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About This Guide

The OpenText Vibe 4 Advanced User Guide explains how to use advanced features of the Vibe
product.

¢ Chapter 1, “Are You an Advanced Vibe User?,” on page 11

¢ Chapter 2, “Creating and Managing Workspaces,” on page 15

+ Chapter 3, “Managing Folders,” on page 25

+ Chapter 4, “Controlling Access,” on page 45

+ Chapter 5, “Branding a Folder or Workspace,” on page 57

+ Chapter 6, “Creating and Managing Landing Pages,” on page 59

+ Chapter 7, “Creating Custom Workspace Views,” on page 95

+ Chapter 8, “Creating Custom Folder Views,” on page 107

¢ Chapter 9, “Designing Custom Folder Entry Forms,” on page 119

+ Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 133

¢ Chapter 11, “Creating and Managing Workflows,” on page 137

+ Chapter 12, “Managing Remote Applications,” on page 179

¢ Chapter 13, “Managing Your Data Quota,” on page 187

¢ Chapter 14, “Restoring Items from the Trash,” on page 193

+ Chapter 15, “Using OpenTextwith MicroFocus GroupWise,” on page 195

+ Appendix A, “What’s New in Vibe 4.0,” on page 197

+ Appendix B, “Using HTML Markup in Vibe,” on page 199

Audience

This guide is intended for all Vibe users who want information about advanced Vibe functionality.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic feature at the bottom of each page
of the online documentation.

Documentation Updates

For the most recent version of this manual, visit the Vibe 4 Documentation website (http://
www.novell.com/documentation/vibe4).

Additional Documentation

You can find more information in the Micro Focus Vibe documentation, which is accessible from the
Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

About This Guide
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To access the Vibe 4 User Guide from within Vibe, click your linked name, then click Help.
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1.1

1.2

Are You an Advanced Vibe User?

Vibe is an enterprise collaboration tool designed to increase individual productivity, team
effectiveness, and organizational success by providing the right set of tools to the right people. Key
Vibe features include team workspaces, calendars, task lists, document management, discussion
threads, wikis, blogs, RSS feeds, and workflows.

Vibe enables ordinary users to perform content-management functions. Because all Vibe users need
to manage a personal workspace, and can also create team workspaces, all users have the potential
to become “advanced Vibe users.”

Although all Vibe users have the ability to become advanced users, many users never have the need
to progress beyond the basic Vibe functionality. This is because Vibe lends itself to two main groups:
content consumers and content providers.

+ Section 1.1, “Content Consumers,” on page 11

¢ Section 1.2, “Content Providers,” on page 11

Content Consumers

Content consumers use Vibe to get important information that pertains to them. They participate in
team workspaces in order to better collaborate with colleagues and facilitate their work
assignments. They identify subject-matter experts and search for important information.

Content consumers can learn how to accomplish these and other important tasks in the OpenText
Vibe 4.0.8 User Guide.

Content Providers

Content providers use Vibe to manage teams by creating team workspaces and making information
easily accessible through landing pages and other advanced Vibe features.

Advanced Vibe users might perform any of the following functions:

+ Create or manage workspaces and folders: When you create your own workspace or folder,
you are the owner of that workspace or folder. By default, you are also the owner of all sub-
workspaces and sub-folders.

For example, suppose that your manager assigns you to lead an advertising campaign for a new
product. Because accomplishing this assignment involves the combined efforts of various
members of your team, you decide to create a new workspace dedicated to the new campaign.

For in-depth information, see Chapter 2, “Creating and Managing Workspaces,” on page 15 and
Chapter 3, “Managing Folders,” on page 25.

+ Control user access to workspaces and folders: As the owner of a workspace or folder, you are
responsible for controlling which users have access rights, and deciding which rights are
appropriate for which people.

Are You an Advanced Vibe User? 11


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo

12

For example, as the advertising campaign manager for a new product, you need to decide if
Vibe users who are not members of your team are allowed to create entries in your team
workspace, or whether non-team members should even be allowed to view the workspace.

Also, when new users join the team, it is your responsibility to grant them appropriate rights.
For in-depth information, see Chapter 4, “Controlling Access,” on page 45.

Create unique brands for workspaces and folders: As the owner of a workspace or folder, you
are responsible for creating a unique and attractive brand. Creating a unique brand is a good
way to differentiate your workspace or folder from other places in the Vibe site.

For example, as the advertising campaign manager for a new product, you brand your team
workspace with a graphic of the product logo, along with the new marketing slogan.

For in-depth information, see Chapter 5, “Branding a Folder or Workspace,” on page 57.

Create landing pages: As the owner of a workspace, you can present the most important
information on the home page of the workspace. At the same time, you can change the look
and feel of the home page. (You can create landing pages in personal workspaces only if your
Vibe administrator has enabled this functionality.)

For example, as the advertising campaign manager for a new product, you create a landing page
in the team workspace. In the landing page you display the current product shipment schedule,
the latest news concerning the product, open tasks as they relate to your team members, and
so forth.

For in-depth information, see Chapter 6, “Creating and Managing Landing Pages,” on page 59.

Create custom workspace and folder views: As the owner of a workspace or folder, you can
create custom views that modify what is displayed on the home page of your workspace or
folder. You can display uploaded files, remote applications, pictures, and more.

For example, as the advertising campaign manager for a new product, you can customize the
home page of your team workspace to display pictures of the various marketing logo options for
the product, as well as upload notes from team meetings.

For in-depth information, see Chapter 7, “Creating Custom Workspace Views,” on page 95 and
Chapter 8, “Creating Custom Folder Views,” on page 107.

Create custom folder entry forms: As the owner of a workspace or folder, you can create
custom folder entry forms that users can fill in when they are making entries in the workspace
or folder.

For example, as the advertising campaign manager for a new product, you decide to create a
new folder called “Slogans.” Inside this folder, you create a new entry form that enables team
members to easily submit their ideas for catchy slogans for the new product. The entry form
contains a field for the team member to type his or her name, a field where they can type the
slogan, a field where they can upload pertinent pictures, and so forth.

For in-depth information, see Chapter 9, “Designing Custom Folder Entry Forms,” on page 119.

Create and manage workflows: As the owner of a workspace or folder, you can create
workflows that automate otherwise time-consuming manual processes.

For example, as the advertising campaign manager for a new product, you notice that expense
reporting is taking more time than you want. The current process is for members of your team
to request an expense reimbursement from you. Then you send the request to HR, and they
transfer the request to Finance. To automate this process, you implement a workflow that

Are You an Advanced Vibe User?



sends you an email notification requesting your approval when the request is submitted. When
you give your approval, the workflow is automatically transferred to HR. If HR approves the
request, the workflow is transferred to Finance, where the reimbursement is processed.

For in-depth information, see Chapter 11, “Creating and Managing Workflows,” on page 137.

Manage remote applications: As the owner of a workspace or folder, you can enable remote
applications that have been set up by your Vibe administrator.

For in-depth information, see Chapter 12, “Managing Remote Applications,” on page 179.

Are You an Advanced Vibe User? 13
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2 Creating and Managing Workspaces

Vibe lets you create and manage your workspaces in the following ways:

+ Section 2.1, “Creating and Managing a Team Workspace,” on page 15

+ Section 2.2, “Creating and Managing a Discussions Workspace,” on page 16

+ Section 2.3, “Creating and Managing a Basic Workspace,” on page 17

+ Section 2.4, “Creating and Managing a Project Management Workspace,” on page 18
+ Section 2.5, “Creating and Managing a Team Workspace Root Workspace,” on page 20
¢ Section 2.6, “Using Global Workspaces,” on page 21

+ Section 2.7, “Creating Workspace Hierarchies,” on page 21

+ Section 2.8, “Creating Custom Workspace Views,” on page 23

+ Section 2.9, “Setting a Maximum Number of File Versions,” on page 23

+ Section 2.10, “Setting a File Upload Size Limit,” on page 23

+ Section 2.11, “General Workspace Management,” on page 23

2.1 Creating and Managing a Team Workspace

Team workspaces help you and your team work together to accomplish tasks and meet objectives.

As the owner of a workspace, you are primarily responsible for workspace administration. You can
create other containers for information (sub-workspaces and folders), adjust access control to
determine who can do what in the workspace, and provide some initial content to assist team
members with getting started.

For information about how to perform basic management tasks on a team workspace, such as
creating the workspace, adding team members, and sending email to team members, see
“Managing a Team Workspace” in the OpenText Vibe 4.0.8 User Guide.

+ Section 2.1.1, “Allowing Visitors to Your Team Workspace,” on page 15

+ Section 2.1.2, “Using Team Workspaces to Create Hierarchies,” on page 16

2.1.1 Allowing Visitors to Your Team Workspace

By default, only team members can view and participate in the workspaces and folders contained in
the team workspace. There might be times when you want to allow other people to visit your team
workspace (which, by default, means that they can read entries and comment on them, but they
cannot create entries).

To allow visitors to your team workspace:

1 Navigate to the team workspace where you want to allow visitors.

2 Click the Configure icon 9 next to the workspace title, then click Access Control.

Creating and Managing Workspaces 15
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2.1.2

2.2

2.2.1

Vibe displays the Configure Access Control page for the team workspace.

3 Ensure that the workspace is not inheriting its access control settings. Select the no radio
button, then click Apply.

4 (Conditional) If Visitor is not already a column in the provided table, click Add a Role > Visitor:

5 On the left side of the table, click Add a User, then use the type-to-find functionality to select
the name of the person you want to add as a visitor to the team workspace.

6 In that new user’s row, select the check box in the Visitor column.
7 Repeat Step 5 and Step 6 until you have added all your visitors.
8 Click Save Changes > Close.

The people who now have the Visitor role can view your team workspace and add comments to
existing entries. They cannot create new entries.

For more information on managing access control, see Section 4.2, “Managing Access Control for
Users and Groups,” on page 49.

Using Team Workspaces to Create Hierarchies

Team workspaces in Vibe can be used to organize information inside of existing workspaces, which
creates different levels of hierarchy within a workspace.

You can also use other types of workspaces to create hierarchies. For information on the advantages
and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace
Hierarchies,” on page 21.

Creating and Managing a Discussions Workspace

The Discussions workspace can be the home page for a set of discussion forums. You can also use
the Discussions workspace to house other types of folders.

Discussions workspaces can be particularly useful for site administrators, or other Micro Focus Vibe
users who are responsible for creating the overall structure of the Vibe site. For example, you can
use a Discussions workspace to organize a set of company-wide discussions on various topics. This
can help organize your Vibe site, so users know where they should go if they are looking for a
particular discussion forum.

+ Section 2.2.1, “Creating a Discussions Workspace,” on page 16

+ Section 2.2.2, “Using Discussions Workspaces to Create Hierarchies,” on page 17

Creating a Discussions Workspace

1 Navigate to the place in Vibe where you want to create the Discussions workspace.
Depending on your rights, you might create this workspace at the Global level, if you are
creating a company-wide Discussions workspace; or you might create this workspace in a lower-
level workspace, if the Discussions workspace is intended for a smaller number of Vibe users.

2 Click the Configure icon © next to the workspace title, then click New Workspace.
The New Workspace page is displayed.
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2.2.2

2.3

3 In the Workspace Title field, specify a name for the Discussions workspace.
4 In the Workspace section, select Discussions Workspace.
5 In the Workspace Folders section, select Discussion.

You can add more Discussion folders after the workspace has been created.

6 Click OK.

Using Discussions Workspaces to Create Hierarchies

Discussions workspaces in Vibe can be used to organize information inside of existing workspaces,
which creates different levels of hierarchy within a workspace.

You can also use other types of workspaces to create hierarchies. For information on the advantages
and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace
Hierarchies,” on page 21.

Creating and Managing a Basic Workspace

Basic workspaces in Micro Focus Vibe can be used to organize information inside of existing
workspaces, which creates different levels of hierarchy within a workspace.

You can also use other types of workspaces to create hierarchies. For information on the advantages
and disadvantages of using each type of workspace, see Section 2.7, “Creating Workspace
Hierarchies,” on page 21.

To create a basic workspace:

1 Navigate to the place in Vibe where you want to create the basic workspace.

2 Click the Configure icon @ next to the workspace title, then click New Workspace.
The New Workspace page is displayed.

3 In the Workspace Title field, specify a name for the basic workspace.

4 In the Workspace section, select Workspace.

5 In the Workspace Folders section, select the folders that you want the new workspace to
contain.

You can add more folders after the workspace has been created.

6 Click OK.
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2.4

24.1

2.4.2

Creating and Managing a Project Management
Workspace

Project Management workspaces include special accessories that help leaders track the progress of
task completion for projects. Although Project Management workspaces can contain any type of
folder, they are specifically designed to work in conjunction with Tasks and Milestones folders.

¢ Section 2.4.1, “Creating a Project Management Workspace,” on page 18

+ Section 2.4.2, “Managing a Project Management Workspace,” on page 18

¢ Section 2.4.3, “Understanding Tasks and Milestones,” on page 19

Creating a Project Management Workspace

1 Navigate to the place in Vibe where you want to create the Project Management Workspace.

2 Click the Configure icon @ next to the workspace title, then click > New Workspace.
The New Workspace page is displayed.

3 In the Workspace Title field, specify a name for the Project Management workspace.

4 In the Workspace section, select Project Management Workspace.

5 Click OK.

Managing a Project Management Workspace

After you create the Project Management workspace, notice that the workspace contains key
folders, such as a Tasks folder, Milestones folder, Files folder, and so forth.

The home page of the Project Management workspace provides the following features that enable
you to better manage your project:

Task Summary Accessory: This accessory lists all of the tasks that exist in the Tasks folder of your
Project Management workspace.

To modify the information in this accessory, navigate to the Tasks folder of this Project Management
workspace. For information about Tasks folders, see “Working with Tasks Folders” in the OpenText
Vibe 4.0.8 User Guide.

Project Information Box: Displays the Status, Manager, and Due Date of the project.

To modify this information:

1 Click the Configure icon @ next to the workspace title, then click Edit Workspace.

2 In the Project Information Box section, modify the Manager, Status, and Due Date fields as
needed.

3 Click OK.

Project Statistics: Displays the current task and milestone statistics that are associated with the
project.

Creating and Managing Workspaces


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bbgkaza
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo

2.4.3

Understanding Tasks and Milestones

Because tasks and milestones contribute important information to your Project Management
workspace, it is important to understand how they work.
+ “Understanding Tasks” on page 19

+ “Understanding Milestones” on page 19

Understanding Tasks

Tasks folders keep track of the progress made in completing work assignments. For information
about Tasks folders, see “Working with Tasks Folders” in the OpenText Vibe 4.0.8 User Guide.

Understanding Milestones

The Milestones folder contains the various milestones for a project. Each milestone entry has
specific Tasks folders that are associated with the milestone. When all of the tasks in the Tasks
folders are complete, you can mark the milestone that is associated with those tasks as completed.
¢ “Creating a Milestone” on page 19
+ “Using the Milestones Folder” on page 20

+ “Modifying a Milestone” on page 20

Creating a Milestone

1 Navigate to the Milestones folder in your Project Management workspace.
2 Click New > Milestone.
The Milestone page is displayed.
3 Specify the following information:
Title: Provide a title for the milestone.
Description: Describe the milestone.
Due Date: Specify when the milestone is due.
Responsible: Specify the users who are responsible for completing the milestone.
Responsible Groups: Specify the groups who are responsible for completing the milestone.
Responsible Teams: Specify the teams who are responsible for completing the milestone.

Send an Email Notification to Responsibles: Select this option if you want Vibe to send an
email notification and iCal task/appointment to all of the users, groups, or teams that you
associate with the entry.

For more information on iCal functionality in Vibe, see “Synchronizing Tasks and Calendars to a
Desktop Application” in the OpenText Vibe 4.0.8 User Guide.

Status: Use the drop-down list to specify a status for the milestone (Open, Reopen, Completed).

Task Folders: Use the tree to navigate to and select the Tasks folders that you want to associate
with the milestone.

The tasks in these Tasks folders must be completed before the milestone can be marked as
Completed.
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2.5

Attachments: Attach any appropriate files.

Subscribe to This Entry: You can configure Vibe to send you notifications when activity takes
place in this entry. For more information, see “Subscribing to a Folder or Entry” in the OpenText
Vibe 4.0.8 User Guide.

Send Email When Entry is Submitted: To ensure that certain co-workers are aware of your
entry, you can send them an email directly from Vibe, notifying them that an entry has been
created. For more information, see “Filling Out the Send E-Mail Page” in the OpenText Vibe
4.0.8 User Guide.

Using the Milestones Folder

The Milestones folder contains the following columns that contain information about each
milestone:

Name: Displays the name of the milestone.
Responsible: Displays the people who are responsible for the milestone.
Tasks: Displays the Tasks folders that are associated with the milestone.

Mouse over the colors in the bar chart to see an explanation of the value (needs action, in process,
completed).

Status: Displays the status of the milestone.

Due date: Displays the due date of the milestone.

Modifying a Milestone

1 In the Milestones folder, click the milestone name in the Name column.
The milestone entry is displayed.

2 In the Entry toolbar, click Modify.
The Milestone page is displayed.

3 Make any modifications, then click OK.

You might need to refresh the page for your changes to be displayed.

Creating and Managing a Team Workspace Root
Workspace

A Team Workspace Root workspace is designed to contain multiple team workspaces. Use this type
of workspace if you want to create additional team workspaces as sub-workspaces to this
workspace. When users with appropriate rights view this workspace, they can easily create a new
team workspace by clicking the Add a Team Workspace button, as described in “Creating a Highly
Visible Team Workspace” in the OpenText Vibe 4.0.8 User Guide. The Add a Team Workspace button
is not displayed in regular team workspaces.

You can control who has access to create workspaces in Team Workspace Root workspaces by
modifying the access controls, as described in Chapter 4, “Controlling Access,” on page 45.
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2.6

2.7

2.7.1

For more information on organizing team workspaces for a Micro Focus Vibe site, see “Managing

Team Workspaces” in the OpenText Vibe 4.0.8 Administration Guide.

To create a Team Workspace Root workspace:

1 Navigate to the location where you want to create the Team Workspace Root workspace.

2 Create a regular team workspace, as described in “Creating a Team Workspace inside of an
Existing Team Workspace” in the OpenText Vibe 4.0.8 User Guide.

3 Navigate to the workspace that you created in Step 2.

4 Click the Configure icon @ next to the workspace title, then click Configure Views, URLs and
Controls.

5 On the Configure Workspace View tab, in the Default View section, select Team Workspace Root.

6 Click Apply > Close.

Using Global Workspaces

Global workspaces contain information beyond the scope of teamwork that might be of broad
interest across your organization.

Global workspaces can be created only by Micro Focus Vibe administrators. For more information on
Global workspaces, see “Creating Global Workspaces” in the OpenText Vibe 4.0.8 Administration
Guide.

Creating Workspace Hierarchies

Creating hierarchies in Vibe is a powerful way to organize workspaces in a meaningful way.
Hierarchies can make information easier to find and increase effectiveness across the Vibe site.

Vibe provides three types of workspaces that you can use to create hierarchies within existing
workspaces. Each type of workspace has its advantages and disadvantages for creating workspace
hierarchies. Depending on your objectives and your environment, you might want to use any of the
following types of workspaces:

+ Section 2.7.1, “Discussions Workspaces,” on page 21

+ Section 2.7.2, “Basic Workspaces,” on page 22

¢ Section 2.7.3, “Team Workspaces,” on page 22

Discussions Workspaces

If you don’t anticipate your workspace having hundreds or thousands of sub-folders, Discussions
workspaces are recommended over basic workspaces and team workspaces.

The following sections describe the advantages and disadvantages of using a Discussions workspace
to create hierarchies within existing workspaces:

+ “Advantages” on page 22

+ “Disadvantages” on page 22
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2.7.2

2.7.3

Advantages

+ Retains the access control rights of higher-level (parent) workspaces by default

+ Lists sub-folders and sub-workspaces on the workspace home page (and displays how many
items are in each folder)

Disadvantages

+ Does not scale well (if you have hundreds or thousands of sub-folders, you should use a basic
workspace to improve performance)

Basic Workspaces

The following sections describe the advantages and disadvantages of using a Basic workspace to
create hierarchies within existing workspaces:

+ “Advantages” on page 22

+ “Disadvantages” on page 22

Advantages

+ Retains the access control rights of higher-level (parent) workspaces by default

+ Scales well (because basic workspaces do not list sub-folders and sub-workspaces on the
workspace home page)

Disadvantages

+ Does not list sub-folders and sub-workspaces on the workspace home page

Team Workspaces

The following sections describe the advantages and disadvantages of using a Team workspace to
create hierarchies within existing workspaces:

+ “Advantages” on page 22

+ “Disadvantages” on page 22

Advantages

+ Lists sub-folders and sub-workspaces on the workspace home page (and displays how many
items are in each folder)

Disadvantages

+ Does not retain the access control rights of higher-level (parent) workspaces by default

+ Does not scale well (if you have hundreds or thousands of sub-folders, you should use a basic
workspace to improve performance)
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2.8

2.9

2.10

2.11

Creating Custom Workspace Views

Micro Focus Vibe lets you create custom workspace views. Workspace views define what is
displayed on the main page of your workspace. When you create custom workspace views, you can
configure workspaces to display optional features such as remote applications, attachments, and
more.

For information on how to create custom workspace views, see Chapter 7, “Creating Custom
Workspace Views,” on page 95.

Setting a Maximum Number of File Versions

You can configure folders and workspaces to allow only a certain number of versions for each file
within the folder or workspace. For more information, see Section 3.5.1, “Automatically Deleting
Minor File Versions That Exceed the Allowed Maximum,” on page 33.

Setting a File Upload Size Limit

You can set a limit on the size of files users can upload to your workspaces and folders. For more
information, see Section 3.6, “Limiting the File Upload Size for Folders and Workspaces,” on page 34.

General Workspace Management

If you have appropriate rights, you can perform various types of management functions on a
workspace, such as copying the workspace to another location, moving the workspace, adding
folders to the workspace, deleting the workspace, and so forth.

For information on how to perform these and other types of management tasks, see “General
Workspace Management” in the OpenText Vibe 4.0.8 User Guide.
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3 Managing Folders

Vibe lets you manage your folders in the following ways:

+ Section 3.1, “Using Vibe 3 Formatting,” on page 25

*

Section 3.2, “Managing Folder Views,” on page 26
+ Section 3.3, “Working with Folder Entry Types,” on page 27
+ Section 3.4, “Enabling Folders to Receive Entries through Email,” on page 30

+ Section 3.5, “Limiting File Versions for Folders and Workspaces by Configuring Automatic
Deletion,” on page 32

+ Section 3.6, “Limiting the File Upload Size for Folders and Workspaces,” on page 34

+ Section 3.7, “Setting Up a Folder or External Email Address to Receive All Sent Email Messages,”
on page 35

+ Section 3.8, “Configuring Folders to Send Email Notifications to Other Users,” on page 36
+ Section 3.9, “Working with Mirrored Folders,” on page 37

¢ Section 3.10, “Setting Up and Using WebDAV,” on page 40

+ Section 3.11, “Viewing Vibe Folders as RSS or Atom Feeds,” on page 42

+ Section 3.12, “Applying Landing Page Elements to a Folder,” on page 43

3.1 Using Vibe 3 Formatting
With the release of Vibe 4, OpenTextimplemented improved default rendering of web pages through
the Google Web Toolkit (GWT).

Administrators who are dissatisfied with GWT rendering of folders and workspaces that were
customized for Vibe 3 can specify Vibe 3 formatting by doing the following:

1. Click the Gear icon © for the folder or workspace.

2. Select Configure View, URLs, and Controls....

3. Enable the Display using Vibe 3 formatting option and click Apply.
4. Click Close.
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3.2

3.2.1

Managing Folder Views

Vibe lets you change the way you and other users view your folder. You can change the default view,
or allow multiple views.

For example, you might have a Tasks folder where the start date and end date are particularly
important. You can configure your Tasks folder to be displayed in a Calendar folder view to place
emphasis on the start and end dates of tasks. You can make this view the default view, or allow users
to toggle between alternate folder views that you pre-enable.

¢ Section 3.2.1, “Changing the Default Folder View,” on page 26

+ Section 3.2.2, “Enabling Alternate Folder Views,” on page 27

Changing the Default Folder View

Vibe lets you change the default view of folders for which you have appropriate rights. This can be
an existing folder view or a custom folder view that you created. For information about how to
create a custom folder view, see Chapter 8, “Creating Custom Folder Views,” on page 107.

+ “Enabling Views to Be Used as the Default View” on page 26

+ “Selecting a New Default Folder View” on page 26

Enabling Views to Be Used as the Default View

Before you can set a view as the default folder view, you need to enable that view.

1 Navigate to the folder where you want to change the default view.

2 Click the Configure icon © next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Allowed Views section, select the view
whose look best presents your folder list or workspace.

4 Click Apply.

The folder view has now been added to the Default View section, and can be chosen as the
default view, as described in “Selecting a New Default Folder View” on page 26.

Selecting a New Default Folder View

1 On the Folder Views, Entries and Workflows tab, in the Default View section, select the folder
view that you enabled in “Enabling Views to Be Used as the Default View” on page 26.

2 Click Apply > Close.
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3.2.2

3.3

3.3.1

Enabling Alternate Folder Views

Because only folder owners have rights to set the default view of a folder, Vibe enables folder
owners to select alternate views that external users of the folder are allowed to use.

1 Navigate to the folder where you want to enable alternate views.

2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Allowed Views section, select all of the
views that you want to enable as alternate folder views.

4 Click Apply > Close.

Users can now view the folder in an alternate view.

1 Click the Configure icon 9 next to the folder title, then click Folder Options.
The Folder Options dialog box is displayed.

2 Inthe View Options section, select the desired alternate view, then click OK.

Working with Folder Entry Types

+ Section 3.3.1, “Enabling Alternate Folder Entry Types,” on page 27
+ Section 3.3.2, “Changing the Entry Type for Entries in a Folder,” on page 28

+ Section 3.3.3, “Changing the View Definitions for Existing Folders and Folder Entries,” on
page 29

Enabling Alternate Folder Entry Types

You can select the types of entries that you want to allow users to create in a certain folder. You can
configure your folder to allow alternate entry types, or you can change the current default entry
type. If you enable multiple entry types, users who submit entries into this folder can choose which
type of entry they want to add, such as a task entry, calendar entry, and so forth.

1 Navigate to the folder where you want to enable alternate entry types.

2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 Onthe Folder Views, Entries and Workflows tab, in the Default Entry Types section, select the
entry types that you want to allow users to create in the folder.

4 Click Apply > Close.
If you enable additional entry types, users who submit entries into this folder can click New in the

Folder Entry toolbar, then use the drop-down list to choose the type of entry they want to add,
depending on which types of entries you enabled on the folder.

Site administrators and folder owners can use the Form and View Designers functionality to create
new entry types (custom forms), which then appear in this list. (When folder owners create new
entry types, those entry types are listed in the Local Definitions section of this list.)
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For more information on how to create custom entry types, see Chapter 9, “Designing Custom
Folder Entry Forms,” on page 119.

3.3.2 Changing the Entry Type for Entries in a Folder

You can change an entry from one type to another type. For example, suppose you are using a
Discussion entry to discuss the new marketing logo for a product. The discussion results in an action
item for you to refine the look of the new logo. You can then change the Discussion entry to a Task
entry for you to keep track of this new action item.

You can change the entry type for a single entry or for every entry of a certain type in a folder.

If the new entry type that you choose contains elements that were not in the original entry type, the
new elements are displayed as blank in existing entries. If the new entry type that you choose
doesn’t have elements that did exist in the original entry type, any information that was in those
elements is removed from the entries. However, the information is not deleted, and is reinstated if
the entry is changed back to the original entry type.

+ “Changing the Entry Type for All Entries In a Folder” on page 28

¢ “Changing the Entry Type for a Single Entry” on page 28

Changing the Entry Type for All Entries In a Folder

You can simultaneously change the entry type for all entries of a certain type in a given folder.
Changing the entry type for entries as described in this section changes the entry form that is used
when creating an entry.

1 Navigate to the folder that contains the entries that you want to change.

2 Click the Configure icon € next to the folder title, then click Configure Views, URLs and
Controls.

3 Click the Entry Type tab.

4 In the Entry Type To Be Changed drop-down list, select the current entry type for entries in the
folder that you want to change to a different entry type.

5 Inthe New Entry Type drop-down list, select the new entry type that you want to convert the
entries to.

6 Click OK, then click OK again to confirm.

Changing the Entry Type for a Single Entry

1 Navigate to and open the entry that you want to change.

2 Click Actions > Change Entry Type.

3 Inthe New Entry Type drop-down list, select the entry type for the entry.
4 Click OK.

28 Managing Folders



3.3.3

Changing the View Definitions for Existing Folders and Folder
Entries

View definitions affect how a folder or entry is displayed. You can simultaneously change the
definitions for folders and folder entries that have already been created. You can change all sub-
folders to match the parent folder, and you can change all entries within a given folder to be of a
specific entry type.

This feature must first be enabled by your Vibe administrator. If it is not enabled, it is not visible. For
information on how to enable this feature, see “Enabling Folder Administrators to Apply Definition
Settings to Sub-Folders and Entries” in the OpenText Vibe 4.0.8 Administration Guide.

+ “Applying Definition Settings to All Sub-Folders” on page 29

+ “Applying Definition Settings to Existing Entries” on page 29

Applying Definition Settings to All Sub-Folders

You can apply the folder definition settings of a parent folder to all sub-folders. For example, if you
have a Discussions folder that contains sub-folders, but not all of the sub-folders are Discussions
folders, you can simultaneously convert all the sub-folders to be displayed as Discussions folders.

1 Navigate to the folder where you want to apply entry definition types to folders or entries that
have already been created.

2 Click the Configure icon © next to the folder title, then click Configure Views, URLs and
Controls.

3 Onthe Folder Views, Entries and Workflows tab, in the Recursively apply section, select Change
contained folders to inherit this folder’s definitions.

4 Click Apply > Close.

All definition settings on the Folder Views, Entries and Workflows tab are applied to all sub-folders.

Applying Definition Settings to Existing Entries

You can convert all the entries that are contained within a specific folder to be of a single entry type.
For example, a user might begin a discussion entry in a Discussion folder, and then move the entry to
the Tasks folder after it is decided that something needs to be done in order to resolve the
discussion. After the discussion entry is added to the Tasks folder, the entry can be converted to a
task entry.

IMPORTANT: Changing entry definition settings as described in this section changes all entries
within the folder and all sub-folders to be the same entry type. You should not perform the steps in
this section if you want your folder and sub-folders to contain multiple types of folder entries, as
described in Section 3.3.1, “Enabling Alternate Folder Entry Types,” on page 27.
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3.4

3.4.1

3.4.2

To make all folder entries the same within a specific folder:

1 Navigate to the folder where you want to apply entry definition types to folders or entries that
have already been created.

2 Click the Configure icon € next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Recursively apply section, select Change
contained folders to inherit this folder’s definitions, then select Change contained entries to be of
the following entry type.

4 In the drop-down list, select the entry type that you want to apply to all existing entries in the
folder.

To add entry types to this drop-down list, select the entry types in the Default Entry Types
section, then click Apply.

5 Click Apply > Close.

Enabling Folders to Receive Entries through Email

Vibe lets you email entries into folders. This is useful if you don’t have access to the Vibe site and still
want to create an entry. You can also send text messages into folders, so you can still capture
thoughts and contribute to conversations when you don’t have access to a computer or the Internet.

To enable folders to receive entries via email, see the following sections:

+ Section 3.4.1, “Enabling and Configuring the Inbound Email Server,” on page 30
+ Section 3.4.2, “Enabling Incoming Email for the Vibe Site,” on page 30
+ Section 3.4.3, “Enabling Email Posting with a Simple URL,” on page 31

+ Section 3.4.4, “Defining Who Has Access to Email Entries,” on page 31

Enabling and Configuring the Inbound Email Server

The Vibe administrator should have enabled and configured the inbound email server during the
Vibe installation, as described in “Planning to Enable Inbound Email” in the OpenText Vibe 4.0.8
Installation Guide.

For information about enabling and configuring inbound email after the Vibe installation, see
“Reconfiguring the Vibe Site” in the OpenText Vibe 4.0.8 Administration Guide.

Enabling Incoming Email for the Vibe Site

For folders to be able to receive entries via email, Vibe administrators need to enable the Vibe site
to allow incoming email.

For information on how to enable Vibe to allow incoming email, see “Disabling/Enabling Inbound
Email Postings” in the OpenText Vibe 4.0.8 Administration Guide.
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3.4.3

3.4.4

Enabling Email Posting with a Simple URL

When you define a simple URL for a folder, Vibe creates a URL that lets you quickly navigate to the
folder, and also creates a corresponding email address that users of the folder can email to.

1 Navigate to the folder where you want to define the URL.

2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 Click the Simple URLs and Email Addresses tab.

4 In the Define a simple URL for this folder or workspace section, specify the URL that you want to
use to reference the folder.

5 Click Add.
6 Select Allow email posts to this folder via the following addresses.

7 Click Apply, then click Close.

You can now make entries to the folder by email or by text-messaging your entry to the email
address that you created, as described in “Adding Entries to a Folder Via Email” in the OpenText Vibe
4.0.8 User Guide.

Defining Who Has Access to Email Entries

By default, only users with rights to create entries in a particular folder can email entries into that
folder.

Vibe lets you view who has rights to create entries in a folder, grant rights to other Vibe users, or
configure the folder to allow all users to create entries by emailing into it.

+ “Viewing Who Has Rights” on page 31

+ “Granting Rights to Other Vibe Users” on page 31

+ “Setting Up a Folder That All Users Can Send Email To” on page 32

Viewing Who Has Rights

1 Navigate to the folder where you want to view who currently has rights to create entries in the
folder.

2 Click View > Who Has Access in the Action toolbar.

3 In the provided table, the Create Entries section lists all of the users who have rights to create
entries in the folder.

These are the users who have rights to email entries into the folder.

Granting Rights to Other Vibe Users

You can grant other Vibe users rights to create entries in a folder.

For information on how to change access control settings in a folder, see Section 4.2.1, “Controlling
Access to Workspaces and Folders,” on page 49.
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3.5

Setting Up a Folder That All Users Can Send Email To

You can enable your Vibe folder to receive email entries from all users, regardless of whether they
have access to create entries in the folder or not.

This enables email entries to be submitted by anybody, inside or outside of the Vibe system.

IMPORTANT: If you are worried about receiving spam messages in your folder, do not set up your
folder to accept email entries in the way described in this section.

1 Navigate to the folder where you want to enable all users to create entries via email.

Click the Configure icon € next to the folder title, then click Access Control.

Ensure that No is selected in the Inherit Role Membership section, then click Apply.

In the table, click Add a User.

In the provided field, use the type-to-find functionality and specify E- mai | Posting Agent.

In the E-mail Posting Agent row, select the check box in the Participant column.

N o A WN

Click Save Changes > Close.

Now all users can create entries in this folder via email, using the email address that you created
in Section 3.4.3, “Enabling Email Posting with a Simple URL,” on page 31.

Limiting File Versions for Folders and Workspaces by
Configuring Automatic Deletion

Because a significant amount of data can be consumed by old versions of files, you can set file
version restrictions for workspaces and folders that you own. You might want to do this if the Vibe
administrator has set a data quota on workspaces and folders throughout the Vibe site, or if you
simply want to limit the amount of clutter in your folders and workspaces.

You can configure folders and workspaces to automatically delete minor file versions that exceed the
maximum number that you set for each file, and you can configure folders to automatically delete
minor file versions after a specified number of days. Major file versions are never automatically
deleted.

+ Section 3.5.1, “Automatically Deleting Minor File Versions That Exceed the Allowed Maximum,”
on page 33

¢ Section 3.5.2, “Automatically Deleting Minor File Versions after a Specified Number of Days,” on
page 33
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3.5.1

Automatically Deleting Minor File Versions That Exceed the
Allowed Maximum

You can configure folders and workspaces to allow only a certain number of file versions for each file
version set within the folder or workspace. (A file version set includes the major file version and all
minor file versions. For more information about major and minor file versions, see “Incrementing
the Major Version Number of a File” in “Working with Files in a Folder Entry” in the OpenText Vibe
4.0.8 User Guide.)

After the maximum number of versions is reached and a new minor version is created in the file
version set, the oldest minor version is automatically deleted and cannot be recovered.

Major versions are never deleted, so if there is a minor version that you want to keep from being
deleted, you can increment it to a major version, as described in “Incrementing the Major Version
Number of a File” in “Working with Files in a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.

This setting is inherited by all sub-folders, so any sub-folders are also restricted to the maximum
number that you set. For example, if you specify a maximum version number of 5 in Folder A, Sub-
Folder B also has a maximum version number of 5. This means that each file in the folder can have a
maximum of 5 versions associated with it.

The maximum number that you set includes the major file version as well as any minor file versions.
For example, if you set the maximum version number to be 5, each file version set can have one
major file version and four minor file versions.

To configure a folder or workspace to have a maximum number of allowed file versions:

1 Navigate to the folder or workspace where you want to set the maximum number of allowed
file versions.

2 Click the Configure icon € next to the folder or workspace title, then click Configure Views,
URLs and Controls, depending on whether you are setting the number on a folder or workspace.

3 Click the Versioning and Folder Settings tab.

4 Select Enable File Versions if it is not already selected, then specify the maximum number of
allowed versions in the Maximum Versions field.

5 (Conditional) If the text (Inherited) appears next to the Maximum Versions field, click Stop
Inheriting from Parent. This configures the folder or workspace to not inherit this setting from a
higher-level folder or workspace.

6 Click OK.
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3.5.2
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3.6

Automatically Deleting Minor File Versions after a Specified
Number of Days

You can configure all minor versions of each file to be automatically deleted after a specified number
of days (major versions are never deleted). When you configure a folder in this way, all versions of
the document that are not a major version are deleted after the specified number of days. (For more
information about major and minor versioning, see “Incrementing the Major Version Number of a
File” in “Working with Files in a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.)

The setting to automatically delete old versions is not inherited by sub-folders; it must be configured
individually for each folder. Because of this, you can enable this feature only on individual folders,
and not on the parent workspace. If the Vibe administrator has configured file versions throughout
the Vibe site to be automatically deleted after a certain number of days, you can either disable the
automatic deletion or specify a new day limit for each folder.

1 Navigate to the folder where you want to specify the number of days to wait before the excess
versions are deleted.

2 Click the Configure icon € next to the folder title, then click Configure Views, URLs and
Controls.

3 Click the Versioning and Folder Settings tab.

4 Select Enable Version Aging, then specify the number of days in the Delete Old Versions after
field.

5 Click OK.

Limiting the File Upload Size for Folders and
Workspaces

The file upload size limit conserves disk space in your folders and workspaces because it prevents
users from uploading large files. The default size limit for uploading files into your Vibe site is 2 GB.
This limit can be increased or decreased by your Vibe administrator. You can change the limit for the
workspaces and folders that you are the owner of, but you cannot make the limit greater than what
is set by your Vibe administrator.

This setting is inherited by all sub-folders, so any sub-folders are also restricted to the size limit that
you set.

1 Navigate to the folder or workspace where you want to set a limit on the size of files that can be
uploaded.

2 Click the Configure icon 9 next to the folder or workspace title, then click Configure Views,
URLs and Controls, depending on whether you are setting the limit on a folder or workspace.

3 Click the Versioning and Folder Settings tab.

4 In the File Size Limit section, specify the limit in the Maximum Size field.

5 Click OK.
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3.7

Setting Up a Folder or External Email Address to
Receive All Sent Email Messages

Like a personal email Outbox for the Vibe site, you can configure a folder or any email address to
receive all email messages that you personally send from the Vibe site. This can help you better track
your activity.

Vibe administrators might need to enable this functionality, as described in “Enabling Users to
Configure a Folder or External Email Address to Receive Sent Emails” in “Managing Email
Configuration” in the OpenText Vibe 4.0.8 Administration Guide.

The following actions cause email messages to be sent from the Vibe site and to be saved in the Vibe
folder that you designate:

+ Using the Email Team and Send e-mail to contributors options, as described in “Informing Others
about a Folder or Workspace” in the OpenText Vibe 4.0.8 User Guide.

+ Using the Share this Entry option, as described in “Sharing an Entry” in the OpenText Vibe 4.0.8
User Guide.

+ Using the Send Email When Entry is Submitted option, as described in the “Sending an Email
about an Entry” in the OpenText Vibe 4.0.8 User Guide.

+ Filling in the Announcement field when creating or editing a team workspace, as described in
“Creating a New Workspace” and “Sending Email to Team Members and Announcing the
Workspace after Its Creation” in the in the OpenText Vibe 4.0.8 User Guide.

NOTE: Certain types of email messages that do not require you to personally add text, such as
setting digest notifications or workflow notifications, are not saved to the folder that you designate.

To set up a folder or external email address to receive all email messages that you send from the
Vibe site:
1 Create a new folder in the workspace where you want the folder to reside.

For information on how to create a folder, see “Creating a New Folder” in the OpenText Vibe
4.0.8 User Guide.

2 Define a simple URL for the folder, and allow emails to be sent to the folder.

For information on how to define a URL for a folder and allow emailing into it, see Section 3.4.3,
“Enabling Email Posting with a Simple URL,” on page 31.

3 Navigate to your user profile page by clicking My Workspace, and then clicking Profile.
The Profile page is displayed.

4 Click Edit.

5 Inthe BCC Email Address field, specify the email address of the folder or external email address.
If the BCC Email Address field does not exist, contact your Vibe administrator.

The folder email address was created when you defined a simple URL for the folder and allowed
email posting into the folder, as described in Step 2.

6 Click OK.
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3.8 Configuring Folders to Send Email Notifications to
Other Users

As a folder owner, you can configure Micro Focus Vibe to send other users email notifications, in
order to inform them of any activity in the folder and any sub-folders of the folder. If a user does not
want to be informed of activity in the folder, the user can change the notification settings. A user’s
individual settings override or cancel notifications established by folder owners.

You cannot directly configure a sub-folder to send email notifications; instead, you must configure
the parent folder.

1 Navigate to the folder from where you want to send the email notifications.

2 Click the Configure icon 9 next to the folder title, then click Subscribe Others to Folder.
The Subscribe Others to Folder page is displayed.

3 In the Subscribe Notification Type section, select the type of email notification that you want to
send.

+ Digest: Vibe sends one message that summarizes all of the activity in the folder and its
sub-folders (available for folders only). Vibe sends digest notifications at a schedule
established by your site administrator.

As a folder owner, you can set your own schedule for digest notifications. For more
information, see Step 5.

+ Email with Attachments: Vibe sends one message for every new or changed entry, and
messages include attached files. Vibe sends all types of individual notifications every five
minutes.

+ Email Only: Vibe sends one message for every new or changed entry. The email messages
do not include files that might be attached to the new or changed entries. Vibe sends all
types of individual notifications every five minutes.

+ Text Message: Vibe sends a message suitable for viewing as a text message. The content of
the message includes only the entry title and a link to the new or changed entry. Vibe
sends all types of individual notifications every five minutes.

4 Specify the users that you want to receive the email notifications.

You can specify specific email addresses, users, or groups, or send the notifications to all team
members.

5 (Optional) Click Set a Different Schedule for This Folder if you want to set a digest schedule for
the folder that is different from the digest schedule set by the site administrator.

6 Click Apply > Close.
To configure the folder to stop sending email notifications:

1 Ensure that no email addresses, users, or groups are specified, and that the Team Members
option is not selected.

2 Click Apply > Close.
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3.9

3.9.1

3.9.2

Working with Mirrored Folders

A mirrored folder is a library folder within OpenText that is synchronized with a folder located on a
system drive outside of Vibe. When you perform basic actions (adding subfolders and files,
modifying files, deleting folders and files) by using the Vibe interface or by accessing the file on the
drive, the change is reflected in the other interface. The advantage to using mirrored files is that you
can apply Vibe tools to files on a drive, including tools such as text search, workflow, and discussion
(in the form of comments applied to the entry in the library folder).

For information about setting up mirrored folders for your Vibe site, see “Configuring Mirrored
Folder Resource Drivers” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8
Installation Guide.

Vibe supports two types of external folders:

*

*

A directory on a file system
A folder on a WebDAV server

When you mirror a folder, the action cannot be undone.

*

*

*

*

*

*

Section 3.9.1, “Prerequisites,” on page 37

Section 3.9.2, “Creating a Mirrored Folder,” on page 37
Section 3.9.3, “Configuring a Mirrored Folder,” on page 38
Section 3.9.4, “Synchronizing a Mirrored Folder,” on page 38
Section 3.9.5, “Deleting a Mirrored Folder,” on page 39
Section 3.9.6, “Mirrored Folder Tips,” on page 39

Prerequisites

The following prerequisites apply for setting up mirrored folders.

*

An administrator must have enabled mirrored folder functionality during the Vibe installation
process, as described in “Configuring Mirrored Folder Resource Drivers” in “Advanced
Installation and Reconfiguration” in the OpenText Vibe 4.0.8 Installation Guide.

An administrator must have specified which folders on the server can be mirrored.

The file that you mirror must either be located on the Vibe server, or accessible from the Vibe
server. (For example, the file can be mapped from the Vibe server.)

For information on how to modify mirrored folder settings after the Vibe installation, see
“Reconfiguring the Vibe Site” in the OpenText Vibe 4.0.8 Installation Guide.

Creating a Mirrored Folder

Ensure that you meet the prerequisites discussed in Section 3.9.1, “Prerequisites,” on page 37.

1

2

Navigate to the workspace where you want to set up the Mirrored Files folder.

Click the Configure icon 9 next to the workspace title, then click New Folder.
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3.9.3

3.9.4

3 Provide a title for the folder in the Folder Title field.

4 Select Mirrored Files in the Folder section, then click OK.

After you create a Mirrored Files folder, you need to configure it. For information on how to do this,
see Section 3.9.3, “Configuring a Mirrored Folder,” on page 38.

Configuring a Mirrored Folder

After you create a Mirrored Files folder, you need to configure it.

1 Select the Mirrored Files folder that you created in Section 3.9.2, “Creating a Mirrored Folder,”
on page 37.

2 Click the Configure icon 9 next to the folder title, then click Edit Folder.

3 Specify the following information:

Resource Driver: Use this drop-down list to select the file on the external file system that you
want the Mirrored Files folder to mirror.

You can select only files that your Vibe administrator has configured to be used as mirrored
files.

Resource Root Path: This is the file path to the folder that you selected in the Resource Driver
field.

Resource Path Relative to the Root Path: If you want to display entries in a lower-level folder
than the folder defined in the Resource Root Path field, use this field to specify the remaining
file path.

4 Click OK.

Synchronizing a Mirrored Folder

After you have configured your mirrored folder to mirror the appropriate files, as described in
Section 3.9.3, “Configuring a Mirrored Folder,” on page 38, you need to synchronize the Vibe
Mirrored Files folder with the external folder that it is mirroring.

Vibe lets you manually synchronize your mirrored folder, or set up an automated synchronization
schedule for it.

+ “Manually Synchronizing a Mirrored Folder” on page 38

+ “Setting Up a Synchronization Schedule for a Mirrored Folder” on page 39
Manually Synchronizing a Mirrored Folder

1 Navigate to the Mirrored Files folder that you want to synchronize.

2 Click the Configure icon € next to the folder title, then click Manually Synchronize.

The Vibe Mirrored Files folder is synchronized with the external folder that it is mirroring.
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3.9.5

3.9.6

Setting Up a Synchronization Schedule for a Mirrored Folder
1 Navigate to the Mirrored Files folder that you want to synchronize.

2 Click the Configure icon 9 next to the folder title, then click Schedule Synchronization.
The Schedule Mirrored Folder Synchronization page is displayed.
3 Specify the following information:

Enable Scheduled Synchronization: Select this check box to enable scheduled synchronization.
If you do not select this check box, the scheduled synchronization is not activated.

Every Day: Select this option if you want your mirrored folder to be synchronized every day.

Weekly: Select the days when you want your mirrored folder to be synchronized. (You can
select multiple days.)

At Time: Specify the time that you want your mirrored folder to be synchronized.
If you select this option, your mirrored folder is synchronized only once per day.

Repeat Every: Select the hourly interval when you want your mirrored folder to be
synchronized.

4 Click Apply > Close.

Deleting a Mirrored Folder

1 Navigate to the Mirrored Files folder that you want to delete.

2 Click the Configure icon 9 next to the folder title, then click Delete Folder.
The Delete This Folder page is displayed.
3 Select Also delete source contents if this folder or any of the sub-folders are mirrored folders.

If you do not select this option, the folder and its contents are removed from Vibe only, and are
restored in the next synchronization.

4 Click OK.

NOTE: Undeleting files that have been deleted through a mirrored folder is not supported in Vibe.
Files that are deleted through a mirrored folder cannot be recovered.

For more information on undeleting items in Vibe, see Chapter 14, “Restoring Items from the Trash,”
on page 193.

Mirrored Folder Tips

Consider these tips when working with mirrored files:

+ When you specify the path to the system folder, specify the full (absolute) path to the folder.

+ After creating the mirrored folder, you cannot alter the path name, and you cannot reconfigure
the Vibe library folder to be a non-mirrored folder.

+ Toinitialize the new mirrored folder, click the Configure icon 9 next to the folder title, click Edit
Folder, then use the Synchronize tool.
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3.10

3.10.1

+ Do not attach additional files to entries in a mirrored folder. Behavior regarding additional
attachments is unpredictable.

+ When you delete a file on the server, Vibe deletes the entire entry in the library folder (not just
the attached file).

+ When you add sub-folders to a mirrored folder in Vibe, sub-folders are added to the folder in
the other system.

+ When a Mirrored Files folder is exported, the content that the folder is mirroring is preserved
when the file is imported. However, the content is no longer mirrored from the original location.
Instead, it is stored within the Vibe database, the same as any other Vibe content. Only Vibe
administrators can import and export workspaces and folders.

Setting Up and Using WebDAV

WebDAV is a standard collaborative editing and file management protocol. Vibe supports the use of
WebDAV tools, and lets you manage your Vibe files through WebDAV. Vibe utilizes WebDAV when
editing attached files; you can also set up WebDAV to view documents in a Vibe folder.

If you cannot use WebDAV as described in the following sections, consult your Vibe administrator.

+ Section 3.10.1, “Using WebDAV to Edit Individual Files,” on page 40
+ Section 3.10.2, “Using WebDAV on a Vibe Folder,” on page 41

Using WebDAV to Edit Individual Files

By default, Vibe uses WebDAV when editing files on the Vibe site. If you are working in a Windows
environment with Microsoft Office, you can download and install the OpenTextOffice Add-in for a
familiar user experience. After you download and install the Vibe Office Add-in, you can open the
files directly in the corresponding Microsoft Office application on either Windows or Mac.

You can use either of the following methods to edit files through WebDAV:

+ “Editing a File Directly from the Vibe Interface” on page 40
+ “Using the WebDAV URL to Open the File in a Document Editor” on page 40

Editing a File Directly from the Vibe Interface

When you use the Edit-in-Place functionality to edit a Vibe file, as described in “Editing Files
Accessed through a Web Browser” in the OpenText Vibe 4.0.8 User Guide, Vibe uses WebDAV to
retrieve, lock, modify, and unlock the file. No special setup or configuration is needed in Vibe to use
WebDAV in this way.

Using the WebDAV URL to Open the File in a Document Editor

You can obtain the WebDAV URL for individual files within Vibe, as described in “Obtaining the
WebDAV URL for a File” in the OpenText Vibe 4.0.8 User Guide.

After you have obtained the WebDAV URL for the file, you can specify the URL in a document editor
such as Microsoft Office to open the file. Refer to the documentation for your specific document
editor for instructions on how to accomplish this.
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3.10.2

Using WebDAV on a Vibe Folder

When you use WebDAV on a Vibe folder, you can create a mapped drive to a Vibe folder, enabling
users to browse and navigate the Vibe folder in a WebDAYV interface. To manage your Vibe folders
through a WebDAV interface, you must first configure the Vibe folder to support WebDAV, and then
create a mapped drive to the Vibe folder.

NOTE: Because of limitations with WebDAV on Mac, you cannot use WebDAV to view a Vibe folder
in a Mac environment.

+ “Configuring a Folder to Support WebDAV” on page 41
+ “Viewing the Vibe Folder in Your Windows Environment” on page 42

+ “Viewing the Vibe Folder in Your Linux Environment” on page 42

Configuring a Folder to Support WebDAV

When a folder is configured to support WebDAV, Vibe requires that each file added to the folder
have a unique name. This is because when you view a folder through WebDAYV, you see only the files
that are within the folder and not the entries that contain each file. Some folder types are
configured to support WebDAV by default, and some are not.

Files folders and Photo Album folders are configured by default to support WebDAV, because they
require that all files have a unique name.

All other types of Vibe folders, however, must be manually configured to support WebDAV. This is
because Vibe allows you to add multiple files with the same name to a single folder, if each file is
added as a separate entry.

To configure a folder to support WebDAV by requiring that all files uploaded to the folder have a
unique name:

1 Navigate to the folder that you want to configure to support WebDAV.

2 Click the Configure icon 9 next to the folder title, then click Edit Folder.

3 Toward the bottom of the page, select Require that all files uploaded into this folder have a
unique name.

4 Click OK.
For information about what users experience when they try to add a file to a WebDAV-enabled
folder when the file has the same name as a file that has already been added to the folder, see

“Adding Files to a Files Folder and Other WebDAV-Enabled Folders” in the OpenText Vibe 4.0.8 User
Guide.
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3.11

Viewing the Vibe Folder in Your Windows Environment

After your Vibe folder has been configured to support WebDAV, as described in “Configuring a Folder
to Support WebDAV” on page 41, you can view the Vibe folder in your Windows environment in
either of the following ways:

+ “Creating a Mapped Drive to the Vibe Folder” on page 42

+ “Adding a Vibe Folder as a Network Place” on page 42

Creating a Mapped Drive to the Vibe Folder

1 Navigate to the folder where you want to create the mapped drive.
2 Click the link in the footer.
3 In the provided table, copy the WebDAV URL.
4 Map a drive to the folder.
You accomplish this by using the Map Network Drive feature for Windows.

5 Specify your Vibe credentials, then complete the setup process.

Adding a Vibe Folder as a Network Place

1 Navigate to the folder where you want to create the mapped drive.
2 Click the link in the footer.

3 In the provided table, copy the WebDAV URL.

4 Add the folder as a network place.

You accomplish this by using the My Network Places feature for Windows.

Viewing the Vibe Folder in Your Linux Environment

After your Vibe folder has been configured to support WebDAV, as described in “Configuring a Folder
to Support WebDAV” on page 41, you can view the Vibe folder in your Linux environment.

1 Navigate to the folder where you want to create the mapped drive.

2 Click the link in the footer.

3 In the provided table, copy the WebDAV URL.

4 Use either Nautilus or Konqueror to access the Vibe folder.

For specific information on how to use Nautilus or Konqueror, consult your Linux
documentation.

5 Specify your Vibe credentials, then complete the setup process.

Viewing Vibe Folders as RSS or Atom Feeds

RSS and Atom are web formats used to publish frequently updated content such as blog entries,
news headlines, or podcasts. RSS and Atom documents, which are often called feeds, contain either
a summary or full content from an associated website. RSS and Atom make it possible for people to
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keep up with their favorite websites in an automated manner that's easier than checking the sites
manually. RSS and Atom enable you to set up feeds to Vibe folders and view those feeds in one
convenient location.

You can set up a Vibe folder to be accessed by an RSS or Atom reader. When you do this, the Vibe
folder sends new or modified folder entries to your RSS or Atom reader. This is an easy way to stay
informed on activity in a certain folder.

To set up a Vibe folder as an RSS or Atom feed:

1 Navigate to the folder that you want to set up as an RSS or Atom feed.
2 Click the Footer toolbar, located at the bottom of the folder page.

3 If you are setting up an RSS feed, select and copy the RSS URL in the RSS URL section in the
provided table.

or

If you are setting up an Atom feed, select and copy the Atom URL in the ATOM URL section in
the provided table.

4 Inyour RSS reader or Atom reader, create a new RSS or Atom feed, and paste the RSS URL or the
Atom URL that you copied in Step 3.

The folder is now set up as an RSS or Atom feed, and entries that are created in the folder
appear in your RSS or Atom reader.

For information on using your OpenText GroupWise client as an RSS reader, see “RSS Feeds” in the
GroupWise 18 Client User Guide.

3.12 Applying Landing Page Elements to a Folder

Landing pages and landing page elements can enhance the presentation and utility of your Micro
Focus Vibe folders. You can set up a landing page on your folder, or you can simply apply some key
landing page elements to the folder, such as hiding the Vibe masthead, the Navigation panel, and so
forth.

+ Section 3.12.1, “Displaying a Landing Page on a Folder,” on page 43
+ Section 3.12.2, “Applying Specific Landing Page Elements to a Folder,” on page 44

3.12.1 Displaying a Landing Page on a Folder

Just as landing pages can enhance the presentation and utility of your Vibe workspaces, they can
also enhance your Vibe folders.

For information on how you can create a landing page for a folder, see Section 6.16, “Creating a
Landing Page for a Folder,” on page 93.
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3.12.2

Applying Specific Landing Page Elements to a Folder

You can leverage certain landing page elements in your Vibe folder without implementing an actual
landing page.

For example, you might want to hide the Navigation panel from your folder in order to create more
viewing room for users who view the folder.

You can apply the following landing page elements to a folder, without implementing an actual
landing page:

+ Hide the Vibe Masthead

+ Hide the Navigation panel

+ Hide the Footer toolbar
To make these modifications to your folder without implementing an actual landing page, you need
to add the Landing Page element to your folder Form definition. For information on how to add the

Landing Page element to your folder Form definition, see Chapter 8, “Creating Custom Folder
Views,” on page 107.
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4.1

Controlling Access

If you are a Vibe site administrator or a workspace and folder owner, it is your responsibility to keep
your content safe and your content consumers happy, by making sure they have access to the files
and folders they depend on. Access control in Vibe is how you accomplish this.

Workspace and folder owners are responsible for controlling user access in their workspaces or
folders. Site administrators are responsible for controlling user access across the entire site.

+ Section 4.1, “Understanding Access Control,” on page 45

+ Section 4.2, “Managing Access Control for Users and Groups,” on page 49

+ Section 4.3, “Managing Access Control for Remote Applications,” on page 56

Understanding Access Control

Access control is how you specify which users have the right to perform which tasks in which places.
Because your Vibe site is a hierarchy of workspaces and folders and because access control settings
can be inherited (or not), access control settings affect a variety of Vibe features.

Micro Focus Vibe uses role-based access control. By default, there are seven roles, and each role
contains specific rights. If you want a particular user to have certain rights, you can assign that user
to the appropriate role.

For example, a user who has been assigned to the Participant role in a workspace or folder can add
comments or replies, create entries, delete his or her own entries, modify his or her own entries, and
read entries in that folder or workspace.

The following sections help you better understand how access control works in Vibe.

+ Section 4.1.1, “Inheritance,” on page 46

+ Section 4.1.2, “Navigation,” on page 46

+ Section 4.1.3, “Default Access Control Behavior in Workspaces,” on page 47
+ Section 4.1.4, “Default User Rights,” on page 47

+ Section 4.1.5, “Default Roles,” on page 47

+ Section 4.1.6, “Default Users and Groups,” on page 49
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4.1.1

4.1.2

Inheritance

Workspaces can inherit the access control settings of their parent workspaces. You should
understand the following facts about access control inheritance:

+ If you create a new workspace under an existing workspace that is inheriting its access control

settings from its parent, the new workspace continues the inheritance chain. If you change any
access control settings above the new workspace at a later time, the access control settings for
the new workspace also change. Global workspaces inherit access control settings from the
parent workspace by default.

If you create a new workspace under an existing workspace that is not inheriting its access
control settings, the new workspace retains the non-inherited settings of the parent workspace.

If you move a workspace that is inheriting its access control settings from its original parent
workspace, it inherits the access control settings of the new parent workspace into which it is
moved. If the new parent workspace has different settings than the original parent workspace,
the access control settings for the moved workspace change accordingly.

Team membership is inherited separately from access control settings. If access control settings
are being inherited, this does not necessarily mean that team membership is also being
inherited. To edit team membership or to change the team membership inheritance settings for

a team workspace, click the Configure icon 9 next to the workspace title, then click Edit Team.

Navigation

As a best practice, you should not grant users access to sub-workspaces and sub-folders while
restricting access for the same users to the higher-level (parent) folders. Ignoring this best practice
can be problematic for the following reasons:

+ Users cannot navigate to the sub-workspace or sub-folder using the Workspace tree navigation,

even though they have appropriate rights to the sub-workspace or sub-folder.

If you understand this limitation and still have a need to restrict access to a parent workspace or
folder while granting access to a sub-workspace or sub-folder, users can still access the hidden
sub-workspace or sub-folder by using the Search feature or by accessing the location through
WebDAV.

Users can see the name of a higher-level workspace, even though they do not have appropriate
rights.

Users who use the Search feature or WebDAV to locate the sub-workspace or sub-folder that
they have been granted access to are able to see the name of the parent workspace, which they
would otherwise not be able to see. However, they can see only the workspace name, not the
contents of the workspace.
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4.1.3

4.1.4

4.1.5

Default Access Control Behavior in Workspaces

By default, most places inherit the access control settings of their parent. When you establish
settings for a primary space, all sub-places automatically apply the same settings, saving
administration time. However, unlike other types of workspaces, Team workspaces do not retain the
access control settings of the parent workspace by default. This is because the desired access control
settings for Team workspaces can vary greatly depending on the objectives of the team.

Also, team membership is inherited separately from access control settings. If access control settings
are being inherited, this does not necessarily mean that team membership is also being inherited. To
edit team membership or to change the team membership inheritance settings for a team
workspace, click Workspace > Edit Team.

Default User Rights

By default, all Vibe users have rights to perform the following actions:
+ Participate in any team workspaces in which they are a member (create folders and entries,
make comments, and so forth)

+ Create team workspaces (by default, only members of a team can view and participate in team
workspaces)

+ Visit all personal workspaces (read entries and comment on them)

+ Participate in all global workspaces and folders

Default Roles

Vibe includes default roles that you can assign to users and groups. The following sections describe
the function of each default role, but do not describe all of the rights associated with each role. For a
complete list of rights, click the name of the role in the table on the Configure Access Control page.

(Click the Configure icon @ next to the workspace or folder title, then click Access Control.)

For a complete list of roles that site administrators can add, see “Controlling User Access throughout
the Vibe Site” in the OpenText Vibe 4.0.8 Administration Guide. For a detailed description of each
right that can be associated with a given role, see “Understanding the Various Rights for Roles” in the
OpenText Vibe 4.0.8 Administration Guide.

Vibe enables site administrators to create their own custom roles, as described in “Defining a New
Role” in the OpenText Vibe 4.0.8 Administration Guide. If you have a need for a custom role, consult
your Vibe administrator.

By default, you can assign users to various roles in workspaces and folders, as well as in entries.

+ “Understanding Default Roles for Workspaces and Folders” on page 48

+ “Understanding Default Roles for Entries” on page 48
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Understanding Default Roles for Workspaces and Folders

Role

Description

Allow Sharing With
Internal Users

Allow Sharing With
External Users

Allow Forwarding of
Sharing Rights

Allow Sharing With The
Public

Allow Sharing File Links
Visitor

Participant

Guest Participant

Team Member

Workspace and Folder
Administrator

Workspace Creator

Can share workspaces and folders with internal users.

Can share workspaces and folders with external users.

When sharing, can allow users to re-share workspaces and folders.

Can share workspaces and folders with the Public.

Can share File Links.
Has read-only and comment-only access.

Can create entries and modify those entries, can download folder content as a
CSVfile, plus perform tasks associated with the Visitor role.

Can read entries, create entries, and add comments.

Has all the rights of a Participant. In addition, can generate reports and manage
global tags.

Can create, modify, or delete workspaces or folders; moderate participation
(modify or delete the entries of others); design entries and workflows; set entry-
level access controls on entries of others; and perform tasks associated with the
Participant and Team Member role.

Can create sub-workspaces. In Team Workspace Root workspaces, this role allows
users to create their own team workspaces.

Understanding Default Roles for Entries

Role

Description

Owner Create Entry ACLs

Read

Read and Reply
Write

Delete

Change Access Controls

The owner of the entry can create entry-level access controls.

Can read the entry.

Can read the entry and add comments or replies to the entry.

Can read the entry, add comments or replies, and modify the entry.

Can read the entry, add comments or replies, modify, and delete the entry.

Can read the entry, add comments or replies, modify, and delete the entry. Can
also modify the access control settings of the entry.
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4.1.6

4.2

4.2.1

Default Users and Groups

You can assign default or custom access control roles to users and groups for the Vibe site if you are
the Vibe administrator, or in your workspaces if you are a workspace owner. In addition to the users
and groups that the Vibe administrator creates, Vibe includes four default users and groups to which

you can assign roles.

Default User and Group Description

Owner of a Workspace or  The person who created the workspace, or the person assigned to be the owner
Folder of the workspace.

Team Members The individuals who are designated as team members in a given place.

For information about how to add team members, see “Adding Additional Team
Members to Your Workspace” in the OpenText Vibe 4.0.8 User Guide.

All Users Every person registered within the Vibe site.

Site Administrator The person who has rights to perform any task in any workspace or folder.
Available only to Vibe administrators.

Managing Access Control for Users and Groups

When you have appropriate rights, you can control which users have access to workspaces, folders,
and entries. Furthermore, you can regulate what actions they are allowed to perform. For example,

you can allow a specific team to view a workspace, but only allow certain members of that team to
create entries in the workspace.

You can control access to workspaces, folders, and entries.

+ Section 4.2.1, “Controlling Access to Workspaces and Folders,” on page 49

+ Section 4.2.2, “Controlling Access to Entries,” on page 53

Controlling Access to Workspaces and Folders

+ “Accessing the Configure Access Control Page” on page 50

+ “Activating the Table” on page 50

+ “Adding Roles to the Access Control Table” on page 51

+ “Adding Users to the Access Control Table” on page 52

+ “Adding Groups to the Access Control Table” on page 52

+ “Assigning Roles to Users and Groups” on page 53

+ “Using the Configure Access Control Page to Adjust Access Controls” on page 53

+ “Creating Access Controls for Remote Applications” on page 53
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Accessing the Configure Access Control Page

Micro Focus Vibe provides a table on the Configure Access Control page that lets you make all of
your needed access control modifications. You must use this table to perform any access control

modifications in Vibe.

1 Navigate to the workspace or folder where you want to modify user access rights.

2 Click the Configure icon 9 next to the folder or workspace title, then click Access Control,
depending on whether you are changing the access control settings for a workspace or folder.

The Configure Access Control page is displayed.

Configure Access Control

Configure Access Control 0

Workspace: Paperless Initiative
Workspace Owner: Julio Chavez(jchavez) [sdi]

Home Work: I Personal Work:

This folder inherits its access control settings from its parent.

Inherit role membership from the parent folder or workspace?
* yes no

Sharing
This workspace has been shared once

Julic Chavez (jchaw

" Paperless Initiative

Roles
Allow Sharing Allow Sharing Allow Workspace
With Internal With External g}'g’;ﬂfi‘:‘“";‘;"mg MG"'*IWT‘;“;L‘;?C Sharing File  Visitor Participant MT::L”H and Folder
Users Users i Links Administrator
Owner of Workspace or
Folder
Team Members
Allow Sharing Allow Sharing  ayo o ; Allow Workspace
g Allow Sharing Team
Groups Group Title  Group Name  With Internal With External of Sharing Righte  With The Publie  Shaning File  Visifor Parficipant it and Falder
Users Users Links Administrator
N0 groups—
Allow Sharing Allow Sharing ) Allow Workspace
; Allow Forwarding  Allow Sharing ! - - Team
Users User Title User Id With Internal With External of Sharing Rights  With The Puplps  Sharing File  Visitor Parficipant ottt and Folder
Users Users Links Administrator
~N0 USErs—
Allow Sharing Allow Sharing Allow Workspace
Feati Allow Forwarding  Allow Sharing ! - - Team
A Groups Group Tifle  Group Name With Internal With External of Sharing Rights  With The Public Sharing File Visitor Participant g =570 and Folder
Users Users Links Administrator
—no application groups—
- : Allow Sharing Allow Sharing  apol o ; Allow Workspace
g Allow Sharing = - - Team
A e e With Internal With External of Sharing Rights  With The Puplys  Sharing File  Visitor Parficipant @ttt and Folder
Users Users inks Administrator

—no applications—

Activating the Table

Before you can make modifications to the table on the Configure Access Control page, ensure that
the folder or workspace does not inherit its access control settings from its parent folder or

workspace.

1 Inthe Folder Inheritance section, select no, then click Apply.
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This folder inherits its access control settings from its parent.

Inherit role membership from the parent folder or workspace?

lyes @ no m

You can now make modifications to the table.

Configure Access Control

Configure Access Control @ [ Close |

Workspace: Paperless Initiative
Workspace Owner: Julio Chavez(chavez) [=dil

H-Home Workspace N [@-Personal Workspaces /1 [@-Julic Chavez (jchavez) // [F-Paperless Initiative

This folder does not inherit its access control settings from its parent.

Inherit role membership from the parent folder or workspace?

Sharing
This workspace has been shared once

+ designates the access control setting of the parent workspace

Add User Names from Clipboard

Add a Role -+
Allow Sharing  Allow Sharing Allow Allow Allow Team Workspace
With Internal  With External  Forwarding of  SharingWith  Sharing  Visitor  Parficipant 3% and Folder
Users Users Sharing Rights ~ The Public  File Links Administrator
Owner of Workspace
v v v ¥ v vi oy W W v
or Folder
Team Mambers v ¥ v ¥ s @
row Allow Sharing  Allow Sharing Allow Allow Allow Team Workspace
Add a Group v Group Title  ovF With Internal  With External  Forwarding of  Sharing With  Sharing  Visitor  Parficipant 2" and Folder
Users Users Sharing Rights  The Public  File Links Administrator
—No groups—
Allow Sharing  Allow Sharing Allow Allow Rliow Team Workspace
Add a User = User Title User Id With Internal  With External Forwarding of  Sharing With Sharing Visitor  Participant o Lo and Folder
Users Users Sharing Rights ~ The Public  File Links Administrator
--N0 Users—
- : Application  Allow Sharing  Allow Sharing Allow Allow Allow Workspace
Add an Application Group + 2‘:2{;“.::2 Group With Internal  With External  Forwardingof  SharingWith  Sharing Visitor  Participant h;er:;r and Folder
# Name Users Users Sharing Rights ~ The Public  File Links Administrator
—no application groups—
- Allow Sharing  Allow Sharing Allow Allow Aliow Workspace
Add an Application v Appieation  APPUCINON withinternal  With External  Forwardingof  SharingWith  Sharing  Visitor  Parficipant yioar  and Folder
Users Users Sharing Rights ~ The Public  File Links Administrator

—no applications—

Adding Roles to the Access Control Table

1 Click the Add a Role link at the top of the table.
2 From the drop-down list, select the role that you want to add.
Vibe adds a new column to the table for the new role.

3 Assign the appropriate user or group to this role by selecting the check box in the user’s or
group’s row, as described in “Assigning Roles to Users and Groups” on page 53.

For information on how to add a new user to the access control table, see “Adding Users to the
Access Control Table” on page 52.
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For information on how to add a new group to the access control table, see “Adding Groups to
the Access Control Table” on page 52.

4 Click Save Changes.

Adding Users to the Access Control Table

You can individually add users to the Access Control table, or you can add them by using the Vibe
clipboard.

+ “Adding Individual Users” on page 52

+ “Adding Users from the Clipboard” on page 52

Adding Individual Users

1 Click the Add a User link in the left column of the table.

2 Inthe Add a User field, begin typing the name of the user that you want to add, then select that
user from the provided list.

Vibe adds a new row to the table for the new user.

3 Assign the user to the appropriate role by selecting the check box in the column of the user’s
row, as described in “Assigning Roles to Users and Groups” on page 53.

4 Click Save Changes.

Adding Users from the Clipboard

1 Inthe upper left corner of the Access Control table, click Add User Names from Clipboard.
All of the users who are currently on your clipboard are added to the Access Control table.

For more information on how to use the Vibe clipboard, see “Using the Vibe Clipboard” in the
OpenText Vibe 4.0.8 User Guide.

2 Assign the users to the appropriate role by selecting the check box in the column of each user’s
row, as described in “Assigning Roles to Users and Groups” on page 53.

3 Click Save Changes.

Adding Groups to the Access Control Table

1 Click the Add a Group link in the left column of the table.

2 Inthe Add a Group field, begin typing the name of the group that you want to add, then select
that group from the provided list.

Vibe adds a new row to the table for the new group.

3 Assign the group to the appropriate role by selecting the check box in the column of the group’s
row, as described in “Assigning Roles to Users and Groups” on page 53.

4 Click Save Changes.
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4.2.2

Assigning Roles to Users and Groups

Arole is a set of privileges. When you assign a user or group to a role, that user or group
automatically has all the rights associated with that role.

1 Ensure that the user or group and the role that you want to associate with the user or group are

visible in the Access Control table.

For information on how to add a role or a user or group to the table, see “Adding Roles to the
Access Control Table” on page 51, “Adding Users to the Access Control Table” on page 52, and
“Adding Groups to the Access Control Table” on page 52.

2 Inthe row of the user or group, select the check box that is located in the role column that you

want to assign to the user or group.
3 Click Save Changes.

If you want to unassign a role:

1 Deselect the appropriate check box, then click Save Changes.

Using the Configure Access Control Page to Adjust Access Controls

Vibe lets you adjust the access control settings of any workspace or folder, directly from the
Configure Access Control page.

1 Inthe workspace tree at the top of the Configure Access Control page, navigate to the place
where you want to adjust the access controls.

2 Click the linked title of the place where you want to adjust the access controls.

Vibe displays the Configure Access Control page for the page that you specified.

Creating Access Controls for Remote Applications

Because not all remote applications can be completely trusted, it is often a good idea to limit the
privileges of the remote application.

For information on how to do this by using access controls, see Section 12.4, “Managing Access
Controls for Remote Applications,” on page 184.

Controlling Access to Entries

Vibe lets you set access controls for an entry that differs from the access controls of the parent

folder. You might want to do this if you have granted a group of users access to a folder, but you want
only a subset of that group to have access to see certain entries within the folder. Or, you might want
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to set access controls on a particular entry to make that entry visible to users who don’t have access
to the folder where the entry resides, as described in “Exposing a Vibe Entry to a Wider Audience
Than the Folder Access Controls Allow” on page 56.

Before you can modify access controls for an entry, ensure that the entry does not inherit its access
control settings from the parent folder.

To set access controls on an entry:
1 Navigate to the entry where you want to modify user access rights.

2 Click Actions > Access Control in the Entry toolbar.

The Configure Access Control page is displayed.

market analysis Close €3
Configure Access Control
;
Entry: market analysis

Entry Cwner: Julio Chavez(jchavez)

Sharing
This has not been shared.

This entry uses the parent folder access controls. [view who has access to the folder..]

®* Use the parent folder access controls
Specify the access controls for this entry

3 To set access controls that differ from the access controls of the parent folder, select Specify the
access controls for this entry, then click Apply.
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market analysis Close €3

Configure Access Control

. Close
Entry: market analysis -
Entry Owner. Julio Chavez(jchavez)
Sharing
This has not been shared.
This entry uses entry specific access controls.
Use the parent folder access controls
® Specify the access controls for this entry
Add User Names from Clipboard
Read Read and Reply Write Delete Change Access Controls
Cwner of Entry i i i i i
Team Members
Add a Group + Group Title Group Name Read Read and Reply Write Delete Change Access Conirols
—No groups—
AddaUser - User Title User Id Read Read and Reply Write Delete  Change Access Controls
—No users—
#| Include the Folder Access Controls [view who has access to the folder.. ]
[admin (admin) has been designated as the default site administrator with privileges to perform any task on any workspace
or folder.]

4 Use the table to modify user access to the entry.
You can assign various roles to team members, groups, or individual users.

For information about the roles that you can assign, see “Understanding Default Roles for
Entries” on page 48.

For information about how to add users and groups to the access control table, see “Adding
Users to the Access Control Table” on page 52 and “Adding Groups to the Access Control Table
on page 52.

”

5 (Optional) Select Include the Folder Access Controls if you want to extend the new entry-level
access controls to include the access controls that are already in place for the folder. Selecting
this option automatically grants users the same access rights to the entry that they have to the
folder.

Deselect Include the Folder Access Controls if you want the new entry-level access controls to
override the folder-level access controls. If you deselect this option, you must use the entry-
level access controls to specify each user or group that you want to have access to the entry.
Users who have access to the folder that contains the entry but have not been granted access
rights to the entry itself do not have access to the entry.

6 Click Save Changes > Close.
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4.3

Exposing a Vibe Entry to a Wider Audience Than the Folder Access
Controls Allow

You can make a Vibe entry visible to a wider audience than is normally allowed for the folder where
the entry resides. For example, if your folder is visible only to team members, the default access
controls allow only team members to see all entries that are created in the folder. However, by
deselecting Include the Folder Access Controls, you can enable a wider audience to view a specific
entry. You might want to do this if the majority of content in a folder is sensitive and should be
restricted to a limited audience, but you want to expose a specific entry to a larger audience.

For example, suppose that you are a member of a finance team that is responsible for the
accounting of your company’s quarterly earnings. All of the information in your team’s workspace is
confidential. However, when it is time to announce the company’s quarterly earnings, you create a
Vibe entry that contains the earning results, and you modify the access controls of this specific entry
to make the entry visible to all company employees.

To expose a Vibe entry to a wider audience than is currently allowed in the folder:

1 Modify the entry access controls as described in Section 4.2.2, “Controlling Access to Entries,”
on page 53.

Ensure that you deselect Include the Folder Access Controls, as described in Step 5 of this
section.

NOTE: When you expose a Vibe entry to a wider audience than is currently allowed in the folder,
users must perform a search in order to locate the entry, or they must have the entry shared with
them. Users cannot locate the entry by navigating the Workspace tree as described in “Navigating
the Workspace Tree” in the OpenText Vibe 4.0.8 User Guide.

Managing Access Control for Remote Applications

Because not all remote applications can be completely trusted, it is a best practice to limit the
privileges of the remote application.

For information on how to do this by using access controls, see Section 12.4, “Managing Access
Controls for Remote Applications,” on page 184.
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5 Branding a Folder or Workspace

Branding a folder or workspace is a good way to make the folder or workspace more unique and
identifiable. When you brand a folder or workspace, the brand is applied to all sub-workspaces and
sub-folders. However, folder and workspace owners in lower-level folders and workspaces can
override the higher-level brand settings by adding a workspace brand of their own. For example, the
Global Workspaces folder can be branded with the company logo and slogan, while a team
workspace at a lower level in the workspace tree can be branded with a logo for the product that the
team is responsible for. Members of that team can then override the team brand by branding
individual folders within the team workspace that they are responsible for.

Vibe administrators can disable this functionality when they create a site-wide brand, as discussed in
“Creating a Site-Wide Brand” in the OpenText Vibe 4.0.8 Administration Guide.

If you are unable to brand a folder or workspace as discussed in this section, contact your Vibe
administrator.

To brand a folder or workspace:

1 Navigate to the folder or workspace where you want to create the brand.

2 Click the Configure icon '@' next to the folder or workspace title, then click Brand Workspace or
Brand Folder.

The Workspace/Folder Branding dialog box is displayed.

Workspace/Folder Branding Q

® Use Branding Image: Novell Vibe ¥ || g

Use Advanced Branding Edit Advanced

Background Image: No images available ¥ || fa
Stretch image
Select a color by using the popup color list or enter a preferred color name, RGEB value, or HEX number {white, rgh{255,255,255), #ffffff)

Background color:

Text Coler:

Clear Branding

3 Specify the following information to create your desired brand:
Use Branding Image: Select this option if you want to use the drop-down list to select an

existing image, or click the Browse icon & to browse to an image on your computer’s file
system.

Use Advanced Branding: Select this option, then click Edit Advanced if you want to create a
brand that includes advanced features, such as linking to another Vibe page or displaying a
YouTube video.
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You can add a YouTube video in your branding section by using the HTML editor and including
the YouTube URL.

For more information about displaying YouTube videos in Vibe, see “Displaying YouTube Videos
in a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.

For more information about linking to another Vibe page, see “Linking to a Folder or Folder
Entry” in the OpenText Vibe 4.0.8 User Guide.

If you add a URL to the advanced branding, the URL cannot contain the
url _created by teani ng parameter. If this parameter does exist, delete it before saving
your brand.

Background Image: Click the Browse icon & to browse to an image on your computer’s file
system. If you are branding a team workspace, you can use the provided drop-down list to
select an image that is already attached to the workspace. (For information on how to attach an
image to a team workspace, see “Modifying a Workspace” in the OpenText Vibe 4.0.8 User
Guide.)

This background image is displayed behind your regular branding.
Stretch Image: Stretches the image to occupy the entire branding area.

If you stretch your background image, the image overrides any background color that you have
set.

Background Color: Adds a background color that occupies the entire branding area. To change
the background color, click the color name to the right of this field, select the new color, then
click OK.

If you added a background image and stretched the image, the background color is not
displayed.

Text Color: Changes the text color of the workspace name in the upper right corner of the
branding area. To change the text color, click the color name to the right of this field, select the
new color, then click OK.

Clear branding: Clears all of your current branding selections.
Click OK.

The folder or workspace now displays the brand that you created.
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6 Creating and Managing Landing Pages

Landing pages in Vibe can benefit your workspaces and folders in two key ways:

+ Improved Customization: Landing pages provide an excellent opportunity to put a custom,
personal face on workspaces and folders in your Vibe site, while still providing the team-
focused, collaborative functionality that Vibe affords.

+ Increased Retrievability: Landing pages increase the accessibility and visibility of the

information that is most critical to your team or organization. You can bring important entries or

entire folders to the forefront of workspaces, ensuring that users access the information they
need in a quick, efficient manner.

For example, a landing page for a city’s public sector might look something like this:

Welcome to the City of Plattsburg

@ Employee Partal Welcome to the Public Portal 9 First Aid Certification
We customized this landing page using the landing page editor to make it have a user-friendly look . "
Information andfeel. Click onthe links on the lsft and right navigation areas to find out how they could be utilized { Neighborhood Watch Network
in a real government public portal. Also, refer to the Public Partal portion of the walkthrough to find out
more about this public portal. Once you are ready, click Intranet on the left to continue this demo
9 FAQ -Teaming Library @ Zoning Approval
Q Jobs @ Small Business Licenses
. ' .
Flower Princess from Last Year's Spring

0 Plattsburg Going Green

9 Report a Problem

First Aid Certification

Message from the Mayor

| wish | could personally thank every one of you
for the work you do! Our beautiful City has never
been as great of a place to live in all the years |
have lived here as itis right now. This is a direct
result of all the hard work you put into making
Platts burg the best City to live in. Thank you!

We are offering a free first aid certification
course at our local fire station

Spring Festival

Itis an exciting time to be living in the City of
Plattsburg. Qur economy and population have
been growing at a steady rate over the last few
years and we expect it to continue. Crime rates
and accident rates have never been lower!
Businesses are thriving and housing prices are

Help us bring inthe Spring season by
participating in our Spring Festival. We will
have plenty of activities for kids and adults!

ELeragI\tI;increasing The future looks bright for Clean the City Day
Sincerely, Please participate in our city-wide "Clean the
Wajor Dan Johmsan st s b ol
beautiful City 2 little more beautiful.

+ Section 6.1, “Landing Page Best Practices,” on page 60

+ Section 6.2, “Enabling the Landing Page View for a Workspace,” on page 61

+ Section 6.3, “Setting Up Your Landing Page,” on page 62

+ Section 6.4, “Adding Content to Your Landing Page,” on page 67
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+ Section 6.5, “Configuring Landing Page Elements,” on page 70

+ Section 6.6, “Previewing Your Landing Page,” on page 84

+ Section 6.7, “Publishing Your Landing Page,” on page 84

+ Section 6.8, “Modifying the Contents of Your Landing Page,” on page 84
+ Section 6.9, “Changing the Order of Landing Page Elements,” on page 85
+ Section 6.10, “Deleting Content from Your Landing Page,” on page 85

¢ Section 6.11, “Automatically Displaying the Newest Folder Entries on Your Landing Page,” on
page 86

+ Section 6.12, “Adding Accessories to Your Landing Page,” on page 88

+ Section 6.13, “Enabling Graphics to Be Used on a Landing Page,” on page 90

+ Section 6.14, “Displaying YouTube Videos on a Landing Page,” on page 91

+ Section 6.15, “Creating a Landing Page On Your Personal Workspace,” on page 92
+ Section 6.16, “Creating a Landing Page for a Folder,” on page 93

+ Section 6.17, “Downloading Existing Landing Pages,” on page 93

6.1 Landing Page Best Practices

When creating landing pages, the following best practices can make the creation process easier and
make your landing pages more visually appealing:

+ Section 6.1.1, “Best Practices for Adding Content,” on page 60

+ Section 6.1.2, “Best Practices for Look and Feel,” on page 60

6.1.1 Best Practices for Adding Content

To easily add content to your landing pages:
+ Wherever possible, build custom pieces using HTML elements on the landing page itself.

For more information about adding HTML elements, see “Adding an HTML Editor” on page 82.

+ If you want to duplicate the same information on multiple landing pages, create the information
in an entry (such as a blog entry) somewhere on the Vibe site where you have access. After you
create the information in an entry, you can then reference that entry from multiple landing
pages.

For more information about adding entry elements, see “Adding an Entry” on page 73.

+ If you plan to edit the HTML of an item, ensure that you have local copies of all images in the
HTML. Images do not load properly when you edit the landing page unless you have local
copies.

6.1.2 Best Practices for Look and Feel

To make your landing page look more professional:

+ Create nice looking graphics to incorporate into the page.
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6.2

6.2.1

+ Use a simple, classy image for the background that can be repeated vertically and horizontally.

+ For subject headers, set the opacity to somewhere between .65 and .85 (<style="opacity:
.??2;">), and round each corner to somewhere between 4 and 10 (<style="border-radius:
??px:>). Ensure that settings for each corner are consistent.

+ When you want to display a graphic on the landing page, especially in tables, re-size the graphic
outside of Vibe before you add it to the landing page. Then use that pre-sized graphic as a
building block to build out the desired sized page. This is important because the pixel sizing
within the landing page editor might not present what you expect.

+ When you want to display a calendar on the landing page, always use the Enhanced View
element.

For more information about the Enhanced View element, see “Adding an Enhanced View
Element” on page 75.

+ If your table contains pixels (or if the percentages do not total 100 percent), you must add an
additional column to the table that has a width of * in order for the columns to stay at their
fixed widths. This is an HTML browser requirement.

For example, suppose you want a 3-column table with the first column with a width of 450
pixels, the second column with a width of 150 pixels, and the third column with a width of 10
percent. In order for the columns to retain their fixed widths, you must add a fourth column,
and specify * in the provided field.

Enabling the Landing Page View for a Workspace

Before you can create the landing page, you need to enable the landing page view for the
workspace.

Micro Focus Vibe includes a default workspace landing page view. The default landing page view
contains a Landing Page Layout section, a Description section, a Branding section, an Icon section,
and an Attachments section.

Or, you can create a custom landing page view for a workspace that contains only the sections that
you choose. For information on how to create a custom landing page view for a workspace, see
Chapter 7, “Creating Custom Workspace Views,” on page 95.

You can enable the landing page view on an existing workspace, or when you are creating a
workspace.

+ Section 6.2.1, “Enabling the Landing Page View on an Existing Workspace,” on page 61
+ Section 6.2.2, “Enabling the Landing Page View on a Workspace You Are Creating,” on page 62

Enabling the Landing Page View on an Existing Workspace

1 Navigate to the workspace where you want to create the landing page.

You can create a landing page for a personal workspace only if your Vibe administrator has
enabled you to do so. For more information, see Section 6.15, “Creating a Landing Page On Your
Personal Workspace,” on page 92.

2 Click the Configure icon 9 next to the workspace title, then click Configure Views, URLs and
Controls.
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3 On the Configure Workspace View tab, in the Default View section, select Landing Page.
4 Click Apply > Close.

What was previously displayed on the main page of the workspace is no longer displayed and
the main page of the workspace is blank.

5 Continue with Section 6.3, “Setting Up Your Landing Page,” on page 62.

6.2.2 Enabling the Landing Page View on a Workspace You Are
Creating

1 Navigate to the workspace where you want to create the new workspace.

2 Click the Configure icon @ next to the workspace title, then click New Workspace.
The New Workspace page is displayed.

3 In the Workspace Title field, specify a title for the workspace.

4 In the Workspace section, select Landing Page.

5 Finish creating the workspace, then click OK.

For more information on creating a workspace, see “Creating a New Workspace” in “General
Workspace Management” in the OpenText Vibe 4.0.8 User Guide.

6 Continue with Section 6.3, “Setting Up Your Landing Page,” on page 62.

6.3 Setting Up Your Landing Page

After you enable a landing page as described in Section 6.2, “Enabling the Landing Page View for a
Workspace,” on page 61, you need to set it up to display the desired layout options and content. By
default, landing pages in sub-folders and sub-workspaces display the same landing page properties
as the parent folder or workspace.

+ Section 6.3.1, “Choosing Layout Options for Your Landing Page,” on page 62

+ Section 6.3.2, “Adding a Background Image or Color to Your Landing Page,” on page 64

+ Section 6.3.3, “Changing the Background and Text Color of Landing Page Headings,” on page 65

¢ Section 6.3.4, “Changing the Color and Width of the Landing Page Border,” on page 66

6.3.1 Choosing Layout Options for Your Landing Page

1 Navigate to the landing page that you created in Section 6.2, “Enabling the Landing Page View
for a Workspace,” on page 61.

2 Click the Configure icon E} next to the workspace or folder title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.
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Market Research
Title

Market Research

Drag and drop any of the elements onto the workspace layout area to design the landing page.
Hover over each element for a description JSE-X )

[l rapie

E st

= Entry

[ Foer

3 Click the Landing Page Properties Configuration icon ﬁ' in the upper right corner of the landing
page editor.

The Landing Page Properties dialog box is displayed.

4 Deselect Inherit landing page properties to make changes to the landing page properties. (By
default, landing page properties are inherited from workspace and folder landing pages higher
up in the workspace hierarchy.)

Landing Page Properties

Imhent landing page properties

Mizcellaneous Background Header Border
Hide the masthead Hide the navigation panel
Hide the footer Hide the menu

Comtent text color.
(white. rgb{255_255 265). #itif)

Page style Light *® Dark

ok | Gancet ]

5 Click the Miscellaneous tab.
6 The following options for modifying the display of your landing page are available:

+ Hide the Masthead: Select this option to hide the masthead (Navigation toolbar). This
hides everything above the Action toolbar.

+ Hide the Navigation Panel: Select this option to hide the Navigation panel.
+ Hide the Footer: Select this option to hide the Footer toolbar.

+ Hide the Menu: Select this option to hide the menu (Action toolbar) from all users who do
not have rights to edit the workspace. Users who have rights to edit the workspace still see
the menu.

+ Content text color: Specify the color of the text that appears on the landing page.

*

Page style: Select from the following options to modify the style of your landing page:

+ Light: No background shading is displayed on landing page elements.
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+ Dark: (Default) Displays a dark background on each element to provide contrast
between the landing page elements.

7 Click OK to save your changes.

You can preview your changes by clicking the Preview icon E in the upper right corner of the
landing page editor.

6.3.2 Adding a Background Image or Color to Your Landing Page

1 Navigate to the landing page that you created in Section 6.2, “Enabling the Landing Page View
for a Workspace,” on page 61.

2 Click the Configure icon E" next to the workspace or folder title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.

IMarket Research
Title

Market Research

Drag and drop any of the elements onto the workspace layout area to design the landing page
Hover over each element for a description E .n, e

[ rstie

E List

= Entry

7 Foider

3 Click the Landing Page Properties Configuration icon ﬁ in the upper right corner of the landing
page editor.

The Landing Page Properties dialog box is displayed.

4 Deselect Inherit landing page properties to make changes to the landing page properties. (By
default, landing page properties are inherited from workspace and folder landing pages higher
up in the workspace hierarchy.)

Landing Page Properties

Inhent landing page properties

Miscellaneocus Background Header Border
Hide the masthead || Hide the navigation pane!
Hide the footer Hide the menu

Comtent text color.
{white. rgb{255 255 265), #iffif)

Page styls Light "® Dark

ok ] Cancel |

5 Click the Background tab.
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6 Configure the following options to modify the background image or color for the landing page:
Background Image: To add images to be used as the background image, you must first add

them to the drop-down list before you can select them. Click the Browse icon E , then
navigate to and select the image that you want to add. Select the image from the drop-down list
that you want to use as the background image.

Background image repeat: In the drop-down list, select whether you want the image to repeat
horizontally and vertically, only horizontally, only vertically, or not at all.

Background color: Click the Color palette icon to choose a color from a list of colors.

7 Click OK to save your changes.

You can preview your changes by clicking the Preview icon E' in the upper right corner of the
landing page editor.

Changing the Background and Text Color of Landing Page
Headings

You can configure the background and text color that is displayed in the headings for landing page
elements:

1 Navigate to the landing page that you created in Section 6.2, “Enabling the Landing Page View
for a Workspace,” on page 61.

2 Click the Configure icon 9 next to the workspace or folder title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.

Market Research

Title

Market Research

Drag and drop any of the elements onto the workspace layout area to design the landing page.

Hover over each element for a description k- X
[ rane

E st
| Entry

[ Foider

3 Click the Landing Page Properties Configuration icon ﬁ in the upper right corner of the landing
page editor.

The Landing Page Properties dialog box is displayed.

4 Deselect Inherit landing page properties to make changes to the landing page properties. (By
default, landing page properties are inherited from workspace and folder landing pages higher
up in the workspace hierarchy.)
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Landing Page Properties
Inhent landing page properties
Miscellaneocus Background Header Border

Hide the masthead | Hide the navigation panel

Hide the footer Hide the menu

Comtent text color.
{white. rgb{255_ 255 265), #ffif)

Page style Light ® Dark

ok ] Cancel ]

5 Click the Header tab.

Configure the following options to modify the background and text color that is displayed in the
headings for landing page elements:

Header background color: Click the Color palette icon to choose a color from a list of

colors.

Header text color: Click the Color palette icon to choose a text color.

6 Click OK to save your changes.

You can preview your changes by clicking the Preview icon E in the upper right corner of the
landing page editor.

6.3.4 Changing the Color and Width of the Landing Page Border

1 Navigate to the landing page that you created in Section 6.2, “Enabling the Landing Page View
for a Workspace,” on page 61.

2 Click the Configure icon E" next to the workspace or folder title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.

IMarket Research
Title

Market Research

Drag and drop any of the elements onto the workspace layout area to design the landing page
Hover over each element for a description JSE-X )

[] ratie

E st

[ ety

7 Foider

3 Click the Landing Page Properties Configuration icon 'ﬁ’ in the upper right corner of the landing
page editor.

The Landing Page Properties dialog box is displayed.
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4 Deselect Inherit landing page properties to make changes to the landing page properties. (By
default, landing page properties are inherited from workspace and folder landing pages higher
up in the workspace hierarchy.)

Landing Page Properties

Inhent landing page properties

Miscellaneocus Background Header Border
Hide the masthead Hide the navigation panel
Hide the footer Hide the menu

Comtent text color.
{white. rgb{255_ 255 265), #ffif)

Page style Light ® Dark

ok ] Cancel ]

5 Click the Border tab.
Configure the following options to modify the color and width of the landing page border:
Border color: Click the Color palette icon “" ' to choose a color.

Border width: Specify how thick you want the border to appear. Specifying a 1 in this field
results in a thin border, and specifying a 10 results in a very thick border.

6 Click OK to save your changes.

You can preview your changes by clicking the Preview icon E in the upper right corner of the
landing page editor.

Adding Content to Your Landing Page

To help make the landing page creation process easier and to help make your landing pages look
more professional, review the best practices discussed in Section 6.1, “Landing Page Best Practices,”
on page 60.

1 Navigate to the landing page that you created in Section 6.2, “Enabling the Landing Page View
for a Workspace,” on page 61.

2 Click the Configure icon E" next to the folder or workspace title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.
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IMarket Research

Title

[Market Research

Drag and drop any of the elements onto the workspace layout area to design the landing page.
Hover over each element for a description JSE-Xx)

fiii] [

List

| Entry

T Foider

3 In the Landing Page Layout section, in the content editor, use the element palette to select the
landing page element that you want to display on your landing page.

| Entry

t: 5 Folder

53| Enhanced View

».¥ Graphic

L5) Link [URL)

E-IT] Link to FolderWorkspace

M Link to Entry

5 utility Element

a Custom JSP
E] hrae

E Embedded Web Page

You can add the following elements:

+ Table: Creates a table with the number of columns that you specify. You can add other

elements inside this table.

¢ List: Creates a list where you can add other elements.

+ Entry: lets you reference an entry that has previously been created in Micro Focus Vibe.

The actual content of your landing page can be created in entries elsewhere on the Vibe
site which are then simply referenced from the landing page. This is helpful if you want to
duplicate the same information on multiple landing pages. After you create the
information in an entry, you can then reference that entry from multiple landing pages.

When you add an entry to the landing page by using the Entry element, only the entry title
and description can be displayed. If you want to display entry comments, add the
Enhanced View element to the landing page.

Folder: lets you reference a folder that has previously been created in Vibe. You can choose
how many entries from the folder that you want to display on your landing page at any one
time.

Enhanced View: lets you display entries and folders in enhanced ways. The following
options are available:

+ Display an entry: Displays the entry title, description, author, date, and the 10 most
recent comments.
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+ Display recent entries: Displays the most recent entries from the specified folder.
Displays the title, description, author, date, and the 10 most recent comments for
each entry.

+ Display a list of recent entries: Displays a list of the most recent entries from the
specified folder. Displays the title, author, and date of the entry.

+ Display a sorted list of recent entries: Displays a list in alphabetical order of the most
recent entries from the specified folder. Displays the title, author, and date of the
entry.

+ Display a sorted list of files: Displays a list in alphabetical order of the files that were
most recently added to the folder. This includes files that are attached to entries.

+ Display calendar: Displays the specified calendar with the full calendar view.

+ Display my calendar events: Displays all the calendar events and tasks that are
assigned to the user who is viewing the landing page. Calendar events and tasks are
displayed in a calendar view. Tasks are displayed on the calendar according to the task
duration; tasks that do not have either a start and end date or a duration specified are
not displayed.

+ Display task folder: Displays the specified task folder with information about each
task, such as the title, due date, priority, and so forth.

+ Display my tasks: Displays all the tasks that are assigned to the user who is viewing
the landing page.

+ Display survey: Displays the specified survey in a full, interactive view. Users can
participate in the survey directly from the landing page.

Graphic: lets you reference a graphic that has previously been added to the workspace.
Link (URL): lets you create a link to a web URL.

Link to Folder/Workspace: lets you add a link to a Vibe folder or workspace.

Link to Entry: lets you add a link to a Vibe entry.

Utility Element: lets you add various utilities, such as the My Workspace link.

Custom JSP: lets you reference a custom JSP file that has previously been created by a Vibe
administrator.

HTML: Displays an HTML editor where you can compose messages, create links, upload
pictures, and more. The information that you create in this HTML editor is displayed on
your landing page.

Embedded Web Page: lets you reference any website and display it on your landing page.

4 Drag the element that you want to display on your landing page and drop it onto the landing
page canvas.
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E List
= Entry
T Folder

3| Enhanced View

[(] Table

4.4 Graphic

(50 Link (URL)

[ Link to FolderWorkspace
) Link to Entry

{3 utility Element

Tl custom JsF

HTML

Embedded Web Fage

After you drop the element onto the landing page canvas, you are prompted to configure it.

How you configure a landing page element depends on the type of element that you add.

Configure the landing page element as described in Section 6.5, “Configuring Landing Page
Elements,” on page 70.

Configuring Landing Page Elements

You need to configure the elements of your landing page when you create them, as described in
Section 6.4, “Adding Content to Your Landing Page,” on page 67.

You can also reconfigure the elements of your landing page at any time, as described in Section 6.8,
“Modifying the Contents of Your Landing Page,” on page 84.

*

*

*

*

Section 6.5.1, “Adding a Table,” on page 71

Section 6.5.2, “Adding a List,” on page 72

Section 6.5.3, “Adding an Entry,” on page 73

Section 6.5.4, “Adding a Folder,” on page 74

Section 6.5.5, “Adding an Enhanced View Element,” on page 75
Section 6.5.6, “Adding a Graphic,” on page 76

Section 6.5.7, “Adding a Link (URL),” on page 77

Section 6.5.8, “Adding a Link to a Folder/Workspace,” on page 78
Section 6.5.9, “Adding a Link to an Entry,” on page 78

Section 6.5.10, “Adding a Utility Element,” on page 79

Section 6.5.11, “Adding a Custom JSP,” on page 80

Section 6.5.12, “Adding an HTML Editor,” on page 82

Section 6.5.13, “Adding an Embedded Web Page,” on page 83

After you have added and configured the elements of your landing page, you are ready to publish

the landing page. For information on how to do this, see Section 6.7, “Publishing Your Landing Page,”

on page 84.
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6.5.1 Adding a Table

To add a table to the landing page:

1 Inthe Landing Page Layout section, in the content editor, click Table in the element palette, then
drag the table into the desired area of the landing page canvas.

Table Properties

! Show border

Number of rows: 4

Number of columns: |2 ¥ |

Column 1 width- 50 [ [% *|

Column 2 width: 50 ' [% |

2 Set the following configuration options to finish setting up the table:
+ Show border: Select this option if you want the border of the table to be visible.
+ Number of rows: Specify the number of rows that you want the table to have.

The height of the table is determined by the number of rows in the table and the contents
of the table.

+ Number of columns: Specify the number of columns that you want the table to have. You
can have up to ten columns.

¢ Column width: Specify the width that you want for each column by either percentage or
pixel. You can have both percentages and pixels within the same table.

If your table contains pixels (or if the percentages do not total 100 percent), you must add
an additional column to the table that has a width of * in order for the columns to stay at
their fixed widths. This is an HTML browser requirement.

For example, suppose you want a 3-column table with the first column with a width of 450
pixels, the second column with a width of 150 pixels, and the third column with a width of
10 percent. In order for the columns to retain their fixed widths, you must add a fourth
column, and specify * in the provided field.

3 Click OK.
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After you add a table to a landing page, you can add content within the table.

1 Select an element from the element palette and drag and drop it into the location of the table
where you want to add the content.

6.5.2 Adding a List

To add a list to the landing page:

1 Inthe Landing Page Layout section, in the content editor, click List in the element palette, then
drag the list and drop it into the desired area of the landing page canvas.

List Properties

Title | |

Width: (% v]

Height: | | px

[! Show scroll bars when nesded
) Show border

2 Set the following configuration options to finish setting up the list:
+ Title: Specify a title for the list.

+ Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

+ Height: (Conditional) Specify the height that you want the element to be on the landing
page by pixels.

+ Show scroll bars when needed: Select this option to have scroll bars appear on elements
when the element requires more room than the width and height that you defined. (If you
specified 100%, scroll bars are never needed.) If the element does need more room than
you defined and you do not select this option, the remaining part of the element is
cropped and you are unable to see it.

+ Show border: Select this option if you want the border of the list to be visible.
3 Click OK.
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6.5.3

After you add a list to a landing page, you can add content within the list.

1 Select an element from the element palette and drag and drop it into the location of the list
where you want to add the content.

Adding an Entry

The actual content of your landing page is created in entries. The landing page simply references
entries that have already been created within Vibe.

When you use the Entry element to add an entry to the landing page, only the entry title and
description can be displayed. If you want to display entry comments, add the Enhanced View
element to the landing page, as described in “Adding an Enhanced View Element” on page 75.

To add an entry to the landing page:

1 Inthe Landing Page Layout section, in the content editor, click Entry in the element palette, then
drag the entry into the desired area of the landing page canvas.

2 Click Edit next to the Entry field.

If you are reconfiguring the element, the entry that is being referenced is shown here.

Entry Properties

Entry: No entry selected Edit
Width: % v

Height: px

[=) Show scroll bars when needed

I_J Show Title Bar

3 Set the following configuration options to finish setting up the entry:

+ Entry: Click Edit, then select whether you want to search the entire site for the entry or
search only within the current folder or workspace, then use the provided field to specify
the entry that you want to display on the landing page.

This field uses type-to-find functionality, so Vibe displays the available options as you type.
Click in the field and press the Spacebar to list all the available options.

+ Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

+ Height: (Conditional) Specify the height that you want the element to be on the landing
page by pixels.
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+ Show scroll bars when needed: Select this option to have scroll bars appear on elements
when the element requires more room than the width and height that you defined. (If you
specified 100%, scroll bars are never needed.) If the element does need more room than
you defined and you do not select this option, the remaining part of the element is
cropped and you are unable to see it.

+ Show Title Bar: Select this option if you want the title bar of the entry to be visible.
4 Click OK.

6.5.4 Adding a Folder

1 Inthe Landing Page Layout section, in the content editor, click Folder in the element palette,
then drag the folder into the desired area of the landing page canvas.

2 Click Edit next to the Folder field.

If you are reconfiguring this element, the folder that is being referenced is shown here.

Folder Properties

Folder: Mo folder selected Edit

MNumber of entries to show: | 0
Width: % v
Height: px

) Show scroll bars when needed
) Show Title Bar
(! Show Folder Description

[} Show Entries opened

3 Set the following configuration options to finish setting up the folder:

+ Folder: Click Edit, then select whether you want to search the entire site for the folder or
search only within the current folder or workspace, then use the provided field to specify
the folder that you want to display on the landing page.

This field uses type-to-find functionality, so Vibe displays the available options as you type.
Click in the field and press the Spacebar to list all the available options.

+ Number of entries to show: Specify the number of folder entries that you want to be
displayed at any one time.

+ Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

+ Height: (Conditional) Specify the height that you want the element to be on the landing
page by pixels.
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+ Show scroll bars when needed: Select this option to have scroll bars appear on elements
when the element requires more room than the width and height that you defined. (If you

specified 100%, scroll bars are never needed.) If the element does need more room than
you defined and you do not select this option, the remaining part of the element is
cropped and you are unable to see it.

+ Show Title Bar: Select this option if you want the folder title bar to be displayed.

+ Show Folder Description: Select this option if you want the folder description to be
displayed.

+ Show Entries opened: Select this option if you want opened entries to be displayed.
4 Click OK.

6.5.5 Adding an Enhanced View Element

1 Inthe Landing Page Layout section, in the content editor, click Enhanced View in the element
palette, then drag the enhanced view into the desired area of the landing page canvas.

Enhanced View Properties

Enhanced View: | Display an entry v

Display the selected entry. The eniry's author, date and the 10 most
recent replies to the entry will be displayed.

Entry: Mo entry selected Edit

Width: % v
Height: px
) Show screll bars when needed

2 In the Enhanced View drop-down list, select one of the available options.
For more information about each option, see Enhanced View.

3 Set the configuration options that apply to the enhanced view element that you are adding.
Depending on the option that you selected in Step 2, the following configuration options are
available:

+ Entry: Click Edit.

If you are reconfiguring this element, the folder that is being referenced is shown here.
+ Folder: Click Edit.

If you are reconfiguring this element, the folder that is being referenced is shown here.

+ Find: Select whether you want to search the entire site for the folder or entry, or only

within the current folder or workspace; then use the provided field to specify the folder or

entry that you want to display on the landing page.
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+ Number of entries to show: (Conditional) Specify the number of folder entries that you
want to be displayed at any one time.

This option is available only when referencing a folder.

+ Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

+ Height: (Conditional) Specify the height that you want the element to be on the landing
page by pixels.

This option is not available when selecting Display calendar or Display my calendar events in
the Enhanced View drop-down list.

+ Show Title Bar: Select this option if you want the title bar to be displayed.
This option is available depending on what you select in the Enhanced View drop-down list.

+ Show scroll bars when needed: Select this option to have scroll bars appear on elements
when the element requires more room than the width and height that you defined. (If you
specified 100%, scroll bars are never needed.) If the element does need more room than
you defined and you do not select this option, the remaining part of the element is
cropped and you are unable to see it.

4 Click OK.

6.5.6 Adding a Graphic

Before you can add a graphic to your landing page, you need to attach the graphic to the landing
page, as described in Section 6.13, “Enabling Graphics to Be Used on a Landing Page,” on page 90.

1 In the Landing Page Layout section, in the content editor, click Graphic in the element palette,
then drag the graphic into the desired area of the landing page canvas.

Graphic Properties

Graphic:
novell_n.png ¥

|- Set image size
Width:
Height:

! Show border

(o] caca |

2 Set the following configuration options to finish setting up the graphic:
+ Graphic: In the Graphic drop-down list, select the graphic that you want to display.

All attachments that are attached to the landing page workspace are displayed in this list.
Attachments are also displayed in the Current Attached Files section at the bottom of the
page.

+ Set image size: Select this option to specify a specific width and height for the graphic.
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+ Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

+ Height: (Conditional) Specify the height that you want the element to be on the landing
page by pixels.

+ Show border: Select this option if you want the border of the graphic to be visible.
3 Click OK.

6.5.7 Adding a Link (URL)

1 Inthe Landing Page Layout section, in the content editor, click Link (URL) in the element palette,
then drag the link element into the desired area of the landing page canvas.

Link To Url Properties

Title

URL (e.g.. http:/iwww.novell.com)

[J Open the URL in a new window

2 Set the following configuration options to finish setting up the URL link:
+ Title: Specify the title that you want to be displayed.
¢ URL: Specify the URL that you want to link to.
To link to a URL outside of Vibe, you must include htt p: // at the beginning of the URL.

To link to a page within Vibe, the best method is to use the Link to Folder/Workspace
element or the Link to Entry element.

An alternative is to paste a Vibe permalink into this field. To get the permalink URL of a
Vibe page, simply navigate to the page that you want to link to, click Permalink in the
footer toolbar, then copy the permalink URL from the Permalink field.

+ Open URL in a new window: Select this option if you want to open the URL in a new
browser window.

3 Click OK.
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6.5.8 Adding a Link to a Folder/Workspace

You can create a link to any folder or workspace for which you have appropriate rights.

1 Inthe Landing Page Layout section, in the content editor, click Link to Folder/Workspace in the
element palette; then drag the link element into the desired area of the landing page canvas.

2 Click Edit next to the Folder/Workspace field.

If you are reconfiguring the element, the folder or workspace that is being referenced is shown
here.

Link to Folder/Workspace Properties

Folder/Workspace: Mo folder selected Edit

) Search entire site
Find: '® Search current folderfworkspace

Title:

] Open the folder'workspace in a new window

3 Set the following configuration options to finish setting up the link:

+ Folder/Workspace: Select whether you want to search the entire site for the folder or only
within the current folder or workspace; then use the provided field to specify the folder or
workspace that you want to link to.

This field uses type-to-find functionality, so Vibe displays the available options as you type.

+ Title: Specify a title for the link.

+ Open the folder/workspace in a new window: Select this option if you want to open the
folder or workspace in a new browser window.

6.5.9 Adding a Link to an Entry

lets you create a link to any entry for which you have appropriate rights.

1 In the Landing Page Layout section, in the content editor, click Link to Entry in the element
palette; then drag the link element into the desired area of the landing page canvas.

2 Click Edit next to the Entry field.

If you are reconfiguring the element, the entry or workspace that is being referenced is shown
here.
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Link to Entry Properties

Entry: Mo entry selected Edit

) Search entire site
Find: ® Search current folder'workspace

Title:

[Z) Open the entry in a new window

3 Set the following configuration options to finish setting up the link:

+ Find: Select whether you want to search the entire site for the entry or only within the
current folder or workspace; then use the provided field to specify the entry that you want
to link to.

This field uses type-to-find functionality, so Vibe displays the available options as you type.
+ Title: Specify a title for the link.

+ Open the entry in a new window: Select this option if you want to open the entry in a new
browser window.

6.5.10 Adding a Utility Element

Most utility elements are options that are normally displayed either in the Vibe masthead or
Navigation panel; however, because it is often desirable to hide the masthead and Navigation panel
in order to make more room for information on your landing page, utility elements enable you to
display important features in a more concise view.

1 In the Landing Page Layout section, in the content editor, click Utility Element in the element
palette; then drag the utility into the desired area of the landing page canvas.

Creating and Managing Landing Pages 79



Utility Element Properties

® Link to "Follow this folder or workspace”
) Link to "My Workspace”

) Link to "Share this folder or workspace”
) Link to "Vibe administration pags”

' Sign-in form

2 Select from the following utility elements:

Link to “Follow this folder or workspace”: Displays a Follow This Workspace or Follow This
Folder link.

Link to “My Workspace”: Displays a link to your personal workspace.

Link to “Share this folder or workspace”: Displays a Share This Workspace or Share This Folder
link.

Link to “Vibe administration page”: Provides a link to the Vibe Administration page.
This link is visible only to Vibe users who have administrative rights.
Sign-in form: Displays a sign-in form when users are not logged in to Vibe.

3 Click OK.

6.5.11 Adding a Custom JSP

Custom JSP files are stored in the \ webapps\ ssf\ VEEB- | NF\ j sp\ cust om j sps directory. If you
want to include a custom JSP file in your landing page, you must store the file in this directory in
order to reference it from Vibe.

Typically, only Vibe administrators have access to this directory. If you want to create a custom JSP
file, consult your Vibe administrator.

After the custom JSP file has been placed in the \ webapps\ ssf\ WEB- | NF\ j sp\ cust om j sps
directory:

1 In the Landing Page Layout section, in the content editor, click Custom JSP in the element
palette; then drag the JSP element into the desired area of the landing page canvas.
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Custom JSP Properties

Custom JSP name

[ Associate a folder with this custom jsp

[ Associate an entry with this custom jsp

Width: | | % v

Height: | | px

) Show scroll bars when needed

2 In the Custom JSP name field, type the name of the custom JSP file that you want to reference.

You must obtain this file name from your Vibe administrator. Only your Vibe administrator can
enable JSP files to be used in the Vibe site.

3 Depending on how you want to use this custom JSP file, select either Associate a folder with this
custom jsp, or Associate an entry with this custom jsp.

For example, if your administrator has enabled a custom JSP file that enhances the way entries
are displayed on the landing page, and you want to utilize this JSP file for a specific folder, you
would select Associate a folder with this custom jsp.

4 Click Edit next to the Folder field.

If you are reconfiguring the element, the field displays the folder that the custom JSP file is
currently associated with. If you are creating a new element, this field is blank.
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Custom JSP Properties

Custom JSP name

¥/ Associate a folder with this custom Isp

Folder: Mo folder selected Edit

) Search entire site
Find: ® Search current folder'workspace

Number of entries to show:

) Show Title Bar

) Associate an entry with this custom jsp

Width: %o
Height: px
") Show scroll bars when needed

5 Set the appropriate configuration options to finish setting up the custom JSP:

Find: Select whether you want to search the entire site for the folder or only within the current
folder or workspace; then use the provided field to specify the folder that you want to associate
the JSP file with.

This field uses type-to-find functionality, so Vibe displays the available options as you type.

Number of entries to show: Specify how many folder entries you want to be displayed on the
landing page at any one time.

Show Title Bar: Select this option if you want the title bar of the entry to be visible.

Width: Specify the width that you want the element to be on the landing page, either by
percent or pixels.

Height: (Conditional) Specify the height that you want the element to be on the landing page by
pixels.

CSS Overflow Property: Select a behavior option for when the element requires more room
than the width and height that you have defined.

6 Click OK.

6.5.12 Adding an HTML Editor

82

To add content (such as text, links, pictures, and videos) to your landing page by using an HTML
editor:

1 Inthe Landing Page Layout section, in the content editor, click HTML in the element palette;
then drag the HTML element into the desired area of the landing page canvas.
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Edit HTML

Edit View Insert Format Table
Arial 10pt Paragraph B / Y A - A &

E =E = E £ = = L

2 Specify content in the HTML editor that you want to be displayed on the landing page.
3 Click OK.

6.5.13 Adding an Embedded Web Page

1 In the Landing Page Layout section, in the content editor, click Embedded Web Page in the
element palette; then drag the page into the desired area of the landing page canvas.

Embedded Web Page Properties

URL (e.g.. http:/fwww.novell.com):

Frame name:

Height: px

Width: px

Show scrollbars:

[} Show border

2 Set the following configuration options to finish setting up the embedded web page:
+ URL: Specify the URL for the embedded web page that you want to display.

+ Title: Specify a title for the page. This title is displayed on the landing page above the
embedded web page.

+ Frame name: This is an internal name for the frame.
+ Height: Specify the height (in pixels) to indicate how much of the page you want to display.
+ Width: Specify the width (in pixels) to indicate how much of the page you want to display.

+ Show scrollbars: Select whether you want to display scroll bars. Keep the default of Auto if
you want Vibe to auto detect whether scroll bars are needed.
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+ Show border: Select whether you want to display a border around the embedded web
page.
3 Click OK.

6.6 Previewing Your Landing Page

You can preview changes that you make to your landing page before you publish it for user
consumption.

To preview changes that you have made to your landing page:

1 Click the Preview icon E in the upper right corner of the landing page editor.

6.7 Publishing Your Landing Page

After you have added elements to your landing page and configured them, you need to publish the
contents of the landing page.

1 Scroll to the bottom of the page that contains the landing page editor.
2 Click OK.
The landing page is displayed with all of the content that you previously added.

6.8 Modifying the Contents of Your Landing Page

Micro Focus Vibe lets you modify the elements that have been previously added to your landing
page.
1 Navigate to the landing page that contains the elements that you want to modify.
For information about each type of element, see Section 6.5, “Configuring Landing Page
Elements,” on page 70.
2 Click the Configure icon 9 next to the folder or workspace title, then click Edit Workspace or

Edit Folder, depending on whether your landing page is on a workspace or a folder.

3 In the landing page editor, click the edit icon # in the upper right corner of the landing page
element that you want to modify.

The properties dialog box of the element that you are modifying is displayed.
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Entry Properties

Entry: newest Edit
Width: %o
Height: pix

Show scroll bars when needed

Show Title Bar

4 Modify the properties of the element, then click OK.

6.9 Changing the Order of Landing Page Elements

Micro Focus Vibe lets you change the order of elements that have been previously added to your
landing page.
1 Navigate to the landing page that contains the elements that you want to reorder.
For information about each type of element, see Section 6.5, “Configuring Landing Page
Elements,” on page 70.
2 Click the Configure icon € next to the folder or workspace title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.

3 Inthe landing page editor, click the Move icon 4 in the upper right corner of the landing page
element that you want to move; then drag the element to the desired location on the landing
page canvas.

4 Click OK to save your changes.

6.10 Deleting Content from Your Landing Page

Micro Focus Vibe lets you delete elements that have previously been added to your landing page.

1 Navigate to the landing page that contains the element that you want to delete.

2 Click the Configure icon E" next to the folder or workspace title, then click Edit Workspace,
depending on whether your landing page is on a folder or a workspace.

3 Inthe landing page editor, click the delete @ icon in the upper right corner of the landing page
element that you want to delete.

4 Click OK to delete the element.
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6.11

6.11.1

Automatically Displaying the Newest Folder Entries on
Your Landing Page

You do not need to manually modify your landing page every time you want to replace an entry.
Because it can be tedious to delete an entry and then add another one from the Add/Delete form in
the Edit Workspace page, Micro Focus Vibe lets you leverage the power of workflows to help keep
your landing page up-to-date, with minimal manual effort.

For example, suppose that you are the manager of a particular product, and you want to use your
team landing page to display the product’s earnings for the most recent quarter. You could reference
a particular entry in the Quarterly Earnings folder, where all of the quarterly earnings for the product
are stored; however, this would mean that at the end of each quarter you would need to manually
delete the old entry from your landing page, and then add the new entry for the new quarter. Vibe
provides an easier way: simply reference the Quarterly Earnings folder from your landing page, and
at the end of each quarter start the Publish workflow (as described in Section 11.6.1, “Available
Workflows,” on page 173) on the entry that contains the earning for that quarter. This displays the
entry that contains the updated quarterly earnings.

+ Section 6.11.1, “Pointing to the Folder Where the Entry Resides,” on page 86

¢ Section 6.11.2, “Using the Publish Workflow to Publish Entries to Your Landing Page,” on
page 87

Pointing to the Folder Where the Entry Resides

When you add content to your landing page (as described in Section 6.4, “Adding Content to Your
Landing Page,” on page 67), if you display an entry that you might want to replace in the future, you
should reference the folder where the entry resides instead of referencing the entry directly.

1 Navigate to your landing page.

2 Click the Configure icon © next to the folder or workspace title, then click Edit Workspace or
Edit Folder, depending on whether your landing page is on a folder or a workspace.

3 In the landing page editor, click Folder in the element palette, then drag the folder into the
desired area of the landing page canvas.
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6.11.2

Folder Properties

Folderr No folder selected Edit

Mumber of entries to show: | 0
Width: % v
Height: pX

I_) Show scroll bars when needed
() Show Title Bar
[} Show Folder Description

[} Show Entries opened

4 Set the following configuration options to finish setting up the folder:

*

*

Folder: Click Edit.

If you have configured this element as described in this section, the folder that is being
referenced is shown here.

Find: Specify the folder where the entry that you want to display resides.
This field uses type-to-find functionality, so Vibe displays the available options as you type.

Number of entries to show: Specify the number of folder entries that you want to be
displayed at any one time.

Show Title Bar: Select this option if you want the folder title bar to be displayed.

Show Folder Description: Select this option if you want the folder description to be
displayed.

Show Entries opened: Select this option if you want opened entries to be displayed.

5 Click OK.

Using the Publish Workflow to Publish Entries to Your Landing

Page

By default, Vibe includes a workflow called Publish. This workflow can help you more easily manage
what is displayed on your landing page.

If you are referencing a folder from your landing page (as described in Section 6.11.1, “Pointing to
the Folder Where the Entry Resides,” on page 86), and you have configured the landing page to
display just one entry from the folder, you can use the Publish workflow to decide which entry you
want to display on your landing page.
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The most recent entry that you publish is the entry that is displayed on the landing page (published
to the landing page).

+ “Enabling the Publish Workflow on Your Folder” on page 88

+ “Publishing a New Entry to Your Landing Page” on page 88

Enabling the Publish Workflow on Your Folder
1 Navigate to the folder where you want to enable the Publish workflow.

2 Click the Configure icon € next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Allowed Workflows section, select
Publish Workflow.

4 Click Apply > Close.

Publishing a New Entry to Your Landing Page

1 Open the entry that you want to display on your landing page.
2 In the Entry toolbar, click Workflow > Start Workflow: Publish Workflow.

The entry where you most recently started the Publish workflow is now displayed on your
landing page, replacing the entry that was previously displayed.

6.12 Adding Accessories to Your Landing Page

You can add accessories to a landing page by modifying the view of the standard landing page, or by
creating a new landing page view. You must be the Vibe administrator to modify the view of the
standard landing page. If you are not the Vibe administrator, you must create a new landing page
view.

+ Section 6.12.1, “Modifying the Default Landing Page,” on page 88

¢ Section 6.12.2, “Creating a New Landing Page View,” on page 89

6.12.1 Modifying the Default Landing Page

You can add the Accessory Panel to the default Landing Page view. This means that all landing pages
that are created in the Vibe site will contain the Accessory Panel.

You must be the Micro Focus Vibe administrator or have administrative rights to modify the default
Landing Page view.
1 Click your linked name in the upper right corner of any Vibe page, then click the Administration
Console icon "2/,
The administration page is displayed.
2 Under System, click Form/View Designers.

The Form and View Designers page is launched.
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6.12.2

3 Expand Workspace view, then click Landing Page.
4 Click Workspace view > Add.
5 In the Standard Form Elements section, click Accessory Panel, then click OK.

The Accessory Panel has now been added to the standard Landing Page view, so users can add
accessories to their landing pages.

Creating a New Landing Page View

You can create your own Landing Page view, and then add the Accessory Panel element to the view.

You do not need to be the Vibe administrator to create a new landing page view.

+ “Creating the New Landing Page Definition” on page 89

+ “Adding the Landing Page Layout Option” on page 89

+ “Enabling the New Landing Page” on page 90

+ “Modifying the Landing Page After You Have Created It” on page 90

Creating the New Landing Page Definition
1 Navigate to the workspace where you want to create the new Landing Page view.

2 Click the Configure icon 9 next to the workspace title, then click Form/View Designers.
The Form and View Designers page is displayed.

3 Click New > Workspace views.

4 Specify the following information:
Caption: Specify a name for the new landing page.

This is the name that appears in the Vibe interface for users to see when they use this
workspace. (For example, Cust om Landi ng Page.)

Name: Specify the internal name for the landing page.

The name that you enter in this field is not visible to users who use this workspace. (For
example, cust om | andi ng_page.)

Family: Select the workspace type that this view is most closely associated with.

Workspace Icons: Select the workspace icon that you want to represent the landing page.
5 Click OK.

The Designer page is launched.

6 Continue with “Adding the Landing Page Layout Option” on page 89.

Adding the Landing Page Layout Option

1 In the Designer page, click Workspace Add/Modify Form > Add.
2 In the Layout Options section, click Landing Page Layout.
3 Specify the following information:
Caption: Specify a name for the Landing Page Layout, or keep the default.

Name: Specify the internal name for the Landing Page Layout.
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6.13

6.13.1

Click OK.
Click Workspace view > Add.

In the Standard Form Elements section, click Landing Page Layout.

N o u b

For the Caption and Data item name fields, retain the same information that you specified in
Step 3.

Click OK > Close > Close.

(+]

9 Continue with “Enabling the New Landing Page” on page 90.

Enabling the New Landing Page

After you have created the new landing page view, you need to enable it on the workspace.

1 Navigate to the workspace where you want to enable the landing page.
2 Click the Configure icon © next to the workspace title, then click Configure Views, URLs and
Controls.

3 On the Configure Workspace View tab, in the Default View section, go to the Local Definitions
subsection and select the landing page that you created.

4 Click Apply > Close.
The landing page is now displayed when you access the workspace.

5 Continue with “Modifying the Landing Page After You Have Created It” on page 90.

Modifying the Landing Page After You Have Created It

Now that you have created and enabled the new landing page, you can configure the landing page
layout options, such as hiding the Navigation panel. This can give your landing page a more
traditional landing page feel.

For information about how to modify the landing page layout options, see Section 6.3.1, “Choosing
Layout Options for Your Landing Page,” on page 62.

Enabling Graphics to Be Used on a Landing Page

Before you can add a graphic to a landing page, as described in “Adding a Graphic” on page 76, you
need to attach the graphic to the workspace or folder, depending on whether your landing page is on
a workspace or folder.

+ Section 6.13.1, “Enabling Graphics to Be Used on a Workspace Landing Page,” on page 90
+ Section 6.13.2, “Enabling Graphics to Be Used on a Folder Landing Page,” on page 91

Enabling Graphics to Be Used on a Workspace Landing Page
1 Navigate to the landing page where you want to attach the graphic.

2 Click the Configure icon @ next to the workspace title, then click Edit Workspace.
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6.14

3 Inthe Attachments section, click Browse, then browse to and select the graphic that you want to
add.

4 After the file is selected and is displayed in the Attachments field, click OK.
To delete a file from the workspace:

1 In the Current Attached Files section, select the file that you want to delete.
2 Click OK.

Enabling Graphics to Be Used on a Folder Landing Page

+ “Adding the Attachment Element to the Folder Form” on page 91
+ “Attaching the Graphic to the Folder” on page 91

Adding the Attachment Element to the Folder Form

You should have already added the Landing Page element to both the folder Form and View in order
to create a landing page for a folder. (For more information, see Section 6.16, “Creating a Landing
Page for a Folder,” on page 93.)

To enable graphics to be used on your folder landing page:

1 Add the Attachments element to the folder Form, as described in Section 8.3, “Modifying an
Existing Folder View,” on page 113.

You do not need to add the Attachments element to the folder View, because this element
should only be displayed on the folder Form.

2 Continue with “Attaching the Graphic to the Folder” on page 91.

Attaching the Graphic to the Folder

1 Navigate to the landing page where you want to attach the graphic.

2 Click the Configure icon 9 next to the folder title, then click Edit Folder.

3 Inthe Attachments section, click Browse, then browse to and select the graphic that you want to
add.

4 After the file is selected and is displayed in the Attachments field, click OK.
To delete a file from the folder:

1 Inthe Current Attached Files section, select the file that you want to delete.
2 Click OK.

Displaying YouTube Videos on a Landing Page

Micro Focus Vibe lets you display YouTube videos in various sections of a landing page.

+ Section 6.14.1, “Displaying Videos in the Branding Section of a Landing Page,” on page 92
+ Section 6.14.2, “Displaying Videos in the Main Landing Page Area,” on page 92
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6.14.1

6.14.2

6.15

Displaying Videos in the Branding Section of a Landing Page

You can add a YouTube video to the Branding section of a landing page, as described in Chapter 5,
“Branding a Folder or Workspace,” on page 57.

Displaying Videos in the Main Landing Page Area

You can display YouTube videos on a landing page in the following ways:
+ By adding an HTML editor, as described in “Adding an HTML Editor” on page 82. Insert a Media
object that links to the video.

+ By referencing a folder or folder entry that contains a YouTube video, as described in
Section 6.4, “Adding Content to Your Landing Page,” on page 67.

For information on how to create a folder entry that contains a YouTube video, see “Displaying
YouTube Videos in a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.

Creating a Landing Page On Your Personal Workspace

You can create a landing page on your personal workspace only if your Micro Focus Vibe
administrator has enabled you to do so. If you are unable to create a landing page on your personal
workspace as described in this section, consult your Vibe administrator.

If you are a Vibe administrator and you want to enable users to create landing pages on their
personal workspaces, see “Enabling Users to Create Landing Pages on Personal Workspaces” in the
OpenText Vibe 4.0.8 Administration Guide.

1 In your personal workspace, click the Configure icon © next to the workspace title, then click
Configure Views, URLs and Controls.

2 On the Configure Workspace View tab, in the Default View section, select the landing page
option that your administrator added.

Default View @)
_' UserLanding Page (user_landing_page)
@ UserWorkspace (_userWorkspace)

3 Click Apply > Close.

4 Continue with Section 6.3, “Setting Up Your Landing Page,” on page 62 to complete the creation
of your landing page.
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6.16

6.17

Creating a Landing Page for a Folder

Displaying landing pages at the workspace level makes the workspace home page a quick portal to
the most important information contained throughout the workspace. In addition to displaying
landing pages at the workspace level, Micro Focus Vibe also lets you display landing pages at the
folder level.

You might want to create a landing page for a folder if your folder contains many sub-folders, is
frequently visited, and contains a lot of information. Because workspace landing pages are more
common than folder landing pages, the process for creating a landing page on the folder is more
complex than creating a landing page for a workspace.

By default, in order to create a landing page for a folder in Vibe, you need to create a new folder

view. (For example, you might name your folder view “Landing Page.”) You need to populate this

folder view with the Landing Page Layout layout option in the Folder Form, and the Landing Page
Layout element in the Folder View. For information on how to create a landing page by creating a
new folder view, see Chapter 8, “Creating Custom Folder Views,” on page 107.

After you create the new landing page folder view, continue setting up your landing page by
following the information in Section 6.3, “Setting Up Your Landing Page,” on page 62.

Downloading Existing Landing Pages

The OpenText Resource Library provides a collection of existing Vibe folder entry forms, workflows,
and landing pages that have been designed to solve specific business problems. You can easily
download the custom forms and workflows, and then import them into your Vibe environment. You
can further customize these forms and workflows to suit your individual business needs.

1 Navigate to the OpenText Resource Library website (http://www.novell.com/products/vibe-
onprem/resource-library/).

Click the Workspaces tab.

Select the custom workspace that you want to use in your Vibe environment.

In the Attachment section, click the zi p file to download it.

v A W N

Import the file into your Vibe environment and deploy it for use.

For information on how to do this, follow the OpenText Resource Library Deployment
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).

Creating and Managing Landing Pages 93


http://www.novell.com/products/vibe-onprem/resource-library/
http://www.novell.com/products/vibe-onprem/resource-library/demos/form_workflow_deployment.html
http://www.novell.com/products/vibe-onprem/resource-library/demos/form_workflow_deployment.html

94 Creating and Managing Landing Pages



1.1

Creating Custom Workspace Views

Vibe lets you create custom workspace views and to customize existing views. Workspace views
define what is displayed on the home page of your workspace. When you create custom workspace
views, you can configure workspaces to display optional features such as remote applications,
attachments, and more. You can even create a custom workspace landing page.

To create a custom workspace view, review the following sections:

¢ Section 7.1, “Understanding Workspace Forms and Views,” on page 95
+ Section 7.2, “Creating a New Custom Workspace View,” on page 97

¢ Section 7.3, “Using Vibe 3 Formatting,” on page 102

+ Section 7.4, “Modifying an Existing Workspace View,” on page 102

+ Section 7.5, “Enabling the Workspace View,” on page 103

+ Section 7.6, “Populating Elements in the Workspace View,” on page 103
+ Section 7.7, “Understanding Elements,” on page 104

+ Section 7.8, “Understanding Layout Options,” on page 106

Understanding Workspace Forms and Views

When creating custom workspace views, you must create both the form and the view.

The workspace view is what users see when they access the workspace. Each view must have a
corresponding form. The form is how workspace administrators enter data, which is then displayed
in the workspace view. Forms contain a series of fields, presented in a specific order and layout that
you define.
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For example, the form for a Team workspace is what workspace administrators see when they edit

the workspace by clicking the Configure icon © next to the workspace title, and then clicking Edit
Workspace. It looks like this:

Julio Chavez (jchavez)

Description
Edit View nsert Format Table
Font Family Font Sizes Paragraph B /7 ¥ A A & EE=E

= = T,

This text editor supports the following types of markup:
[[entry title]] creates a link to another entry in this folder. 0
==5ection name== and ===3ubsscfion name=== add seclions and subsections to your text.

feon ® o8 o o® oFP P o o2 oz o oe
v ®

Remote Application

—select one— v

The view for a Team workspace is what users see when they access the workspace. It looks like this:
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1.2

) Sales ©

/A Calendar
Calendar

%s Discussion
Discussion
L1 Files
Files

Milestones
Milestones

[E Photo Album
Photo Album

¥ Surveys
sSurveys

Tasks
Tasks
@ Wiki
Wiki

2. Sales
eam Members

Creating a New Custom Workspace View

Vibe lets you create custom workspace views that contain elements that are unique to your needs.
To do this, you must create both the form and the view. For more information about forms and
views, see Section 7.1, “Understanding Workspace Forms and Views,” on page 95.

¢ Section 7.2.1, “Creating the View,” on page 98

+ Section 7.2.2, “Adding Elements to the Workspace Add/Modify Form,” on page 98

+ Section 7.2.3, “Adding Elements to the Workspace View,” on page 100
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7.2.1

7.2.2

Creating the View

1 Navigate to the workspace where you want to create the new view.

2 Click the Configure icon © next to the workspace title, then click Form/View Designers.

The Form and View Designers page is launched.

Click New > Workspace Views.

The Add a New Definition form is displayed.

Specify the following information in the Add a New Definition section:

Caption: Specify the name of the workspace view that you want to appear in the Micro Focus
Vibe interface. (For example, “Custom Workspace.”)

Name: Specify the internal name of the workspace view. This name is not visible to regular Vibe
users. (For example, “custom_workspace.”)

Family: Select the workspace type that this view is most closely associated with.

Workspace Icons: Select the icon that you want to represent the workspace. The icon that you
select is displayed with the name of the workspace in the Navigation panel.

5 Click OK.

Continue with Section 7.2.2, “Adding Elements to the Workspace Add/Modify Form,” on
page 98.

Adding Elements to the Workspace Add/Modify Form

The workspace add/modify form is the form you see when you are creating or modifying the content
of your workspace home page. This form needs to contain the elements and layout options that you
want to display in your workspace home page. For example, you might want to display multiple
remote applications and a two-column table.

After you add elements and layout options to the workspace form, you must then add those same
elements and layout options to the workspace view in order for the elements and options to be
displayed in your workspace. For information on how to add features to the workspace view, see
Section 7.2.3, “Adding Elements to the Workspace View,” on page 100.

1 Under the custom workspace form that you created, expand Workspace Add/Modify Form.

If you are modifying an existing form, all of the elements and layout options that are currently
applied to your form are displayed.

or

If you are creating a new form, only the default options are displayed.
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Sales
Designer >> Custom Workspace (custom_workspace)

ED Custom Workspace (custom_workspace)
E|D Workspace Add/Modify Form
. [] Title - Titie

D Description - Description

- D lcon - leon

B[] Workspace view

2 Add and modify the desired elements and layout options, as described in the following sections:

+ “Adding Elements to a Form” on page 99
+ “Modifying Elements in a Form” on page 99
+ “Deleting Elements in a Form” on page 100

+ “Adding Layout Options to a Form” on page 100

Based on the modifications that you make to a form element or option, you might need to make the
same modifications to the corresponding view element or option.

Adding Elements to a Form

1 Click Workspace Add/Modify Form.
2 In the Workspace Add/Modify Form window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add.

For information on the types of elements that you can add, see Section 7.7.1, “Workspace Form
Elements,” on page 104.

4 Specify the appropriate information.
5 Click OK.

Modifying Elements in a Form

If you are modifying an existing form, you can modify existing elements.

1 Expand Workspace Add/Modify Form, then click the element that you want to modify.
2 In the window on the right side of the page, click Modify.

3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Form

If you are modifying an existing form, you can delete existing elements.

1 Expand Workspace Add/Modify Form, then click the element that you want to delete.
2 Inthe window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to a Form

1 Click Workspace Add/Modify Form.
2 In the Workspace Add/Modify Form window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 7.8,
“Understanding Layout Options,” on page 106.

4 Specify the appropriate information.
5 Click OK.

Adding Elements to the Workspace View

The workspace view is how the information from your workspace add/modify form is displayed to
users who view your workspace. Every form must have a corresponding view. This view needs to
contain all of the elements and layout options that you want to display in your workspace home
page; it is made up of elements from the form.

Vibe provides you with all of the tools necessary to create a workspace view that suits any of the
purposes that you want to accomplish with your workspace.

Before you can add elements and layout options to the workspace view, you must first add the
elements and layout options to the workspace form in order for them to be displayed in your
workspace. (For information on how to add features to the workspace form, see Section 7.2.2,
“Adding Elements to the Workspace Add/Modify Form,” on page 98.)

To add elements to the views:

1 Under the custom entry form that you created, expand Workspace view.

If you are modifying an existing view, all of the elements and layout options that are currently
applied to your view are displayed.

or

If you are creating a new view, only the default options are displayed.
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Sales
Designer >> Custom Workspace (custom_workspace)

E‘D Custom Workspace (custom_workspace)
D Workspace Add/Modify Form
E‘D Workspace view
- D Accessory Panel - Accessory Panel

2 Add the desired elements and layout options, as described in the following sections:

+ “Adding Elements to a View” on page 101
+ “Modifying Elements in a View” on page 101
+ “Deleting Elements in a View” on page 102

+ “Adding Layout Options to a View” on page 102

Adding Elements to a View

1 Click Workspace view.
2 In the Workspace View window on the right side of the page, click Add.

3 In the Standard Form Elements section, click the element that you want to add.

When you add elements to a view, you add elements that have already been added to the form;

any form element that you create can be added as a view element.

For information on the types of elements that you can add that are specific to views, see

Section 7.7.2, “Workspace View Elements,” on page 105.
4 Specify the appropriate information.
5 Click OK.

Modifying Elements in a View

If you are modifying an existing view, you can modify existing elements.

1 Expand Workspace view, then click the element that you want to modify.

2 In the window on the right side of the page, click Modify.

3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a View

If you are modifying an existing view, you can delete existing elements.

1
2
3

Expand Workspace view, then click the element that you want to delete.
In the window on the right side of the page, click Delete.
Click OK.

Adding Layout Options to a View

1
2
3

Click Workspace view.
In the Workspace view window on the right side of the page, click Add.
In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 7.8,
“Understanding Layout Options,” on page 106.

Specify the appropriate information.

5 Click OK.

7.3 Using Vibe 3 Formatting

With the release of Vibe 4, OpenTextimplemented improved default rendering of web pages through
the Google Web Toolkit (GWT).

Administrators who are dissatisfied with GWT rendering of folders and workspaces that were
customized for Vibe 3 can specify Vibe 3 formatting by doing the following:

1. Click the Gear icon © for the folder or workspace.
2. Select Configure View, URLs, and Controls....

3.

4. Click Close.

Enable the Display using Vibe 3 formatting option and click Apply.

7.4 Modifying an Existing Workspace View

You can also create a custom workspace by modifying an existing workspace view.

1 Navigate to the folder or workspace where the custom workspace view was created.

2 Click the Configure icon 9 next to the workspace title, then click Form/View Designers.

The Form and View Designers page is launched.
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1.6

Form and View Designers

Form and View definitions for 'Marketing'
[F-Home Workspace & [E-Team Workspaces /N [@-Marketing

MNew Copy... Import Export

B~ @ Ferm/iew Designers
[l @ Folder Views

& Workspace view
Vibe Resource Library

3 Expand Workspace view, then click the custom workspace view that you want to modify.

4 Continue with Section 7.2.2, “Adding Elements to the Workspace Add/Modify Form,” on
page 98.

Enabling the Workspace View

After you have created the workspace view, you need to enable it as the default view for the
workspace.

1 Navigate to the workspace where you want to enable your custom view as the default view.

2 Click the Configure icon @ next to the workspace title, then click Configure Views, URLs and
Controls.

3 On the Configure Workspace View tab, in the Local Definitions section, select the custom view
that you created.

4 Click Apply > Close.

Populating Elements in the Workspace View

After you create a workspace view, you need to populate and customize some of the elements that
you included in the view.

For example, if you added a Branding element, you need to create your brand to display in the
workspace; if you added a Description element, you need to populate the element with a description
of the workspace; if you added an Attachment element, you need to attach any files that you want to
display in the workspace, and so forth.

1 After the workspace view has been created and enabled as the default workspace view, as
described in Section 7.5, “Enabling the Workspace View,” on page 103, navigate to the
workspace.

2 Click the Configure icon @ next to the workspace title, then click Edit Workspace.

A page with all of the form elements that you added to the workspace view add/modify form is
displayed. (If you want these elements to be displayed in the workspace, ensure that you have
also added them to the view form of the workspace view.)
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3 Populate the elements with the desired information.
For example, add a workspace description and attach any files.
4 Click OK.

7.7 Understanding Elements

Elements make up the content of your workspace forms and views.

When you are adding elements to a form, remember that you need to add that same element to the
view in order for it to be displayed in the workspace.

You can add the following elements:

+ Section 7.7.1, “Workspace Form Elements,” on page 104

+ Section 7.7.2, “Workspace View Elements,” on page 105

7.7.1 Workspace Form Elements

Attachment(s): Adds a field that lets you browse for and upload files, making them accessible to
those who view the workspace.

The files that you upload are displayed in the workspace home page.

Captcha: Adds a Captcha verification box that must be filled out before the form can be submitted
(this helps to prevent the workspace from bot attacks).

Checkbox: Adds a check box that can be selected or deselected.
Date: Adds a field that launches a calendar applet when users click inside it.

Date and Time: Adds two fields. The first field launches a calendar applet, and the second field
launches a time-selection applet when users click inside.

Description: Adds an HTML text editor that lets you specify a description of the workspace.
Email List: Adds a field that lets you specify email addresses.

File Upload: Adds a field that enables users to browse for and upload files.

Group List: Adds an element that enables users to add groups.

HTML Editor Text Area: Adds an HTML text area where you can compose messages, create links,
upload pictures, and more. The information that you create in this HTML editor is displayed in your
folder.

Hidden Field: Adds a hidden element. When you design the custom form, you can use this element
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear
on the entry form when users are creating an entry; however, the text does appear on the entry view
after the entry is created.

Icon: Enables the workspace owner to choose from a selection of icons to represent the workspace.
Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.

Picture: Adds a field that lets you browse for and upload pictures.
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Radio Buttons: lets you display options that users can select with radio buttons.

Remote Application: lets you display certain applications that have been configured by your Vibe
administrator.

For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on
page 179.

Selectbox: lets you display options that users can select.

Team List: Adds a field that enables users to specify teams.
Text: Adds a field where users can enter text.

Text Area: Adds an expandable field where users can enter text.
Title: Adds a field that lets you specify a title for the workspace.
URL: Add a field that converts any text into a hyperlink.

User List: Adds a field that lets you specify other Vibe users, using type-to-find functionality. When
you specify a user’s name when you modify the workspace, as described in Section 8.5, “Populating
Elements in the Folder View,” on page 114, Vibe displays the user’s name on the folder home page,
with links to his or her personal workspaces.

Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to
another application through iCal. You should not manually add this element to any form or view.

For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop
Application” in the OpenText Vibe 4.0.8 User Guide.

Workspace View Elements

Any form element that you create can be added as a view element, if you want it to appear in the
view.

The following elements are specific to views; they cannot be added to a form.

Accessory Panel: Displays the Accessory Panel on the workspace home page. Users can use this
panel to add community or personal accessories, depending on their individual rights.

For more information on accessories, see “Managing Accessories” in the OpenText Vibe 4.0.8 User
Guide.

Attachments: Displays all attachments.

Landing Page Layout: Adds a landing page creation form that lets you create landing page elements
to display in your workspace.

You must add the Landing Page Layout layout option in the workspace add/modify form before you
can add it as a view element.

Title: On the workspace home page, displays the title that you specified for the workspace.

Workspace and Folder List: Displays a workspace tree that contains the workspace and all sub-
workspaces and sub-folders.
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1.8

Understanding Layout Options

Layout options can enhance the presentation of your workspace forms and views.

When you are adding layout options to a form, remember that you need to add the same layout
options to the view in order for it to be displayed in the workspace.

You can add the following form layout options:
Box: Places a box around the specified elements.
Custom JSP: lets you reference a custom JSP from the Vibe directory.

Custom JSPs must be created by Vibe administrators before you can reference them, as described in
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 133.

Divider: Displays a horizontal line between elements.
Expandable Area: Displays an expandable tree element.
Fieldset: Adds a box that can contain other elements.
Use this option if your form is exceptionally long.
HTML: Adds HTML formatting.

Landing Page Layout: (For the View Definition, the Landing Page Layout is in the Elements section.)
Adds a landing page creation form that lets you create landing page elements that you can populate
when you modify your workspace.

Three Column Table: lets you add elements within a three-column table.

Two Column Table: lets you add elements within a two-column table.
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8.1

Creating Custom Folder Views

Vibe lets you design custom folder views. Folder views define what is displayed on the home page of
your folder. When you design custom folder views, you can configure folders to display optional
features such as remote applications, attachments, and more. You can even create a folder landing

page.
To create a custom folder view, review the following sections:

+ Section 8.1, “Understanding Folder Forms and Views,” on page 107
+ Section 8.2, “Creating a New Custom Folder View,” on page 109

+ Section 8.3, “Modifying an Existing Folder View,” on page 113

+ Section 8.4, “Enabling the Folder View,” on page 114

+ Section 8.5, “Populating Elements in the Folder View,” on page 114
+ Section 8.6, “Understanding Elements,” on page 115

+ Section 8.7, “Understanding Layout Options,” on page 117

Understanding Folder Forms and Views

When creating custom folder views, you must create both the form and the view.

The folder view is what users see when they access the folder. Each view must have a corresponding
form. The form is how folder administrators enter data, which is then displayed in the folder view.
Forms contain a series of fields, presented in a specific order and layout that you define.
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For example, the form for a Discussion folder is what folder administrators see when they edit the

folder by clicking the Configure icon © next to the folder title, and then clicking Edit Folder. It looks
like this:

Discussion folder

Title
[piscussion folder

Description
Edit View nsert Format Table
A A & E=E=E £ =2 =2 | L

Font Family Font Sizes Paragraph B [ U

This text editor supports the following types of markup:
[[entry title]] creates a link to another entry in this folder. 0
==5ection name== and ===Subsection name=== add sections and subsections fo your text.

Remote Application
—select one— ¥

Icon fg=| % = — - .
o b F5 &8 [ ] ? (ol £ Wi )
Require that all files uploaded into this folder have a unique name. (You must check this box if you want to access folder contents using WebDAV.) @

Force titles to be unique. (This is useful for wiki views.)

The view for a Discussion folder is what users see when they access the folder. It looks like this:

Home Workspace Team Workspaces Marketing View What's New m
fiew What's New
Lgn Discussion @
¥ | New~ Add Files... - @ Fiter List o6
¥ T MNo. Title (] State  Author Date Rating
oo What do you think about the new . I:‘ Julio Chavez Mara 2015 527 PM
marketing loga? ' ’
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8.2

8.2.1

Creating a New Custom Folder View

Vibe lets you create custom folder views that contain elements that are unique to your needs. To do
this, you must create both the form and the view. For more information about forms and views, see
Section 8.1, “Understanding Folder Forms and Views,” on page 107.

+ Section 8.2.1, “Creating the View,” on page 109

¢ Section 8.2.2, “Adding Elements to the Folder Add/Modify Form,” on page 110

+ Section 8.2.3, “Adding Elements to the Folder View,” on page 111

Creating the View

1 Navigate to the folder or workspace where you want to create the new view.

If you create a new folder view at the workspace level, the folder view can be enabled on any
folder within the workspace. If you create the folder view at the folder level, the folder view can
be enabled only on that folder where the view was created.

2 Click the Configure icon 9 next to the folder or workspace title, then click Form/View
Designers, depending on whether you are creating the new folder view at the folder or
workspace level.

The Form and View Designers page is displayed.
3 Click New > Folder Views.
The Add a New Definition form is displayed.
4 Specify the following information in the Add a New Definition section:

Caption: Specify the name of the folder view that you want to appear in the Micro Focus Vibe
interface. (For example, “Custom Blog.”)

Name: Specify the internal name of the folder view. This name is not visible to regular Vibe
users. (For example, “custom_blog.”)

Family: Select the folder type that this view is most closely associated with.

Create a File Entry on file drag/drop: Select this option if you want Vibe to create a new file
entry when you drag and drop a file into the folder by using the Add Files to Folder feature, as
described in “Adding a File by Dragging and Dropping” in the OpenText Vibe 4.0.8 User Guide.

If you do not select this option, the default entry type for the folder is created when you drag
and drop a file into the folder using the Add Files to Folder feature, as described in “Dragging
and Dropping Files” in the OpenText Vibe 4.0.8 User Guide. For example, in a Blog folder, a blog
entry is created, and the file is added as an entry attachment.

If you are creating a new view for a Files folder, this option has no effect.

Folder Icons: Select the icon that you want to represent the folder. The icon that you select is
displayed with the name of the folder in the Navigation panel.

5 Click OK.
6 Continue with Section 8.2.2, “Adding Elements to the Folder Add/Modify Form,” on page 110.
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8.2.2 Adding Elements to the Folder Add/Modify Form

After you add elements and layout options to the folder form as described in this section, you must
then add those same elements and layout options to the folder view in order for them to be
displayed in your folder. For information on how to add elements and layout options to the folder
view, see “Adding Elements to the Folder View” on page 111.

1 Expand the custom folder form that you previously defined.

Form and View Designers

Discussion
Designer >> Custom Blog (custom_blog)

Title - Title
Description - Description

Ilcon - lcon

2 Add, modify, and delete elements and layout options, as described in the following sections:

+ “Adding Elements to a Folder Form” on page 110
+ “Modifying Elements in a Folder Form” on page 111
+ “Deleting Elements in a Folder Form” on page 111

+ “Adding Layout Options to a Form” on page 111

Based on the modifications that you make to a form element or option, you might need to make the
same modifications to the corresponding view element or option.

Adding Elements to a Folder Form

1 Click Folder Form.
2 In the Folder Form window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add.

For information on the types of elements that you can add, see Section 8.6.1, “Folder Form
Elements,” on page 115.

4 Specify the appropriate information to configure the element.

5 Click OK.
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Modifying Elements in a Folder Form

If you are modifying an existing form, you can modify existing elements.

1 Expand Folder Form, then click the element that you want to modify.
2 In the window on the right side of the page, click Modify.

3 Make the desired modifications, such as changing the caption or data name, then click OK.

Deleting Elements in a Folder Form

If you are modifying an existing form, you can delete existing elements.

1 Expand Folder Form, then click the element that you want to delete.
2 In the window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to a Form

1 Click Folder Form.
2 In the Folder Form window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 8.7,
“Understanding Layout Options,” on page 117.

4 Specify the appropriate information to configure the layout option.
5 Click OK.

8.2.3 Adding Elements to the Folder View

The folder view is how your folder form is displayed to other users. Every folder form must have a
view associated with it. This view needs to contain all of the elements that you want to display in
your folder. For information on how to add elements and layout options to the folder view, see
Section 8.2.2, “Adding Elements to the Folder Add/Modify Form,” on page 110.

1 Expand the custom folder view that you previously defined, then expand Folder View.

If you are modifying an existing view, all of the elements and layout options that are currently
applied to the view are displayed.

or

If you are creating a new view, only the default options are displayed.
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Form and View Designers

Discussion
Designer >> Custom Blog (custom_blog)

2 Add, modify, and delete elements and layout options, as described in the following sections:

+ “Adding Elements to a Folder View” on page 112
+ “Modifying Elements in a Folder View” on page 112
+ “Deleting Elements in a Folder View” on page 113

+ “Adding Layout Options to a Folder View” on page 113

Adding Elements to a Folder View

1 Click Folder View.
2 In the Folder View Definition window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add to the view.

For information on the types of elements that you can add, see Section 8.6.2, “Folder View
Elements,” on page 116.

Before you can add some of these elements to your Folder View, you must first add them to the
Folder Form. For information on how to do this, see “Adding Elements to a Folder Form” on
page 110.

4 Specify the appropriate information to configure the element.
5 Click OK.

Modifying Elements in a Folder View

If you are modifying an existing view, you can modify existing elements.

1 Expand Folder View, then click the element that you want to modify.
2 In the window on the right side of the page, click Modify.

3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Folder View

If you are modifying an existing view, you can delete existing elements.

1 Expand Folder View, then click the element that you want to delete.
2 Inthe window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to a Folder View

1 Click Folder View.
2 Inthe Folder View window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 8.7,
“Understanding Layout Options,” on page 117.

4 Specify the appropriate information to configure the layout option.
5 Click OK.

8.3 Modifying an Existing Folder View

In addition to creating a new custom folder view as described in Section 8.2, “Creating a New
Custom Folder View,” on page 109, you can create a custom folder by modifying an existing folder
view.

1 Inthe folder or workspace where the custom folder view was previously defined, click Folder >
Form/View Designers.
The Form and View Designers page is launched.

2 Expand Folder Views, then click the custom folder view that you want to modify.
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Form and View Designers

Form and View definitions for 'Discussion’
F-Home Workspace & [F-Team Workspactes /N [F-Marketing / Discussion

MNew Copy... Import Export

- @ Form/view Designers
£ @ Folder Views

o Custom Blog (custom_blog)

Yibe Resource Library

3 Continue with Section 8.2.2, “Adding Elements to the Folder Add/Modify Form,” on page 110.

8.4 Enabling the Folder View

After you have defined and designed the folder view, you need to enable it to be viewed by those
who will use the folder. You can enable the folder view to be the default folder view for a folder, or to
be an alternate folder view. For information on how to do this, see Section 3.2, “Managing Folder
Views,” on page 26.

8.5 Populating Elements in the Folder View

After you create and enable a folder view, you need to populate and customize some of the
elements that you included in the view.

For example, if you added a Branding element, you need to create your brand to display in the
folder; if you added a Description element, you need to populate the element with a description of
the folder; if you added an Attachment element, you need to attach any files that you want to
display in the folder, and so forth.

1 Ensure that the folder view has been created and enabled as the default folder view, as
described in Section 8.2, “Creating a New Custom Folder View,” on page 109 and Section 8.4,
“Enabling the Folder View,” on page 114.

2 Navigate to the folder where you enabled the folder view.

3 Click the Configure icon 9 next to the folder title, then click Edit Folder.

A page with all of the form elements that you added to the folder form is displayed. (If you want
these elements to be displayed in the folder, ensure that you have also added them to the
folder view, as described in Section 8.2.3, “Adding Elements to the Folder View,” on page 111.)

4 Populate the elements with the desired information.
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8.6

8.6.1

For example, create your folder brand, add a folder description, attach any files, and so forth.
5 Click OK.

Understanding Elements

Elements make up the content of your forms and views. Some elements can be used only once.

When you are adding elements, remember that when you add an element to a form, you need to
add that same element to the view in order for it to be displayed in the folder.

You can add the following elements:

¢ Section 8.6.1, “Folder Form Elements,” on page 115

+ Section 8.6.2, “Folder View Elements,” on page 116

Folder Form Elements

Attachments: lets you display uploaded files as an attachment.
Attachments include a thumbnail, and details about the document, such as file size and author.

Captcha: Adds a Captcha verification box that must be filled out before the form can be submitted
(this helps to prevent the folder from bot attacks).

Checkbox: Adds a check box that can be selected or deselected.
Date: Adds a field that launches a calendar applet when users click inside it.

Date and Time: Adds two fields. The first field launches a calendar applet, and the second field
launches a time-selection applet when users click inside.

E-Mail Address List: Adds a field that lets you specify email addresses.

Description: Adds an HTML text editor that lets you provide a description of the folder.
File Upload: lets you upload files.

Group List: Adds an element that enables users to add groups.

Hidden Field: Adds a hidden element. When you design the custom form, you can use this element
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear
on the entry form when users are creating an entry; however, the text does appear on the entry view
after the entry is created.

HTML Editor Text Area: Adds an HTML text editor where you can compose messages, create links,
upload pictures, and more. The information that you create in this HTML editor is displayed in your
folder.

Icon: lets you change the folder icon that is displayed in the Navigation panel.
Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.
Picture: Adds a field that lets you upload a picture to display in your folder.

Radio Buttons: lets you display options that users can select with radio buttons.
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8.6.2

Remote Application: lets you display certain applications that have been configured by your Vibe
administrator.

For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on
page 179.

Selectbox: lets you display options that users can select.

Team List: Adds a field that enables users to specify teams.
Text: Adds a field where users can enter text.

Text Area: Adds an expandable field where users can enter text.
Title: Adds a field that lets you specify a title for the workspace.
URL: Add a field that converts any text into a hyperlink.

User List: Adds a field that lets you specify other Vibe users, using type-to-find functionality. When
you specify a user’s name when you modify the workspace, as described in Section 8.5, “Populating
Elements in the Folder View,” on page 114, Vibe displays the user’s name on the folder home page,
with links to his or her personal workspaces.

Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to
another application through iCal. You should not manually add this element to any form or view.

For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop
Application” in the OpenText Vibe 4.0.8 User Guide.

Folder View Elements

Any form element that you create can be added as a view element, if you want it to show up in the
view.

The following elements are specific to views; they cannot be added to a form.

Accessory Panel: Displays the Accessory Panel on the workspace home page. Users can use this
panel to add community or personal accessories, depending on their individual rights.

For more information on Accessories, see “Managing Accessories” in the OpenText Vibe 4.0.8 User
Guide.

Discussion Folder: Displays folder entries in the Discussion folder view.

Entry Creation Date: Displays the date and time that an entry was created.

Entry Creator: Displays the creator of an entry.

Entry Creator and Creation Date: Displays who created the entry and when they created it.

Landing Page Layout: Adds a landing page creation form that lets you create landing page elements
to display in your folder.

You must add the Landing Page Layout layout option in the folder form before you can add it as a
view element.

Title: Adds a field that lets you specify a title for the workspace.
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8.7

Understanding Layout Options

Layout options can enhance the presentation of your folder forms and views in Micro Focus Vibe.

When you are adding layout options to a form, remember that you need to add the same layout
options to the view in order for them to be displayed in the folder.

You can add the following layout options:
Box: Places a box around the specified elements.
Custom JSP: lets you reference a custom JSP from the Vibe directory.

Custom JSPs must be created by Vibe administrators before you can reference them, as described in
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 133.

Divider: Displays a horizontal line between elements.
Expandable Area: Displays an expandable tree element.
Use this option if your form is exceptionally long.
Fieldset: Adds a box that can contain other elements.
HTML: Adds HTML formatting.

Landing Page Layout: (For the View Definition, the Landing Page Layout is in the Elements section.)
Adds a landing page creation form that lets you create landing page elements that you can populate
when you modify your workspace.

Three Column Table: lets you add elements within a three-column table.

Two Column Table: lets you add elements within a two-column table.
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9.1

9.2

Designing Custom Folder Entry Forms

Folder Entry forms in Vibe can be customized to suit your precise business needs. You can create
your own custom entry forms and views by using the Vibe Form and View Designers tool, or you can
download existing custom entry forms from the OpenText Resource Library.

+ Section 9.1, “Downloading Existing Custom Forms and Workflows,” on page 119

*

Section 9.2, “Understanding Entry Forms and Views,” on page 119

*

Section 9.3, “Creating a Custom Folder Entry Form,” on page 121

*

Section 9.4, “Modifying an Existing Entry Form,” on page 127

*

Section 9.5, “Understanding Elements,” on page 128

*

Section 9.6, “Understanding Layout Options,” on page 131

Downloading Existing Custom Forms and Workflows

The OpenText Resource Library provides a collection of existing Vibe folder entry forms and
workflows that have been designed to solve specific business problems. You can easily download the
custom forms and workflows, and then import them into your Vibe environment. You can further
customize these forms and workflows to suit your individual business needs.

1 Go to the OpenText Resource Library website (http://www.novell.com/products/vibe-onprem/
resource-library/).

Click Forms and Workflows.

Select the custom form or workflow that you want to use in your Vibe environment.

In the Attachment section, click the zi p file to download it.

i A W N

Import the file into your Vibe environment and deploy it for use.

For information on how to do this, follow the OpenText Resource Library Deployment
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).

Understanding Entry Forms and Views

When creating custom forms, you must create both the form and the view.

The form is how users enter data into the Vibe system. Forms contain a series of fields, presented in
a specific order and layout defined by the user who created the custom entry. Each form must have a
corresponding view that contains all or some of the elements and layout options that exist in the
form. The view defines how the data for the entry is displayed after it has been added to Vibe by
users filling out the form.
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For example, the form for a File entry is what users see when they are creating a File entry. Users
access this form by clicking New File Entry in a Files folder. It looks like this:

File Entry

Title
|

File Upload *

Choose File | Mo file chosen Exdit File Note...

Description

Edit Wiew Insert Format Table

| b
| b
%
1
il
Il
I

Font Family Font Sizes Paragraph B [ u

This text editor supports the following types of markup:
[[entry fitle]] creates a link to another entry in this folder. 0
==Section name== and ===5ubseclion name=== add seclions and subsections o your text.

[> Subscribe to This Entry

[* Send Email When Entry is Submitted

Ok _J Cancel ]

The view for a File entry is what users see after the File entry is created. It looks like this:

ProdX_Analysis. docx O © cos=D
Comment Modify Delete Actions Reports - e 0
ProdX_Analysis.docx V1.0 NoStatus= File Actions~  Edit This File
Created :-. Uulic Chavez Mar @, 2015 5:57 PM —Mot rated— 1 Visit no comments

This is the marketing plan for Product X. Please review and provide feedback.

[Edit]
Comments(o)

Add Comment...

Permalink | Subscribe to This Entry
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9.3

Creating a Custom Folder Entry Form

Micro Focus Vibe lets you create custom folder entry forms that contain fields that are unique to
your needs. To do this, you must create both the form and the view. For more information about
forms and views, see Section 9.2, “Understanding Entry Forms and Views,” on page 119.

For example, you can create a custom entry form for an expense report.

Expense Report

Title
|Report Date *
3092015

|Business Purpose™

Employee Information

Name of Submitter *

Feople

Department/Team *
Department Cne T

E-Mail

Manager Information

Name™

People

Expense Report

Date ™

Category ™
Travel

IAdditional Information

Font family |~/ Font size

*

Section 9.3.1,
Section 9.3.2,
Section 9.3.3,
Section 9.3.4,

*

*

*

Expense Code ™ Start Date™ End Date ™

Job Title

s Luke Penrod &

[ Clipboard User Names

Employee ID*

E-Mail ™

[ Clipboard User Names

Description ™

Cost™

==

- | Format

Bz U A

11
e

“Creating the Folder Entry Form,” on page 122

“Adding Elements to the Entry Form Definition,” on page 122
“Adding Elements to the Entry View Definition,” on page 124

|HTI'I1L | s

“Adding Elements to the Summary View,” on page 126
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9.3.1

9.3.2

Creating the Folder Entry Form

1 Navigate to the folder or workspace where you want to create the custom entry form.

If you create the entry form in a folder, the form can be applied only to entries in that folder. If
you create the entry form in a workspace, the form can be applied to entries in any folder in the

workspace.

2 Click the Configure icon 9 next to the folder or workspace title, then click Form/View
Designers, depending on whether you are creating the entry form at the folder or workspace
level.

The Form and View Designers page is displayed.

3 Click New > Entry Definitions.
The Add a New Definition form is displayed.

4 Specify the following information in the Add a New Definition section:
Caption: Specify a name for the folder entry.

This is the name that appears in the Vibe interface. Users see it when they create an entry of
this type. (For example, “Expense Report.”)

Name: Specify the internal name for the folder entry.

The name that you enter in this field is not visible to users who create this type of entry. (For
example, “expense_report.”)

Family: Select the item type that is closest to the function of the item you are creating. Users

can use the family type when performing filtered searches.

Allowed Comments/Reply Types: Select all of the comments or reply types that you want to
allow on the entry.

When users comment on this type of entry, they can choose from the options that you specify

in this section.
To select multiple options, hold the Ctrl key while selecting the comment or reply types.
5 Click OK.
6 Continue with Section 9.3.2, “Adding Elements to the Entry Form Definition,” on page 122.

Adding Elements to the Entry Form Definition

The entry form is what users see when they are creating a new entry. This form needs to contain all

of the fields necessary for users to create this type of entry. For example, an Expense Report form
needs to contain the expense code, the purpose for the expense, the cost of the expense, and so
forth.

After you add elements and layout options to the entry form, you must then add all of the elements

and layout options to the entry view in order for them to be displayed when users view the entry.

(For information on how to add elements to the entry view, see Section 9.3.3, “Adding Elements to

the Entry View Definition,” on page 124.)
To add elements to the form:

1 Under the custom entry form that you created, expand Entry Form Definition, then expand
Form.
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All of the elements and layout options that are currently applied to your form are displayed.

Form and View Designers

Files
Designer >> Expense Report (expense_report_basic)

E|--- Expense Report (expense_report_basic)

[&-[Z] Entry \iew Definition
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2 Add, modify, and delete the desired elements and layout options, as described in the following
sections:

+ “Adding Elements to a Form” on page 123

+ “Modifying Elements in a Form” on page 123

+ “Deleting Elements in a Form” on page 124

+ “Adding Layout Options to a Form” on page 124

Based on the modifications that you make to a form element or option, you might need to make the
same modifications to the corresponding view element or option.

Adding Elements to a Form

1 Click Form.
2 In the Form window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add.

For information on the types of elements that you can add, see Section 9.5.1, “Entry Form
Elements,” on page 128.

4 Specify the appropriate information to configure the element.
5 Click OK.

Modifying Elements in a Form

1 Expand Form, then click the element that you want to modify.
2 In the window on the right side of the page, click Modify.

3 Make the desired modifications, such as changing the caption or data name, then click OK.
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Deleting Elements in a Form

1 Expand Form, then click the element that you want to delete.
2 Inthe window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to a Form

1 Click Form.
2 In the Form window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 9.6,
“Understanding Layout Options,” on page 131.

4 Specify the appropriate information to configure the element.
5 Click OK.

9.3.3 Adding Elements to the Entry View Definition

The entry view is how the information from your entry form is displayed to users who view your
entry. Every form must have a corresponding view. This view needs to contain all of the fields
necessary for users to get the information they need when viewing the entry; it is made up of
elements from the form.

Before you can add elements and layout options to the entry view, you must first add those same
elements and layout options to the entry form in order for them to be displayed in your entry. (For
information on how to add features to the entry form, see Section 9.3.2, “Adding Elements to the
Entry Form Definition,” on page 122.)

To add elements to the view:

1 Under the custom entry form that you created, expand Entry View Definition.
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Form and View Designers

Files
Designer >> Expense Report (expense_report_basic)

= Expense Report (expense_report_basic )
Entry Form Definiticn

= Entry “iew Definition
----- Entry Creator and Creation Date
----- Entry Workflow - Entry Workflow

mmmm

----- Entry Data ltem [additional_information] - Additional Information

----- Attac hments - Attachments

2 Add, modify, and delete the desired elements and layout options, as described in the following
sections:

+ “Adding Elements to an Entry View Definition” on page 125

+ “Modifying Elements in an Entry View Definition” on page 125

+ “Deleting Elements in an Entry View Definition” on page 126

+ “Adding Layout Options to an Entry View Definition” on page 126

Adding Elements to an Entry View Definition

1 Click Entry View Definition.
2 In the Entry View Definition window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add.

For information on the types of elements that you can add, see Section 9.5.2, “Entry View
Elements,” on page 130.

4 Specify the appropriate information to configure the element.
5 Click OK.

Modifying Elements in an Entry View Definition

1 Expand Entry View Definition, then click the element that you want to modify.
2 In the window on the right side of the page, click Modify.
3 Make the desired modifications, then click OK.
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Deleting Elements in an Entry View Definition

1 Expand Entry View Definition, then click the element that you want to delete.
2 Inthe window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to an Entry View Definition

1 Click Entry View Definition.
2 In the Entry View Definition window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 9.6,
“Understanding Layout Options,” on page 131.

4 Specify the appropriate information to configure the element.
5 Click OK.

9.3.4 Adding Elements to the Summary View

The summary view is used to display entries in a folder before the entries are opened.

To add elements to the summary view:

1 Under the custom entry form that you created, expand Summary View.

Form and View Designers

Files
Designer >> Expense Report (expense_report_basic)

-[E] Entry Workflow - Entry Workflow
i [2] Attac hments - Attachments

2 Add, modify, and delete the desired elements and layout options, as described in the following
sections:

+ “Adding Elements to a Summary View” on page 127

+ “Modifying Elements in an Summary View Definition” on page 127
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+ “Deleting Elements in a Summary View Definition” on page 127

+ “Adding Layout Options to a Summary View” on page 127

Adding Elements to a Summary View

1 Click Summary View.
2 In the Summary View window on the right side of the page, click Add.
3 In the Standard Form Elements section, click the element that you want to add.

For information on the types of elements that you can add, see Section 9.5.2, “Entry View
Elements,” on page 130.

4 Specify the appropriate information to configure the element.
5 Click OK.

Modifying Elements in an Summary View Definition

1 Expand Summary View, then click the element that you want to modify.
2 Inthe window on the right side of the page, click Modify.
3 Make the desired modifications, then click OK.

Deleting Elements in a Summary View Definition

1 Expand Summary View, then click the element that you want to delete.
2 In the window on the right side of the page, click Delete.
3 Click OK.

Adding Layout Options to a Summary View

1 Click Summary View.
2 In the Summary View window on the right side of the page, click Add.
3 In the Layout Options section, click the layout option that you want to add.

For information on the types of layout options that you can add, see Section 9.6,
“Understanding Layout Options,” on page 131.

4 Specify the appropriate information to configure the element.
5 Click OK.

9.4 Modifying an Existing Entry Form

1 Navigate to the folder or workspace where the custom folder entry was created.

2 Click the Configure icon € next to the folder or workspace title, then click Form/View
Designers, depending on whether the custom folder entry was created at the folder or
workspace level.

The Form and View Designers page is displayed.
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9.5

9.5.1

Form and View Designers

Form and View definitions for 'Files'
FH-Home Workspace N [F-Team Workspaces /1 [F-Marketing W Files

Mew Copy... Imiport Export

- @ Formtiew Designers

E| @ Entry Definitions

Yibe Resource Library

3 Expand Entry Definitions, then click the custom entry that you want to modify.

4 Continue with Section 9.3.2, “Adding Elements to the Entry Form Definition,” on page 122.

Understanding Elements

Elements make up the content of your forms and views.

When you are adding elements, remember that when you add an element to a form, you need to
add that same element to the view in order for it to be displayed in the custom form.

You can add the following elements:

+ Section 9.5.1, “Entry Form Elements,” on page 128

+ Section 9.5.2, “Entry View Elements,” on page 130

Entry Form Elements

Cancel Button: Adds the Cancel button.

Captcha: Adds a Captcha verification box that must be filled out before the form can be submitted
(this helps to prevent the folder from bot attacks).

Checkbox: Adds a check box that can be selected and deselected.
Date: Adds a field that launches a calendar applet when users click inside it.

Date and Time: Adds two fields. The first field launches a calendar applet, and the second field
launches a time-selection applet when users click inside.

E-Mail Address List: Adds a field that lets you specify email addresses.
Event: Adds fields that enable users to specify the start time and end time of an event.

File Upload: Adds a field that enables users to browse for and upload files.
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Form: This element is for internal use and is required on the entry form.
Form Buttons: Adds the OK and Cancel buttons.
Group List: Adds a type-to-find field that enables users to find and select Vibe groups.

Guest User Name: Adds a field where users who are logged in to the Vibe site as Guest can specify
their name. This field is displayed on the entry form only when the Guest user is viewing the form.

HTML Editor Text Area: Adds an HTML text area where users can compose messages, create links,
upload pictures, and more.

Hidden Field: Adds a hidden element. When you design the custom form, you can use this element
to add boilerplate text to every entry that is created. This text is “hidden” because it does not appear
on the entry form when users are creating an entry; however, the text does appear on the entry view
after the entry is created.

Icon: Enables the workspace owner to choose an icon to represent the workspace.

Number: Adds a field that requires users to enter a number. Alphabetic characters are rejected.
Picture: Adds a field that enables users to browse for and upload pictures.

Places: Adds a workspace tree that enables users to browse to and select folders.

Radio Buttons: lets you display options that users can select with radio buttons.

Remote Application: lets you choose a remote application to display.

Remote applications must be created and enabled for use by the Vibe administrator.
Selectbox: lets you display options that users can select.

Send Email When Entry is Submitted: Adds an option that enables users to automatically send an
email to other Vibe users, after the entry is submitted.

Show Only When In Workflow States: lets you hide elements from being displayed on the entry
form unless the entry is in a designated state of a workflow.

Subscribe to This Entry: Adds an option that enables users to subscribe to the entry.
Survey: Adds options that enable users to create a survey.

Team List: Adds a field that enables users to specify teams.

Text: Adds a field where users can enter text.

Text Area: Adds an expandable field where users can enter text.

Title: Adds a field where users can enter a title for the entry.

URL: Add a field that converts any text into a hyperlink.

User List: Adds a field that enables users to use the type-to-find functionality to specify other Vibe
users.

User List Selectbox: Adds a list of users that you can choose from in the entry form. This list is
populated from the User List element that is defined on the folder view of the parent folder (for
more information about how to add a User List element to a custom folder view by either creating a
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new folder view or modifying an existing folder view, see Chapter 8, “Creating Custom Folder Views,”
on page 107). You need to reference this User List element by specifying the element’s data name in
the Source User List Element from the Parent Folder when creating the User List Selectbox element.

Users External to Vibe: Vibe uses this option internally when synchronizing tasks and calendars to
another application by using iCal. You should not manually add this element to any form or view.

For more information about iCal in Vibe, see “Synchronizing Tasks and Calendars to a Desktop
Application” in the OpenText Vibe 4.0.8 User Guide.

9.5.2 Entry View Elements

Any form element that you create can be added as a view element, if you want it to appear in the
view.

The following elements are specific to views; they cannot be added to a form.
Attachments: Displays all attachments.
Comments: Displays all comments.

Comments and Attachments Tabs: Displays the Comments and Attachments tabs. Also, where
applicable, it displays the Entry History and File Versions tabs.

Description: Displays the entry description.

Entry Creation Date: (Not available with a Summary View) Displays the date that the entry was
created.

Entry Creator: (Not available with a Summary View) Displays who created the entry.

Entry Creator and Creation Date: (Not available with a Summary View) Displays who created the
entry and when they created it.

Entry Workflow: Displays the workflow process, the state of the workflow process, and any actions
to be performed on the workflow.

Remote Application: (Not available with a Summary View) lets you add custom applications that are
running on a separate server.

For more information on remote applications, see Chapter 12, “Managing Remote Applications,” on
page 179.

Replies: All replies to an entry are listed here. You can move this section to another location in the
entry view by moving this element.

Show Only When In Workflow States: lets you hide elements from being displayed on the entry
view unless the entry is in a designated state of a workflow.

Title: Displays the title of the entry.
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9.6

Understanding Layout Options

Layout options can enhance the presentation of your forms and views.

When you are adding layout options, remember that when you add layout options to a form, you
need to add the same layout options to the view in order for it to be displayed in the custom form.

You can add the following layout options:
Box: Places a box around the specified elements.
Custom JSP: lets you reference a custom JSP from the Vibe directory.

Custom JSPs must be created by Vibe administrators before you can reference them, as described in
Chapter 10, “Using Custom JSP Files to Enhance Your Vibe Pages,” on page 133.

Divider: Displays a horizontal line between elements.

Expandable Area: Displays an expandable tree element.

Use this option if your form is exceptionally long.

Fieldset: Adds a box that can contain other elements.

HTML: Adds HTML formatting.

Three Column Table: lets you add elements within a three-column table.

Two Column Table: lets you add elements within a two-column table.
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Using Custom JSP Files to Enhance Your
Vibe Pages

Vibe supports the use of custom JavaServer Pages (JSPs) that can help you modify the behavior of
certain areas in your Vibe site. For example, your Vibe administrator might enable a custom JSP file
that enhances the functionality of Vibe landing pages by enabling users to participate in a survey
directly from a workspace landing page.

Before you can leverage the functionality of custom JSP files, your Vibe administrator must first
make the files available. Your Vibe administrator will inform you about the names of the files and
what they can be used for.

Some areas of Vibe, such as landing pages, enable you to add custom JSP files by default. Other
areas, such as folder and workspace forms and views, first require you to do some additional steps,
as described in the following sections:

¢ Section 10.1, “Applying JSP Files to a Landing Page,” on page 133

+ Section 10.2, “Enabling Vibe Forms and Views to Reference JSP Files,” on page 133

10.1 Applying JSP Files to a Landing Page

Landing pages can enhance the presentation of your workspaces and folders and increase the
accessibility of the information they contain. For more information about landing pages, see
Chapter 6, “Creating and Managing Landing Pages,” on page 59.

By default, JSP files can be applied to your Micro Focus Vibe landing page. For information on how to
reference a JSP file from a landing page, see “Adding a Custom JSP” on page 80.

10.2 Enabling Vibe Forms and Views to Reference JSP Files

+ Section 10.2.1, “Applying JSP Files to a Folder Entry Form and View,” on page 134
+ Section 10.2.2, “Applying JSP Files to a Folder or Workspace View,” on page 135
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10.2.1 Applying JSP Files to a Folder Entry Form and View

Folder entry forms are used to add folder entries to all types of Vibe folders. Folder entry views are
used to display folder entries in all types of Vibe folders. You can create your own folder entry forms
and views, or modify existing forms and views. For more information, see Chapter 9, “Designing
Custom Folder Entry Forms,” on page 119.

To enable a folder entry form and view to reference a custom JSP file:
1 Create a new custom folder entry form and view, as described in Section 8.2, “Creating a New
Custom Folder View,” on page 109.
or

Modify an existing folder entry form and view, as described in Section 9.4, “Modifying an
Existing Entry Form,” on page 127.

Only Vibe administrators have the ability to modify default folder entry forms.

2 Add a JSP layout option and element to the folder entry form, as described in Section 8.2.2,
“Adding Elements to the Folder Add/Modify Form,” on page 110.

Form and View Designers

Files
Designer >> Expense Report (expense_report_basic)

Custom J5P
Guest User Name - Please enter your name and email {optional)
HTML - Background Caption

Data Name

Custom Form JSP

3 Specify the following information:
Caption: Specify a name for the custom JSP.
Data Name: Specify an internal name for the custom JSP.
Custom Form JSP: Specify the file name of the custom JSP file.

You must obtain this file name from your Vibe administrator. Only your Vibe administrator can
make JSP files available to be used in the Vibe site.

4 Click OK.
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10.2.2

Applying JSP Files to a Folder or Workspace View

Vibe lets you create custom folder and workspace views. Folder and workspace views define what is
displayed on the home page of your folder or workspace. When you create custom folder or
workspace views, you can display optional features such as remote applications and attachments;
you can also reference JSP files. For more information, see Chapter 8, “Creating Custom Folder
Views,” on page 107, and Chapter 7, “Creating Custom Workspace Views,” on page 95.

To enable a folder or workspace view to reference a custom JSP file:
1 Create a new custom folder or workspace view, as described in Section 7.2, “Creating a New
Custom Workspace View,” on page 97.
or

Modify an existing folder or workspace view, as described in Section 7.4, “Modifying an Existing
Workspace View,” on page 102.

Only Vibe administrators have the ability to modify default folder and workspace views.

2 Add a JSP layout option and element to the folder or workspace view, as described in
Section 8.2.3, “Adding Elements to the Folder View,” on page 111 or Section 7.2.3, “Adding
Elements to the Workspace View,” on page 100, depending on whether you are working with a
folder or workspace view.

Form and View Designers

Marketing
Designer >> Custom Workspace (custom_workspace)

E| Vol Addl]

kspace Add/Modify Form

e T Custom JSP

. Drescription - Description Caption

lcon - lcon Data Mame

[-[E] Workspace view 7

Custom Form JSP

3 Specify the following information:
Caption: Specify a name for the custom JSP.
Data Name: Specify an internal name for the custom JSP.
Custom Form JSP: Specify the file name of the custom JSP file.

You must obtain this file name from your Vibe administrator. Only your Vibe administrator can
make JSP files available to be used in the Vibe site.

4 Click OK.
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11.1

11.1.1

Creating and Managing Workflows

Vibe lets you create custom workflows to streamline important business processes. Vibe
administrators can create workflows and implement them across the entire site, and individual
folder and workspace owners can create workflows to be used in their respective folders and
workspaces.

After you have created a workflow, you can perform the management functions that are described in
this section. You can enable workflows to automatically start when certain types of entries are
created in the folder or when users comment on or reply to an entry; or, you can configure them to
be manually started by users who view the entry.

Examples of workflows include approving documents, ordering supplies, hiring new employees,
requesting paid time off, and getting expense reimbursements.

+ Section 11.1, “Creating a Simple Workflow,” on page 137

¢ Section 11.2, “Creating an Advanced Workflow,” on page 144

¢ Section 11.3, “Visually Representing a Workflow,” on page 163

+ Section 11.4, “Adding Access Controls to a Workflow,” on page 165

+ Section 11.5, “Downloading Existing Custom Forms and Workflows,” on page 173

+ Section 11.6, “Workflows Included with Vibe,” on page 173

¢ Section 11.7, “Enabling Workflows,” on page 174

+ Section 11.8, “Testing a Workflow,” on page 176

¢ Section 11.9, “Importing and Exporting a Workflow,” on page 176

Creating a Simple Workflow

If you have a straightforward business process that you think might benefit from a workflow, you can
create a simple workflow to help automate that process. For example, you might want to create a
workflow that automates the review process of articles for the company magazine. To create a
simple workflow, complete the steps in the following sections:

+ Section 11.1.1, “Creating the Workflow Definition,” on page 137

+ Section 11.1.2, “Adding Workflow States,” on page 138

¢ Section 11.1.3, “Adding Workflow Start and End States,” on page 139

¢ Section 11.1.4, “Adding Manual Transitions,” on page 141

+ Section 11.1.5, “Sending Email Notifications,” on page 142

¢ Section 11.1.6, “Enabling Your Workflow for Use,” on page 144

Creating the Workflow Definition

1 Navigate to the workspace or folder where you want to create the workflow.
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You can create workflows at the workspace level or at the folder level. If you create a workflow
at the workspace level, the workflow can be applied to all sub-folders and sub-workspaces. If
you create a workflow at the folder level, the workflow can be applied only to that folder, and to
the folder’s sub-folders.

2 Click the Configure icon 9 next to the folder or workspace title, then click Form/View
Designers, depending on whether you are creating the workflow at the folder or workspace
level.

The Form and View Designers page is displayed.

3 Inthe Form and View Designers page, click New > Workflow Processes.
The Add a New Definition form is displayed.

4 Specify the following information:
Caption: Specify a name for the workflow process.

This is the name that appears in the Vibe interface. Users see it when they use this workflow.
(For example, “Article Production.”)

Name: Specify the internal name for the workflow process.

The name that you enter in this field is not visible to users who use this workflow. (For example,
“article_production.”)

5 Click OK.
6 Continue with Section 11.1.2, “Adding Workflow States,” on page 138.

11.1.2 Adding Workflow States

Workflow states are the phases that a workflow goes through as it completes the business process.
For example, the Article Production workflow contains five states: Article Composition, Peer Review,
Edit, Manager Approval, Publish.

1 In the Designer page, expand the workflow definition that you created in Section 11.1.1,
“Creating the Workflow Definition,” on page 137.

Form and View Designers

Marketing
Designer >> Article Production (article_production)

E|--- Artic le Production (article_produc tion)

- Workflow Process

2 Click Workflow Process.

3 Click Add.

4 Click State.

5 Specify the following information:

Caption: Specify a name for the workflow state.
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11.1.3

This is the name that appears in the Vibe interface. Users see it when they use this workflow.
(For example, “Article Composition.”)

Name: Specify the internal name for the workflow state.

The name that you enter in this field is an internal-use database name. Names for elements in a
definition must be unique. The first character must be an alphabetic character (a-z, A-Z). For the
rest, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).

Description: Describe the function of the state.
6 Click OK.
7 Repeat Step 2 through Step 6 to add additional workflow states.

The new states are added to the workflow and appear in the Workflow Preview section at the
bottom section of the window.

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.

Workflow Preview
Article Production (article_production)

Save Layout

.Article Composition

. Feer Review
. Edit

. Manager Approval

. Fublish

8 Continue with Section 11.2.3, “Adding Workflow Start and End States,” on page 147 for
information on how you can define start and end states for your workflow.

Adding Workflow Start and End States

Vibe lets you add a Start and End state to your workflow. This is important because without an End
state, a workflow does not officially stop unless you manually stop it. Adding an End state to a
workflow automatically stops the workflow when it reaches the final state.

1 Click Workflow Process.
2 In the Workflow process window, click Modify.

3 Specify the following information:
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140

Initial State: Select the Start state of the workflow process.

End State: Select the End (final) state of the workflow process.

You can select multiple End states by holding the Ctrl key while clicking additional states.
Background Actions Will Run in the Context Of: Select either Entry Owner or Folder Owner.

This option defines the level of access control that the workflow uses. Typically the folder owner
has more access control rights than the entry owner. Certain workflow operations require the
appropriate access controls to complete, so selecting Entry Owner might not provide the
workflow with sufficient access controls. For example, suppose your workflow moves the entry
to a different folder. If you select to run background actions in the context of the entry owner
and the user who is running the workflow at the time the entry is to be moved does not have
rights to create entries in the target folder, the workflow cannot complete. If the folder owner
has rights to create entries in the target folder, selecting to run background actions in the
context of the folder owner allows the workflow to complete as designed.

Click OK.

In the Workflow Preview section, the Start state is marked with yellow, and the End state is
marked with red.

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.

Workflow Preview
Article Production (article_production)

Save Layout

OAnicle Zomposition

. FPeer Review
. Edit

. Manager Approval

. Fublish

Continue with Section 11.1.4, “Adding Manual Transitions,” on page 141 for information on how
you can create transitions that move an entry from one workflow state to the next.
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11.1.4 Adding Manual Transitions

After you have defined the workflow states, you need to create transitions that move an entry from
one state to the next. The easiest kind of transitions to implement are manual transitions.

Manual transitions provide a drop-down list in the entry that allows the user to choose when to
transition the entry. The workflow creator decides which workflow states the user can select in the
drop-down list.

For example, from the “Article Composition” state, the workflow creator might allow the user to
transition the entry to either the “Peer Review” or the “Edit” state.

To create manual transitions from one workflow state to the next workflow state:

1 Expand Workflow Process, then expand the workflow state where you want to transition the
entry from.

For this example, expand the “Article Composition” state.

Form and View Designers

Marketing
Designer >> Article Production (article_production)

- Peer Review
- Edit
- Manager Approval

- Publizh

2 Click Transitions, then click Add in the Transitions box in the right section of the Designer page.
3 Click Manual Transition.

For information regarding the other transition types, see Section 11.2.4, “Adding Transitions,”
on page 147.

4 In the To State select box, select the next state in the workflow.

This is the state that users will be allowed to transition the entry to.
5 Click OK.

Repeat Step 2 through Step 5 if you want to allow users to select from multiple states.
6 Repeat this procedure for all other states in the workflow.

In the Workflow Preview section, you see a diagram representing all of your workflow states
(circles) and transitions (arrows).

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.
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Workflow Preview
Article Production (article_production)

Save Layout

Article Composition

Peer Review
Edit
Manager Approval

Fublish

Continue with Section 11.1.5, “Sending Email Notifications,” on page 142.

Sending Email Notifications

Now that you have added your workflow states and specified how the entry will transition through
those states, you need to set up notifications that inform Vibe users when they need to take action
on the entry as it moves into a state corresponding with their area of expertise.

For example, Julio composes an article for the company magazine. After he composes the article, he
transitions the entry to the next workflow state, Peer Review. Anne, Julio’s co-worker, then receives
an email message notifying her that an article is ready for her to review. After Anne reviews the
article, she transitions it to the next workflow state, Edit, and so forth.

7
11.1.5
1
2
3
4
5
6
7
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Expand the workflow definition, then click the workflow state where you want the notification
to be sent.

For example, click Peer Review.

Click Add.

Click On Entry.

In the On Entry box, click OK.

Click On Entry. (This is located underneath the workflow state where you just created it.)

In the On Entry box, you can select from many options. These are actions that you can choose to
perform when the entry enters this workflow state, such as moving the entry to another
location, copying the entry, or sending notifications. For this basic workflow example, simply
select to send email notifications.

For information about all of the options that you can choose to perform when an entry enters a
workflow state, see Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.

Click Add > Notifications.

In the Notifications box, specify the following information:
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Entry Creator: Select this option if you want to send a notification to the user who created the
entry.

Team: Select this option if you want to send a notification to the entire team.
Users: Specify individual users to whom you want to send a notification.
Groups: Specify groups to whom you want to send a notification.

Additional E-Mail Addresses to Notify: Specify an email address where you want a notification
to be sent.

Select an Entry Type: Use the drop-down list to select the type of entry that most closely
represents the type of entry that is going through the workflow. Some entry types have user
lists, group lists, and team lists that are available in the entry type. For example, if you select
Task Entry, you can select Assigned to, Assigned to Groups, and Assigned to Teams and have
notifications sent to those users.

Text to be Put in the Notification Subject Line: Specify the text that you want to appear in the
subject line of the notification that is sent.

For example, Peer Revi ew Needed.

You can use certain HTML constructs to provide specific information about the entry that is
transitioning through the workflow. For example, you can populate the Notification Subject Line
with the entry title and who last modified the entry: Wor kf | ow noti fication for
{{vibe:title}} from{{vibe: nodifiedBy}}.

For more information about all the HTML constructs you can use, see Appendix B, “Using HTML
Markup in Vibe,” on page 199.

Append the Entry Title: (Optional) Select this option if you want the entry title to appear after
the text in the subject line.

Include a Link to the Entry: Displays a link to the entry in the email notification. This option is
enabled by default. If you do not want a link to the entry in your email notification, you must
deselect this option.

Include the Full Entry: Displays the full entry in the email notification.

Text to be Put in the Notification Body: Specify text that you want to appear in the main body
of the email notification. You can also select Append the Entry Body if you want the main body
of the entry to display with the email notification message.

Any text formatting that you use in this field needs to be done in the HTML format. Following
are some examples of HTML formatting:

* <i></i > for italics

¢ <b></ b> for bold

¢ <br > for a break (return/enter)

+ <p></ p> for a new paragraph

+ <a href ="www. exanpl e. cont ></ a> for links to URLs

You can use certain HTML constructs to provide specific information about the entry that is
transitioning through the workflow. For example, you can populate the Notification Body with
the name of the user who last modified the entry: This entry was | ast nodified by
{{vibe: nodi fi edBy}}.

For more information about all the HTML constructs you can use, see Appendix B, “Using HTML
Markup in Vibe,” on page 199.
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Append the Entry Description: (Optional) Select this option if you want the main body of the
entry to display with the email notification message.

8 Click OK.

9 Repeat this process for every workflow state that needs an email notification message.

11.1.6 Enabling Your Workflow for Use

Now that you have created your workflow, you need to enable it. For information on how to do this,
see Section 11.7, “Enabling Workflows,” on page 174.

11.2 Creating an Advanced Workflow

144

This section expands the workflow design presented in Section 11.1, “Creating a Simple Workflow,”
on page 137.

For example, you might want to create a workflow that automates the expense reporting process for
your department.

Figure 11-1 Advanced Workflow Example

Submit Expense Report .
Meeds Attention

Finance Departmeant
Report Frocessed

. Statistics Department

. Records Department

To create this and other advanced workflows, complete the following sections:

+ Section 11.2.1, “Creating the Workflow Definition,” on page 145

¢ Section 11.2.2, “Adding Workflow States,” on page 145

¢ Section 11.2.3, “Adding Workflow Start and End States,” on page 147
¢ Section 11.2.4, “Adding Transitions,” on page 147

+ Section 11.2.5, “Setting Up Transition Types,” on page 150

¢ Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154

¢ Section 11.2.7, “Setting Up On-Entry and On-Exit Events,” on page 155
¢ Section 11.2.8, “Adding a Parallel Workflow Thread,” on page 158

¢ Section 11.2.9, “Chaining Workflows,” on page 159

¢ Section 11.2.10, “Adding a Question to a Workflow,” on page 159

+ Section 11.2.11, “Enabling Your Workflow for Use,” on page 163
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11.2.1 Creating the Workflow Definition

1 Navigate to the workspace or folder where you want to create the workflow.

You can create workflows at the workspace level or at the folder level. If you create a workflow
at the workspace level, the workflow can be applied to any folder or workspace included in the
workspace. If you create a workflow at the folder level, the workflow can be applied only to that
folder, and to the folder’s sub-folders.

2 Click the Configure icon € next to the folder or workspace title, then click Form/View
Designers, depending on whether you are creating the workflow at the folder or workspace
level.

The Form and View Designers page is displayed.

3 In the Form and View Designers page, click New > Workflow Processes.
The Add a New Definition form is displayed.

4 Specify the following information:
Caption: Specify a name for the workflow process.

This is the name that appears in the Vibe interface. Users see it when they use this workflow.
(For example, “Expense Report Workflow.”)

Name: Specify the internal name for the workflow process.

The name that you enter in this field is not visible to users who use this workflow. (For example,
“expense_report_workflow.”)

5 Click OK.

6 After you define a workflow, you need to add states to it. For information on how to do this,
continue with Section 11.2.2, “Adding Workflow States,” on page 145.

11.2.2 Adding Workflow States

Workflow states are the phases that a workflow goes through as it completes the business process.

For example, the Expense Report workflow contains six states: Submit Expense Report, Finance
Department, Needs Attention, Report Processed, Statistics Department, and Records Department.

1 Inthe Designer page, expand the workflow definition that you created in Section 11.2.1,
“Creating the Workflow Definition,” on page 145.

Form and View Designers

Marketing
Designer >> Expense Report Workflow (expense_report_workflow)

2 Click Workflow Process.
3 Click Add.
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4 Click State.

5 Specify the following information:

Caption: Specify a name for the workflow state.

This is the name that appears in the Vibe interface. Users see it when they use this workflow.
(For example, “Article Composition.”)

You can use alphanumeric characters (a-z, A-Z, 0-9), dashes (-), underscores (_), and spaces.
Name: Specify the internal name for the workflow state.

The name that you enter in this field is an internal-use database name. Names for elements in a
definition must be unique. The first character must be an alphabetic character (a-z, A-Z). For the
rest, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).

Description: Describe the function of the state.
Click OK.
Repeat Step 2 through Step 6 to add additional workflow states.

The new states are added to the workflow and appear in the Workflow Preview section located
in the bottom section of the window.

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.

. Submit Expense Report

. Meeds Attention

. Finance Department
. Report Processed
. Statistics Department

. Records Department

8 After you have added states to your workflow, you need to define the Start and End states. For

information on how to do this, see Section 11.2.3, “Adding Workflow Start and End States,” on
page 147.
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11.2.3 Adding Workflow Start and End States

Vibe lets you add Start and End states to your workflow. This is important because without an End
state, a workflow does not officially stop unless you manually stop it. Adding an End state to a
workflow automatically stops the workflow when it reaches the final state.

1 Click Workflow Process.
2 In the Workflow process window, click Modify.
3 Specify the following information:
Initial State: Select the Start state of the workflow process.
End State: Select the End (final) state of the workflow process.
You can select multiple End states by holding the Ctrl key while clicking additional states.
Background Actions Will Run in the Context Of: Select either Entry Owner or Folder Owner.
4 Click OK.

In the Workflow Preview section, Start states are marked with yellow, and End states are marked
with red.

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.

O Submit Expense Report
. Meads Attention
. Finance Depariment

. Feport Frocessed
. Statistics Department

. Records Department

5 Continue with Section 11.2.4, “Adding Transitions,” on page 147 for information on how to
create transitions that move an entry from one state to the next.

11.2.4 Adding Transitions

After you have defined the workflow states, you need to create transitions that move an entry from
one workflow state to the next.

1 Expand Workflow Process, then expand the workflow state that you want to transition the entry
from.
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For this example, expand the “Submit Expense Report” state.

Form and View Designers

Marketing
Designer >> Expense Report Workflow (expense_report_workflow)

| On Exit

- Meeds Attention

- Finance Department
- Report Processed

& - Statistics Department

- Records Department

2 Click Transitions, then click Add in the Transitions box in the right section of the Designer page.
3 Click the type of transition that you want to add.

Custom Transition: Use this transition if you want to integrate an external process with a Vibe
workflow. To do this, consult with your Vibe administrator.

For example, you might want to synchronize a Vibe workflow with an external workflow. You
can write some custom Java code and use a custom transition to accomplish this.

Immediate Transition: The entry is immediately transitioned.

Manual Transition: Provides a drop-down list in the entry that allows the user to choose when
to transition the entry. The workflow creator decides which workflow states the user can select
in the drop-down list.

Transition After Time Elapsed: The entry is transitioned to the next workflow state after a
specified amount of time.

Transition on Comment or Reply: The entry is transitioned to the next workflow state after a
user makes a comment or a reply on the entry.

Transition on Entry Data Values: The entry is transitioned to a new state based on the value
that a user specifies for a custom element in the entry.

For example:

+ |f you want to assign an entry to a specific state based on a value the user selects, you
define a custom element with multiple values from which a user can make a selection
(from a drop-down list on the form). Map each of these values to specific states in the
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initial workflow state by using the Transition on Entry Data Values option. This option is
useful for assigning help tickets in a help desk, assigning entries to the appropriate review
contact, and so on.

+ If you want to transition an entry at a specific time, you can transition the entry based on a
custom date element.

Transition on Modify: The entry is transitioned to a new state when it is modified.
This can be useful for review purposes.

Transition on Response: Allows you to transition an entry to a new state based on a response to
a question in the entry. Map each possible answer to a workflow question to one of these
transitions by using the Data name for each Workflow Response.

For specific instructions on how to do this, see Section 11.2.10, “Adding a Question to a
Workflow,” on page 159.

Transition on a Variable: You can make decisions based on the value of a variable that you set.
For example, you could have a process that sends email notifications when it enters a state. The
process re-enters that same state later in the process, but you do not want to send the
notifications more than once. Set up that first state so that it sends notifications only if the
“sent notifications” variable is not true.

Wait for Parallel Thread(s) to End: Allows you to transition an entry to a new state when one or
more specified parallel workflow threads end.

Specify setup options.

After you select a transition type in Step 3, you must set up the transition. Each transition type
requires you to specify different setup options.

For specific information regarding the information that you need to specify for the individual
fields, see “Setting Up Transition Types” on page 150.

5 Click OK.

Repeat Step 1 through Step 5 for all other states in the workflow.

In the Workflow Preview section, you see a diagram representing all of your workflow states
(circles) and transitions (arrows).

For more information on the Workflow Preview section, see Section 11.3, “Visually
Representing a Workflow,” on page 163.
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Feport Processed
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7 After you have set up how entries transition from one workflow state to another in your
workflow, you can set up events to occur when the entry enters or exits particular workflow
states. For information on how to do this, as well as the kinds of entry and exit events that you
can set up, see Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.

11.2.5 Setting Up Transition Types

When you choose a specific type of transition, you might need to provide information regarding the
type of transition that you selected.

Following are the types of transitions that you can choose from, and the information describing the
fields that you must complete in order to set up each type of transition:

¢ “Custom Transition” on page 150

+ “Immediate Transition” on page 151

¢ “Manual Transition” on page 151

+ “Transition After Time Elapsed” on page 151

+ “Transition on Comment or Reply” on page 152

+ “Transition on Entry Data Values” on page 152

+ “Transition on Modify” on page 152

+ “Transition on Response” on page 152

+ “Transition on a Variable” on page 153

+ “Wait for Parallel Thread(s) to End” on page 153

Custom Transition

After you begin creating the Custom Transition as described in Section 11.2.4, “Adding Transitions,”
on page 147, you see the following options:

Condition Class Name: Specify the Java file name where your Vibe administrator created the custom
transition. Consult with your Vibe administrator to get the name of this file.

To State: Select the state where you want to transition the entry.
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Immediate Transition

After you begin creating the Immediate Transition as described in Section 11.2.4, “Adding
Transitions,” on page 147, you see the following option:

To State: Select the state where you want to immediately transition the entry.

Manual Transition

After you begin creating the Manual Transition as described in Section 11.2.4, “Adding Transitions,”
on page 147, you see the following option:

To State: Select the state where you want to allow users to transition the entry.

After you create the transition, repeat Step 2 on page 148 through Step 5 on page 149 if you want to
allow users to select from multiple states.

You can set access controls on the manual transition to allow only certain users to transition the
entry. If you do not set any access controls, the default is to allow all users who have Write access to
the entry to transition the entry. For more information about how to set access controls on the
manual transition, see Section 11.4.3, “Setting Access Controls on a Manual Transition,” on

page 171.

Transition After Time Elapsed

After you begin creating the Transition After Time Elapsed transition as described in Section 11.2.4,
“Adding Transitions,” on page 147, you see various options. You can specify values for each option,
and the values are added together. For example, if you want to transition entries 4 business days, 3
hours, and 20 minutes after they enter the workflow state, you enter 4 in the Business Days field, 3
in the Hours field, and 20 in the Minutes field.

Numbers entered in the following fields must be whole values. Decimal points and fractions are not
valid.

Calendar Days: Specify how many calendar days to wait before the transition. Calendar days include
weekends and holidays.

Business Days: Specify how many business days to wait before the transition. Business days do not
include weekends and holidays.

The Vibe administrator determines which days are considered to be business days, as described in
“Configuring Weekends and Holidays” in “VibeSite Setup” in the OpenText Vibe 4.0.8 Administration
Guide.

Hours: Specify how many hours to wait before the transition.
Minutes: Specify how many minutes to wait before the transition.

To State: Select the state where you want to transition the entry after the elapsed time that you
specified.
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Transition on Comment or Reply

After you begin creating the Transition on Comment or Reply transition as described in
Section 11.2.4, “Adding Transitions,” on page 147, you see the following option:

To State: Select the state where you want to transition the entry after a user comments on or replies
to the entry.

Transition on Entry Data Values

After you begin creating the Transition on Entry Data Values transition as described in Section 11.2.4,
“Adding Transitions,” on page 147, you see the following options:

Match Entry Data Values: Select Match Any if only one condition must be met for the entry to
transition. Select Match All if all conditions must be met before the entry transitions.

To State: Select the state where you want to transition the entry.

Transition on Modify

After you begin creating the Transition on Modify transition as described in Section 11.2.4, “Adding
Transitions,” on page 147, you see the following option:

To State: Select the state where you want to transition the entry when the entry is modified.

When you are working with a File entry, modifications made to the file also cause the workflow to be
transitioned. Modifications to a file include setting the status of the file, incrementing the major
version, editing the file note, reverting to a previous version, and deleting the file. For more
information about working with File entries, see “Working with Files in a Folder Entry” in the
OpenText Vibe 4.0.8 User Guide

Transition on Response

After you begin creating the Transition on Response transition as described in Section 11.2.4,
“Adding Transitions,” on page 147, you see the following option:

Workflow Question: Specify the Data Name for the workflow question that you previously defined.

For information on how to create a workflow question, see “Creating a Workflow Question” on
page 160.

Workflow Response: Specify the Data Name for the workflow response that you previously defined.

For information on how to create a workflow response, see “Creating Answers to a Workflow
Question” on page 160.

To State: Select the state where you want to transition the entry after a user responds to the
workflow question.

The Transition Occurs:

+ As soon as one person answers with the Workflow Response: Transitions the entry
immediately after one person responds to the workflow question with the value that is in the
Workflow Response field in the Transition on Response dialog box.
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+ As soon as a majority have answered with the Workflow Response: Transitions the entry
immediately after a majority of people respond to the workflow question with the value that is
in the Workflow Response field in the Transition on Response dialog box.

+ After everyone has responded and all have answered with the Workflow Response:

Transitions the entry after all responders have responded to the workflow question and all
people respond with the value that is in the Workflow Response field in the Transition on
Response dialog box.

+ After everyone has responded and somebody answered with the Workflow Response:

Transitions the entry after all responders have responded to the workflow question and at least
one person responds with the value that is in the Workflow Response field in the Transition on
Response dialog box.

+ After everyone has responded and not all have answered with the Workflow Response:

Transitions the entry after all responders have responded to the workflow question and at least
one person responds with a value that is not in the Workflow Response field in the Transition on
Response dialog box.

+ After everyone has responded and a majority answered with the Workflow Response:

Transitions the entry after all responders have responded to the workflow question and the
majority of people respond with the value that is in the Workflow Response field in the
Transition on Response dialog box.

For more information about how to designate specific users to respond to the question, see
“Designating Specific Users to Respond to a Workflow Question” on page 162

Transition on a Variable

After you begin creating the Transition on a Variable transition as described in Section 11.2.4,
“Adding Transitions,” on page 147, you see the following options:

Variable Name: Specify the name of the workflow variable that you want to activate the transition.

You must have already created a workflow variable. You create a workflow variable as an On Entry or
On Exit event, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.

Variable Value: Specify the value of the workflow variable that you want to activate the transition.

You must have already created a workflow variable. You create a workflow variable as an On Entry or
On Exit event, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.

To State: Select the state where you want to transition the entry.

Wait for Parallel Thread(s) to End

After you begin creating the Wait for Parallel Thread(s) to End transition as described in
Section 11.2.4, “Adding Transitions,” on page 147, you see the following options:

Parallel Thread Name: Select the parallel thread that you want to wait for.

Transition to State: Select the state where you want to transition the entry after all selected threads
have ended.
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11.2.6

Adding On-Entry or On-Exit Events

You can take action when a process enters or exits a workflow state. For example, when an entry
enters (or exits) a workflow state, you can send a notification, begin or end a parallel process, set a
variable, modify an element within the entry, and more.

1 Navigate to and click the workflow state where you want to set up an event to occur when the

entry enters or exits the state.
Click Add.

Click On Entry or On Exit, depending on whether you want the event to occur when the entry
enters or exits the state.

In the On Entry (or On Exit) box, click OK.

5 Click On Entry or On Exit, depending on whether you are adding an On Entry or On Exit event.

(This is located underneath the workflow state where you just created it.)
Click Add.
Click the type of event that you want to add.

Copy Entry: Allows you to copy an entry to a new location in Vibe when it enters or exits a
specific state.

When used as an On Entry event, this event cannot be used in the initial state of a workflow or
in any workflow state that is immediately transitioned to from the initial state with an
Immediate Transition.

Custom Action: Use the custom action if you want to integrate an external process (usually
contained within a JAR file) with a Vibe workflow. To do this, consult with your Vibe
administrator.

For more information about how Vibe administrators can enable JAR files to be used as custom
workflow actions, see “Enabling Custom JAR Files to Be Used on Your Vibe Site” in the OpenText
Vibe 4.0.8 Administration Guide.

Move Entry: Allows you to move an entry to a new location in Vibe when it enters or exits a
specific state.

Notifications: Allows you to notify specific users or groups about an entry when it enters or
exits the state.

Remote Application: Remote applications communicate with a third-party online application,
and send information from that third-party application back into Vibe. You can enable a remote
application to start when entries enter or exit a workflow state.

Remote applications need to be set up and configured by your Vibe administrator before you
can add them.

Set Entry Data: lets you automatically modify an element within an entry when the entry enters
or exits a workflow state.

Set a Workflow Variable: Defines a variable to be used when transitioning a workflow.

This workflow variable is referenced with the Transition On a Variable transition, as described in
Section 11.2.4, “Adding Transitions,” on page 147.

Start a Parallel Workflow Thread: Allows you to start a parallel workflow when an entry enters
or exits a specific state. Parallel workflows are useful if two or more processes need to occur
simultaneously. Only when the parallel thread is finished can the main workflow thread
proceed.

154  Creating and Managing Workflows


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#buj9oa3
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

10

11

Before you can start a parallel workflow thread, you first need to create it. For information on
how to create a parallel workflow thread, see Section 11.2.8, “Adding a Parallel Workflow
Thread,” on page 158.

Start a Workflow Process: Vibe lets you chain workflows together. When you are creating a
workflow (or modifying an existing workflow), you can start an existing workflow process on the
workflow you are creating (or modifying). This can speed up the workflow creation process by
helping you make use of existing workflows.

Starting an existing workflow process is not the same as starting a parallel workflow thread.
Unlike a parallel workflow thread, when you chain workflows together by starting an existing
workflow process, there is no way to share variables or states between the two workflows; in
other words, there is no physical connection between the two workflows.

Stop a Workflow Thread: Allows you to stop a parallel workflow when an entry enters or exits a
specific state.

Set up the event you selected in Step 7. Each event type requires you to specify different setup
options.

For information on what to specify for the individual fields, see Section 11.2.7, “Setting Up On-
Entry and On-Exit Events,” on page 155.

Click OK.

Repeat this procedure for all other states in the workflow where you want to set up on-entry or
on-exit events.

Set up access controls on the workflow. For information on how to do this, see Section 11.4,
“Adding Access Controls to a Workflow,” on page 165.

11.2.7 Setting Up On-Entry and On-Exit Events

After you add an on-entry or on-exit event to a workflow as described in Section 11.2.6, “Adding On-
Entry or On-Exit Events,” on page 154, you need to provide information to set up the event.

*

*

*

*

“Copy Entry” on page 155

“Custom Action” on page 156

“Move Entry” on page 156

“Notifications” on page 156

“Remote Applications” on page 157

“Set Entry Data” on page 157

“Set a Workflow Variable” on page 157

“Start a Parallel Workflow Thread” on page 158
“Start a Workflow Process” on page 158

“Stop a Workflow Thread” on page 158

Copy Entry

Select the Destination Folder: Select the folder to copy the entry to.

Selected Folder: Displays the destination folder that you selected.
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Start This Workflow on the New Entry: Select the state where you want the workflow to start on
the new entry. You can configure the workflow to start at the initial state, at the current state, or to
not start at all.

Custom Action

Action Class Name: Specify the name of the custom action that your Vibe administrator has set up.
Work with your Vibe administrator for information on what you should put in this field.

For more information about how Vibe administrators can enable JAR files to be used as custom
workflow actions, see “Enabling Custom JAR Files to Be Used on Your Vibe Site” in the OpenText
Vibe 4.0.8 Administration Guide.

Move Entry

Select the Destination Folder: Select the folder to move the entry to.

Selected Folder: Displays the destination folder that you selected.

Notifications

Entry Creator: Select this option if you want to send a notification to the user who created the entry.
Team: Select this option if you want to send a notification to the entire team.

Users: Specify individual users to whom you want to send a notification.

Groups: Specify groups to whom you want to send a notification.

Additional E-mail Addresses to Notify: Specify an email address where you want a notification to be
sent.

Select an Entry Type: Use the drop-down list to select the type of entry that most closely represents
the type of entry that is going through the workflow.

Text to be Put in the Notification Subject Line: Specify the text that you want to appear in the
subject line of the notification that is sent.

For example, Peer Revi ew Needed.

Append the Entry Title: (Optional) Select this option if you want the entry title to appear after the
text in the subject line.

Include a Link to the Entry: Displays a link to the entry in the email notification. This option is
enabled by default. If you do not want a link to the entry in your email notification, you must
deselect this option.

Include the Full Entry: Displays the full entry in the email notification.

Text to be Put in the Notification Body: Specify text that you want to appear in the main body of the
email notification. You can also select Append the Entry Body if you want the main body of the entry
to display with the email notification message.
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Any text formatting that you use in this field needs to be done in the HTML format. Following are
some examples of HTML formatting:

* <j></i>foritalics

+ <b></ b> for bold

¢ <br > for a break (return/enter)

+ <p></ p> for a new paragraph

+ <a href="ww. exanpl e. cont ></ a> for links to URLs

Append the Entry Body: (Optional) Select this option if you want the main body of the entry to
display with the email notification message.

Remote Applications

Remote Application: From the drop-down list, select the remote application.

Remote applications need to be set up and enabled by your Vibe administrator before you can use
them. For more information about remote applications, see Chapter 12, “Managing Remote
Applications,” on page 179.

Variable Name: Specify the name of the variable to contain the results that are returned by the
remote application.

Execute Action in the Context Of: Select who you want the remote application to be in relation to:
Active User, Entry Owner, or Folder Owner.

Set Entry Data

Select an Entry Type: Select the entry type that you want to associate the workflow with.

Select an Element within the Entry: Select the element in the entry that you want to be
automatically modified.

Select the Operation: Depending on the type of element that you selected, you have various
modification options that you can perform. Possible operations include:

+ Set: Provides another drop-down list whereby you can select the action that you want to
perform on the element. If it is a text element, you can specify text to be added to the element.
+ Set to Now: Resets the date of the element to the current day and time.

+ Increment Date: Increments the date of the element by a specified number of minutes, hours,
or days.

+ Decrement Date: Decrements the date of the element by a specified number of minutes, hours,
or days.

+ Set to Now: Resets the date of the element to the current day and time.

Select the New Value: This is the new value for the element that you are modifying. The options in
this list are based on the operation that you previously selected.

Set a Workflow Variable

Variable Value: Specify the name of the workflow variable.
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Variable Name: Specify the value of the workflow variable. This is the name that is referenced
internally.

Start a Parallel Workflow Thread

Parallel Thread Name: Select the parallel workflow thread that you want to start.
You must have already created the parallel workflow thread in order for it to be displayed in this list.

For information on how to create a parallel workflow thread, see Section 11.2.8, “Adding a Parallel
Workflow Thread,” on page 158.

Start a Workflow Process

Workflow Process: From the drop-down list, select the workflow process that you want to start.

Stop a Workflow Thread

Parallel Thread Name: Select the workflow thread that you want to stop.

11.2.8 Adding a Parallel Workflow Thread

Vibe workflows support parallel workflow threads, which enable you to start a second workflow
inside of an existing workflow. Parallel workflows are useful if two or more processes need to occur
simultaneously. The main workflow is dependent on the parallel workflow thread; only when the
parallel thread is finished can the main workflow thread proceed.

To create a parallel workflow thread:

1 Click Workflow Process.
2 Click Add > Parallel Workflow Thread.
3 Specify the following information:
Caption: Specify a name for the parallel workflow thread.

This is the name that appears in the Vibe interface, that users see when they use this workflow
thread.

Data Name: Specify the internal name for the parallel workflow thread.
The name that you enter in this field is not visible to users who use this workflow thread.
Start State: Select the first state in the parallel workflow thread.
End State: Select the last state in the parallel workflow thread.
4 Click OK.

For information on how to start and stop a parallel workflow thread after you have created it, see
Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.
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11.2.9

11.2.10

Chaining Workflows

Vibe lets you chain workflows together by starting a workflow process inside of a workflow that you
are creating (or modifying). This can speed up the workflow creation process by helping you make
use of existing workflows.

Starting an existing workflow process is not the same as starting a parallel workflow thread. Unlike a
parallel workflow thread, when you chain workflows together by starting an existing workflow
process, there is no way to share variables or states between the two workflows; in other words,
there is no physical connection between the two workflows.

You chain workflows by adding an On Entry or On Exit option to the workflow state where you want
to add the existing workflow process. Use the On Entry or On Exit option to add the existing
workflow process, as described in Section 11.2.6, “Adding On-Entry or On-Exit Events,” on page 154.

Adding a Question to a Workflow

Workflow questions can enhance the ease and usability of workflows. For example, imagine a Time-
Off Request workflow where a manager can respond to a request by simply selecting Yes or No in the
workflow.

In the following example, if the manager selects Yes, the workflow is transferred to the next state of
the workflow, HR Approval. If the manager selects No, the request is denied and the workflow is
ended.

Figure 11-2 Workflow Question Layout

Wﬁ?equest
Team Lead Review

Approved by Team Lead

Denied by Team Lead

MNeeds Team Lead Aftention

Denied by Manager

Insufficient Balance
Needs Manager Attention

. Manager Review Out of Compliance with Time Off Policy

Denied by HR

Approved by Manager
MNeeds HR Attention

. HR Review

Appraved by HR

. Time Off Approved

+ “Creating a Workflow Question” on page 160

+ “Creating Answers to a Workflow Question” on page 160

+ “Designating Specific Users to Respond to a Workflow Question” on page 162
+ “Creating Transitions” on page 163

+ “Setting Access Controls on a Workflow Question” on page 163
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Creating a Workflow Question

1 Click the workflow state where you want to add the workflow question.

A workflow question can be specific to a single state (each state can have only one associated
guestion), or you can define a global question, which you can then associate with any number
of states. Global questions are useful when multiple states require the same question and
answer set.

Click Add > Workflow Question.

Specify the following information:

Question Text: Specify the question that you want to appear in the workflow.
For example, Approve tine-off request?

Data Name: Specify the internal name for the workflow question.

This name must be unique because it is the name that you use to refer to the workflow question
in future steps. For example, appr ove_ti nmeof f _request.

4 Click OK.

5 Continue with “Creating Answers to a Workflow Question” on page 160.

Creating Answers to a Workflow Question

1 Click Workflow Question.

This is the question that you created in “Creating a Workflow Question” on page 160.
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Form and View Designers

Marketing
Designer >> Time Off Request Process (timeoff_workflow_3_tiers)

State - Mew Time Off Reguest
State - Team Lead Review

State - Meeds Team Lead Attention

State - Denied by Team Lead

State - Approved by Team Lead

- Manager Review
On Entry

r§°| Transitions
Workflow Qiu Estic-r')

Access controls

tate - Needs Manager Attention
tate - Denied by Manager

tate - Approved by Manager
tate - HR Review

tate - Needs HR Attention

tate - Denied by HR

tate - Approved by HR

tate - Insufficient Balance

tate - Out of Compliance with Time Off Policy

tate - Time Off Approved

Click Add > Workflow Response.

Specify the following information:

Response Text: Specify a single response option.

For example, Yes.

Data Name: Specify the internal name for the workflow response.
For example, yes.

Click OK.

5 Repeat Step 1 through Step 4 to create multiple answers to the same workflow question.

Users using this workflow can choose from the answers that you create.

You can designate specific users as responders to the workflow question, as described in
“Designating Specific Users to Respond to a Workflow Question” on page 162.
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Designating Specific Users to Respond to a Workflow Question

When you designate specific users as responders to a workflow question, you can configure the
workflow to transition only after all responders have answered the workflow question, or only after
all responders have answered the workflow question correctly. For more information, see
“Transition on Response” on page 152.

1 Click Workflow Question.

This is the question that you created in “Creating a Workflow Question” on page 160.

Form and View Designers

Marketing
Designer >> Time Off Request Process (timeoff_workflow_3_tiers)

State - New Time Off Request

: - Team Lead Review

- Meeds Team Lead Attention
- Denied by Team Lead

- Approved by Team Lead

- Manager Review

r§°| Transitions
; Workflow Qu Esti::-r')

| Access controls

te - Needs Manager Attention

te - Denied by Manager

te - Approved by Manager

te - HR Review

te - Meeds HR Attention

te - Denied by HR

te - Approved by HR

te - Insufficient Balance

te - Out of Complianc e with Time Off Policy

te - Time Off Approved

2 Click Add > Responders.
The Responders dialog box is displayed.

3 In the provided form, specify which users or groups of users you want to specify as responders
to the workflow question:

Folder Default Access: Select this option to specify all users who have access to the folder as
responders.
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11.2.11

11.3

Entry Creator: Select this option to specify the user who created the entry as a responder.
Team: Select this option to specify the team as responders.

Users: Specify individual users as responders.

Groups: Specify groups as responders.

Select an Entry Type: Select the type of entry that most closely represents the type of entry
that is going through the workflow.

Select Elements within the Entry: lets you select elements that are contained in the entry.
Users associated with that element are granted access.

For example, if you select Task Entry in the Select an Entry Type drop-down list, the options that
you can select in the Select Elements within the Entry are Assigned to, Assigned to Groups,
Assigned to Teams.

4 Click OK.

Creating Transitions

Now that you have created the workflow question and workflow answers, you need to create
transitions that correspond to the answers that you created. This kind of transition is called
“Transition on Response.”

For information on how to create a Transition on Response, see Section 11.2.4, “Adding Transitions,”
on page 147.

Setting Access Controls on a Workflow Question

If you want to add access controls to this workflow question, you must use the Transition Out of This
State access control setting. For more information, see Section 11.4, “Adding Access Controls to a
Workflow,” on page 165.

Enabling Your Workflow for Use

Now that you have created your workflow, you need to enable it. For information on how to do this,
see Section 11.7, “Enabling Workflows,” on page 174.

Visually Representing a Workflow

Vibe lets you view a visual representation of your workflow, which makes the creation process easier
by allowing you to envision the workflow in every step of its development.

As you create your workflow in the Designer section, the changes you make are automatically added
to the Workflow Preview section.
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11.3.1

11.3.2

Figure 11-3 Workflow Preview Section

Workflow Preview
Expense Report Workflow (expense_report_workflow)

Save Layout

Submit Expense Report .
Meeds Aftention

Finance Depatment

Report Processed

. . Records Department
Statistics Department

You can modify the workflow layout in the Workflow Preview section. You must save the layout after
you have modified it.

+ Section 11.3.1, “Modifying a Workflow Layout,” on page 164

+ Section 11.3.2, “Saving a Workflow Layout,” on page 164

Modifying a Workflow Layout

You can easily modify the visual representation of a workflow. Modifying the workflow layout can
make it easier to understand how a workflow process operates because it lets you better visualize
the process.

1 In the Workflow Preview section, click a workflow state and drag the state to the desired
location.

Transition arrows automatically adjust to the new locations of the workflow states.

Saving a Workflow Layout

By default, every time you make a change in the Designer section when you create a workflow, any
changes that you previously made in the Workflow Preview section are reverted to the state when
you last saved.

To save your layout in the Workflow Preview section:

1 Click Save Layout after you have modified your workflow layout.

Now, when you make changes in the Designer section, the changes that you previously made to
your workflow layout in the Workflow Preview section are retained.
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11.4 Adding Access Controls to a Workflow

Vibe lets you set access controls on workflows that you create. You can set access controls on an
entire workflow, or on the individual states of a workflow.

+ Section 11.4.1, “Setting Access Controls on an Entire Workflow,” on page 165
+ Section 11.4.2, “Setting Access Controls on Individual States of a Workflow,” on page 168

+ Section 11.4.3, “Setting Access Controls on a Manual Transition,” on page 171

11.4.1 Setting Access Controls on an Entire Workflow

1 In the Designer page, expand the workflow definition that you created in Section 11.2.1,
“Creating the Workflow Definition,” on page 145.

Form and View Designers

Marketing
Designer >> Expense Report Workflow (expense_report_workflow)

2 Click Workflow Process.
3 Click Add > Access controls.
4 Click OK.

5 Expand Workflow Process, then click Access controls.
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Form and View Designers

Marketing
Designer >> Time Off Request Process (timeoff_workflow_3_tiers)

= E Time Off Reguest Process (timeoff_workflow_3_tiers)

- Mew Time Off Request

- Team Lead Review

- Meeds Team Lead Attention
- Denied by Team Lead

- Approved by Team Lead
- Manager Review

- Meeds Manager Attention
- Denied by Manager

- Approved by Manager

- HR Review

- Meeds HR Attention

- Denied by HR

- Approved by HR

- Insufficient Balance

- Dut of Compliance with Time Off Policy

- Time Off Approved

1[4ccess controls

6 Click Add.

7 Click the access control setting that you want to add.

Delete Access: lets you grant specific users rights to delete entries as they transition through
the workflow process.

Modify Access: lets you grant specific users rights to modify entries as they transition through
the workflow process.

Modify Specified Fields: lets you grant users or groups who do not have rights to modify an
entry (have only rights to view the entry) with rights to modify specific fields within the entry.
(Users who already have the right to modify the entry are not affected.)

Field elements must first be configured to allow field-level modifications. You designate which
fields have the field-level modification access control by selecting the Allow field level
modification option when you are creating or modifying an element within the entry form, as
described in “Adding Elements to a Form” on page 123 and “Modifying Elements in a Form” on
page 123. The elements that have been configured to allow field-level modifications can be
modified only by the users that you specify in the Modify Specified Fields access control, and
only in the workflow state where this access control exists.
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For more detailed information, see this TID in the in the Novell Support Knowledgebase (https:/
/www.novell.com/support/kb/): “Allowing users to modify specific form fields” (https://
www.novell.com/support/kb/doc.php?id=7015045).

Read Access: lets you grant specific users rights to read entries as they transition through the
workflow process. Furthermore, you can choose whether or not users are allowed to comment
or reply to the entries.

Transition Into This State: lets you grant specific users rights to transition entries into any state
in the workflow.

Transition Out of This State: lets you grant specific users rights to transition entries out of any
state in the workflow.

This is the access control setting that determines who can see a workflow question. If you are
adding a workflow question to your workflow or to an individual state, as described in
Section 11.2.10, “Adding a Question to a Workflow,” on page 159, and you want to add access
controls to determine who sees the question, you must use this access control setting.

Define the access control setting that you added in Step 7 by specifying the following
information in the provided form:

Modify Access

Folder Default Access
Entry Creator

Team

Users and Groups
Users

Fzaople

Groups

Find Groups

Select an Entry Type
—selectan entry type— v

Folder Default Access: Select this option to grant access to all users who have access to the
folder.

Entry Creator: Select this option to grant access to the user who created the entry.
Team: Select this option to grant access to the team.

Users: Specify individual users to whom you want to grant access.

Groups: Specify groups to whom you want to grant access.

Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list
that you select in the Select Elements within the Entry field are granted access.
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Select Elements within the Entry: Select the user list fields that are contained within the
selected entry type that contain users to whom you want to grant access.

Access control rights can be granted only for the User List, Group List, and List elements. By
default, only calendar entry types and task entry types contain these elements. For Calendars,
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned
to, Assigned to Groups, and Assigned to Teams fields.

For information about how to add these elements to existing entry types, or how to create your
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom
Folder Entry Forms,” on page 119.

9 Click OK.

11.4.2 Setting Access Controls on Individual States of a Workflow

1 In the Designer page, expand the workflow definition that you created in Section 11.2.1,
“Creating the Workflow Definition,” on page 145.

2 Expand Workflow Process, then click the state where you want to add the access controls.

Form and View Designers

Marketing
Designer >> Time Off Request Process (timeoff_workflow_3_tiers)

Mew Time Off Request

- Team Lead Review

- Meeds Team Lead Attention
- Denied by Team Lead

- Approved by Team Lead

- Manager HE'.-'iEW)

- Needs Manager Attention

- Denied by Manager

- Approved by Manager

- HR Review

- Meeds HR Attenticn

- Denied by HR

- Approved by HR

- Insufficient Balance

- Dot of Compliance with Time Off Policy

- Time Off Approved

3 Click Add > Access controls.
4 Click OK.
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5 Expand the state where you just added the access controls, then click Access controls.
6 Click Add.
7 Click the access control setting that you want to add.

Delete Access: lets you grant specific users rights to delete entries when they are in this
workflow state.

Modify Access: lets you grant specific users rights to modify entries when they are in this
workflow state.

Modify Specified Fields: lets you grant users or groups who do not have rights to modify an
entry (have only rights to view the entry) with rights to modify specific fields within the entry.
(Users who already have the right to modify the entry are not affected.)

Field elements must first be configured to allow field-level modifications. You designate which
fields have the field-level modification access control by selecting the Allow field level
modification option when you are creating or modifying an element within the entry form, as
described in “Adding Elements to a Form” on page 123 and “Modifying Elements in a Form” on
page 123. The elements that have been configured to allow field-level modifications can be
modified only by the users that you specify in the Modify Specified Fields access control, and
only in the workflow state where this access control exists.

After you add this access control to a workflow state and define the fields that can be modified,
you cannot select different fields to be modified when adding this access control to a different
workflow state.

For more detailed information, see the following TID in the Novell Support Knowledgebase
(https://www.novell.com/support/kb/): “Allowing users to modify specific form fields” (https://
www.novell.com/support/kb/doc.php?id=7015045).

Read Access: lets you grant specific users rights to read entries when they are in this workflow
state. Furthermore, you can choose whether or not users are allowed to comment or reply to
the entries.

Transition Into This State: lets you grant specific users rights to transition entries into this state.
This setting is relevant only when a manual transition is defined involving this state.

Transition Out of This State: lets you grant specific users rights to transition entries out of this
state.

This setting is relevant only when a manual transition is defined involving this state.
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Meodify Access
I Folder Default Access
I Entry Creator

! Team

Users and Groups
Users

Fezople

Groups
Find Groups

Selectan Entry Type
—selectan entry type— v

[ OK QI Cancel ]

8 Define the access control setting that you added in Step 7 by specifying the following

information in the provided form:

Folder Default Access: Select this option to grant access to users who have access to the folder.
Entry Creator: Select this option to grant access to the user who created the entry.

Team: Select this option to grant access to the team.

Users: Specify individual users to whom you want to grant access.

Groups: Specify groups to whom you want to grant access.

Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list
that you select in the Select Elements within the Entry field are granted access.

Select Elements within the Entry: Select the user list fields that are contained within the
selected entry type that contain users to whom you want to grant access.

Access control rights can be granted only for the User List, Group List, and List elements. By
default, only calendar entry types and task entry types contain these elements. For Calendars,
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned
to, Assigned to Groups, and Assigned to Teams fields.

For information about how to add these elements to existing entry types, or how to create your
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom
Folder Entry Forms,” on page 119.

9 Click OK.
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11.4.3

Setting Access Controls on a Manual Transition

1 Inthe Designer page, expand the workflow definition that you created in Section 11.2.1,

“Creating the Workflow Definition,” on page 145.

2 Expand Workflow Process, expand the state that contains the manual transition where you want
to set the access controls, expand Transitions, then click Manual Transition.

Form and View Designers

Marketi

ng

Designer >> Time Off Request Process (timeoff_workflow_3_tiers)

fl-[Z] State - Team Lead Review
H-- E State - Meeds Team Lead Attention

§|--- State - Denied by Team Lead

3 Click Add

§|--- State - Approved by Team Lead

> Manual Transition Access Controls.
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¥
7

Manual Transition Access Controls
I Folder Default Access
! Entry Creator

] Team

Isers and Groups
Users

FPeople

Groups
Find Groups

Selectan Entry Type
—select an entry type— r

Ok il Cancel ]

4 In the provided form, specify which users or groups of users to whom you want to grant access

to transition the entry:

Folder Default Access: Select this option to grant access to users who have access to the folder.
Entry Creator: Select this option to grant access to the user who created the entry.

Team: Select this option to grant access to the team.

Users: Specify individual users to whom you want to grant access.

Groups: Specify groups to whom you want to grant access.

Select an Entry Type: Select an entry type that contains a user list. Users who are in the user list
that you select in the Select Elements within the Entry field are granted access.

Select Elements within the Entry: Select the user list fields that are contained within the
selected entry type that contain users to whom you want to grant access.

Access control rights can be granted only for the User List, Group List, and List elements. By
default, only calendar entry types and task entry types contain these elements. For Calendars,
this is the Attendee, Attendee Groups, and Attendee Teams fields. For tasks, this is the Assigned
to, Assigned to Groups, and Assigned to Teams fields.

For information about how to add these elements to existing entry types, or how to create your
own custom entry types where you can add these elements, see Chapter 9, “Designing Custom
Folder Entry Forms,” on page 119.

5 Click OK.
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11.5

11.6

11.6.1

Downloading Existing Custom Forms and Workflows

The OpenText Resource Library provides a collection of existing Vibe folder entry forms and
workflows that have been designed to solve specific business problems. You can easily download the
custom forms and workflows, and then import them into your Vibe environment. You can further
customize these forms and workflows to suit your individual business needs.

1 Navigate to the OpenText Resource Library website (http://www.novell.com/products/
teaming/resource-library/).

2 In the Forms and Workflows tab, select the custom form or workflow that you want to use in
your Vibe environment.

3 In the Attachment section, click the zi p file to download it.
4 Import the file into your Vibe environment and deploy it for use.

For information on how to do this, follow the OpenText Resource Library Deployment
Instructions (http://www.novell.com/products/vibe-onprem/resource-library/demos/
form_workflow_deployment.html).

Workflows Included with Vibe

Vibe includes three predefined workflows. One is available for you to enable and use; the others are
used within Vibe.

¢ Section 11.6.1, “Available Workflows,” on page 173
¢ Section 11.6.2, “Internal Workflows,” on page 174

Available Workflows

Vibe currently includes the Publish workflow, which is functional as soon as you enable it, as
described in Section 11.7, “Enabling Workflows,” on page 174.

You can use the Publish workflow in the following ways:

Publish Entries to a Landing Page: You can use the Publish workflow to publish entries to a landing
page, without manually modifying the contents of the landing page.

For more information, see Section 6.11, “Automatically Displaying the Newest Folder Entries on Your
Landing Page,” on page 86.

Keep Entries Private: You can use the Publish workflow to keep entries private until you are ready to
publish them for other Vibe users to read.

For example, you can associate the Publish workflow with a certain entry type in a folder (see
Section 11.7.1, “Enabling Workflows to Start When an Entry Is Created,” on page 175 for more
information). When you create an entry in the folder, the entry is created as Private. When you are
ready for other Vibe users to view the entry, you can change the workflow status to Publish.

To transition the workflow status of an entry from Private to Publish:

1 Open the entry. In the Transition to field, select Publish in the drop-down list.
2 Click OK.
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11.6.2

11.7

To make the workflow status of the entry Private again:

1 Open the entry where you want to change the workflow status.

2 In the Entry toolbar, click Workflow > Stop Workflow: Publish Workflow, then click OK when you
are asked if you really want to stop the workflow.

3 Inthe Entry toolbar, click Workflow > Start Workflow: Publish Workflow, then click OK when you
are asked if you really want to start the workflow.

The workflow status of the entry is now Private.

Internal Workflows

Vibe includes two workflows that are used internally:

+ “Task Workflow” on page 174
+ “Calendar Workflow” on page 174

Task Workflow

Vibe uses the Task workflow internally to allow all users who are assigned to a particular task to
make modifications to the task, if they are not members of the workspace where the task resides.

This workflow should not be manually added to any workspace or folder.

Calendar Workflow

Vibe uses the Calendar workflow internally to allow all users who are attendees in an event to make
modifications to the calendar event, if they are not members of the workspace where the event
resides.

This workflow should not be manually added to any workspace or folder.

Enabling Workflows

After a workflow is created, you can enable the workflow to automatically start when certain types
of entries are created in the folder, or when users comment on or reply to entries. Or, you can enable
users to manually start workflows when they view the entry.

Before you can enable a workflow, the workflow must first be created. For information on how to
create a workflow, see either Section 11.1, “Creating a Simple Workflow,” on page 137 or

Section 11.2, “Creating an Advanced Workflow,” on page 144, depending on the type of workflow
that you want to create.
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You can enable workflows only in folders for which you have appropriate rights. When you enable a
workflow in a folder, it is automatically enabled on all sub-folders and sub-workspaces, and can be
applied to all entries that are created in that folder and its sub-folders.

+ Section 11.7.1, “Enabling Workflows to Start When an Entry Is Created,” on page 175

+ Section 11.7.2, “Enabling Workflows to Start When Users Comment on or Reply to an Entry,” on
page 175

+ Section 11.7.3, “Allowing Users to Manually Start Workflows,” on page 176

11.7.1 Enabling Workflows to Start When an Entry Is Created

You can enable a workflow to automatically start on all entries that are created in a specific folder,
whenever an entry is created. This is called “associating workflows with entries.”

1 Navigate to the folder where you want to enable the workflow.

2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Workflow Associations section, click the
drop-down list next to the entry type that you want to associate the workflow with, then select
the desired workflow.

To add workflows to this drop-down list, you need to create them. After workflows have been
created at this folder level, or at a higher workspace level, they appear in this list. For
information on how to create workflows, see either Section 11.1, “Creating a Simple Workflow,”
on page 137 or Section 11.2, “Creating an Advanced Workflow,” on page 144, depending on the
type of workflow that you want to create.

4 Click Apply > Close.
Now, when this type of entry is created in this folder, Vibe automatically starts the workflow by
placing the entry in the initial state of the workflow process that you specified.

When you enable a folder to support multiple entry types, you can associate workflows to the
specific types of entries. For example, if you have a folder that supports both file entries and
calendar entries, you can have one kind of workflow start when you create a file entry, and another
kind of workflow start when you create a Calendar entry. For information on how to enable multiple
entry types in a single folder, see Section 3.3.1, “Enabling Alternate Folder Entry Types,” on page 27.

11.7.2 Enabling Workflows to Start When Users Comment on or Reply
to an Entry

You can enable a workflow to automatically start when users comment on or reply to an entry. This
is called “associating workflows with comments or replies.”

1 Navigate to the folder where you want to enable the workflow.

2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Workflow Associations section, click the
drop-down list next to the comment or reply type that you want to associate the workflow with,
then select the desired workflow.
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11.7.3

11.8

11.9

To add workflows to this drop-down list, you need to create them. After workflows have been
created at this folder level, or at a higher workspace level, they appear in this list. For
information on how to create workflows, see either Section 11.1, “Creating a Simple Workflow,”
on page 137 or Section 11.2, “Creating an Advanced Workflow,” on page 144, depending on the
type of workflow that you want to create.

4 Click Apply > Close.

Now, when this type of comment or reply is made to an entry in this folder, Vibe automatically
starts the workflow by placing the entry in the initial state of the workflow process that you
specified.

Allowing Users to Manually Start Workflows

You can allow users to decide if they want to start a workflow on an entry, and if they do, at what
point they want to start the workflow. Also, you can give users the option to choose among multiple
workflows for each entry.

1 Navigate to the folder where you want to enable users to start the workflows.
2 Click the Configure icon 9 next to the folder title, then click Configure Views, URLs and
Controls.

3 On the Folder Views, Entries and Workflows tab, in the Allowed Workflows section, select the
workflows that you want to allow users to choose from.

The Local Definitions section in the Allowed Workflows section displays all of the workflows that
you have created locally. The other workflows listed in the Allowed Workflows section were
either created by your Vibe administrator, by another user at a higher level in the workspace
tree, or are included with the Vibe product.

4 Click Apply > Close.

Now, when users create entries in this folder, they can start and stop workflows as they desire.
For information on how to start and stop a workflow, see “Using Workflows” in the OpenText
Vibe 4.0.8 User Guide.

Testing a Workflow

To test a workflow, simply create the workflow in a testing workspace and ensure that it works
according to your specifications. When the workspace is ready to be deployed in a production
environment, export the workflow, then import it into the production workspace where you want to
deploy it.

For information on how to import and export a workflow, see Section 11.9, “Importing and
Exporting a Workflow,” on page 176.

Importing and Exporting a Workflow

Micro Focus Vibe lets you import and export workflows into and out of Vibe.

+ Section 11.9.1, “Importing a Workflow,” on page 177
+ Section 11.9.2, “Exporting a Workflow,” on page 177
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11.9.1 Importing a Workflow

1

2

Navigate to the workspace where you want to import the workflow.

Click the Configure icon © next to the workspace title, then click Form/View Designers.

Click Import.
The Import Definitions page is displayed.

Click Browse.

5 Browse for and select the workflow that you want to import.

Click OK > Close.

11.9.2 Exporting a Workflow

1

2

Navigate to the workspace where you created the workflow.

Click the Configure icon © next to the workspace title, then click Form/View Designers.

Click Export.
The Export Definitions page is launched.

Expand Workflow Processes, then select the workflow that you want to export.

5 Click OK.

Select the location where you want to save the workflow, then save it.
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2 Managing Remote Applications

12.1

Remote applications communicate with a third-party, online application, and send information from
the third-party application back into Micro Focus Vibe.

For example, your Vibe administrator could create a remote application for Twitter that displays all
of your Twitter entries in Vibe.

Remote applications are vastly customizable, and are set up by your Vibe administrator. Talk with
your Vibe administrator if you have a request for a new remote application.

This section describes how to set up remote applications after they have already been created and
enabled by your Vibe administrator.

+ Section 12.1, “Adding Remote Applications to Views and Forms,” on page 179

+ Section 12.2, “Setting Up a Remote Application,” on page 180

+ Section 12.3, “Setting Up Multiple Remote Applications on a Single Page,” on page 182

+ Section 12.4, “Managing Access Controls for Remote Applications,” on page 184

Adding Remote Applications to Views and Forms

Micro Focus Vibe lets you add a Remote Application element to a folder or workspace view or a
custom form. The Remote Application element is a drop-down list that enables users of the view or
form to select from a list of remote applications. This is useful if the current view or form does not
allow you to select a remote application to run; it is also useful if you want to run multiple remote
applications in a single view or form. (For specific information on configuring a view or form to run
multiple remote applications, see Section 12.3, “Setting Up Multiple Remote Applications on a Single
Page,” on page 182.)

Unless you are the Vibe administrator, you can perform the following procedure only on custom
views and forms for which you have appropriate rights. You can create custom views and forms for
workspaces, folders, or entries, as described in Chapter 7, “Creating Custom Workspace Views,” on
page 95, Chapter 8, “Creating Custom Folder Views,” on page 107, and Chapter 9, “Designing
Custom Folder Entry Forms,” on page 119.

To add a Remote Application element to a view or form:

1 Navigate to the workspace or folder where you want to add the Remote Application element.

If you want to add the Remote Application element to a form, navigate to the workspace or
folder where the form was created.

2 Click the Configure icon 9 next to the workspace or folder title, then click Form/View
Designers.

The Form and View Designers page is displayed.
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3 Click the entry definition, folder view, or workspace view where you want to add the Remote
Application element.

4 Add the Remote Application element to the desired folder view, workspace view, or entry
definition, as described in the following sections:

Folder View: Section 8.2.2, “Adding Elements to the Folder Add/Modify Form,” on page 110

Workspace View: Section 7.2.2, “Adding Elements to the Workspace Add/Modify Form,” on
page 98

Entry Definition (Form): Section 9.3.2, “Adding Elements to the Entry Form Definition,” on
page 122

12.2 Setting Up a Remote Application

+ Section 12.2.1, “Setting Up a Remote Application in a Workspace,” on page 180
+ Section 12.2.2, “Setting Up a Remote Application as an Accessory,” on page 181

12.2.1 Setting Up a Remote Application in a Workspace

1 Navigate to the workspace or folder where you want to display the remote application.

2 Click the Configure icon @ next to the workspace or folder title, then click Edit Workspace or
Edit Folder.

3 In the Remote Application section, click the drop-down list and select the remote application
that you want to enable.

4 Click OK.

The remote application is displayed at the top of the folder or workspace.
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12.2.2

Setting Up a Remote Application as an Accessory

Vibe allows you to set up remote applications as accessories. You might want to do this if you want
to view more than one remote application on a single Vibe page.

1 Navigate to the page where you want to create the Remote Application accessory.

2 Locate the Accessory Panel, then click Accessory Panel.

For information about locating the Accessory Panel, see “Hiding or Displaying the Accessory
Panel in a Folder” in the OpenText Vibe 4.0.8 User Guide.

Accessory Panel =
Add an Accessory

Show Hidden Borders and Controls

Set the accessory panel's title

Set Default Layout for Personal Global Accessories

Set Default Layout for Community Accessories

3 Click Add an Accessory.

Accessory Scope
# Personal Accessory for This Fage Only
Fersonal Accessory for all Workspaces and Fuldersa
Community Accessory for This F"age'ﬂ'

Accessory Type
Search Results

Workspace Tree
Formatted Text (HTWML Editar)
Embedded Web Page (iframe)
Buddy List
Team Members
Fhoto Gallery
Blog Summary
Guesthook
Task Summary
Wiki Home Page
Calendar Summary
» Remote Application

4 Select the scope of the accessory you want to create, then select Remote Application.

5 Click OK.
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12.3

12.3.1

Accessory Setup

Accessory Setup
Accessory Scope: Personal Accessory for This Page Only

Remote Application
Title

Display Style
* Border
Ma border

Remote Application
Vibe Remote Test Connectar

[ Apply Jil Close Jl Delete |

6 Specify a title for the accessory, then use the Remote Application drop-down menu to select the
remote application that you want to add.

7 Click Apply > Close.

The new accessory is displayed.

Setting Up Multiple Remote Applications on a Single
Page

You can use either of the following methods to set up multiple remote applications on a single
Workspace or Folder.

¢ Section 12.3.1, “Launching a Remote Application as an Accessory,” on page 182

+ Section 12.3.2, “Creating a New Workspace or Folder View That Supports Multiple Remote
Applications,” on page 183

Launching a Remote Application as an Accessory

If you want to view more than one remote application on a single Vibe page, you can set up one
remote application in your workspace, and then you can view subsequent remote applications as
accessories.

For more information on viewing remote applications as accessories, see Section 12.2.2, “Setting Up
a Remote Application as an Accessory,” on page 181.
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12.3.2

Creating a New Workspace or Folder View That Supports
Multiple Remote Applications

If you don’t want your remote application to be displayed as an accessory, but you still want to
enable multiple remote applications on a single page, you can accomplish this by creating a new
view for the workspace or folder where you want the remote applications to be displayed, and then
configuring the workspace or folder to support the new view.

¢ “Creating the New View” on page 183

+ “Configuring the Workspace or Folder to Support the New View” on page 183

+ “Using the New View to Enable a Remote Application” on page 184

Creating the New View
1 Navigate to the Workspace or Folder where you want to enable additional remote applications.
2 Click the Configure icon 9 next to the workspace or folder title, then click Form/View
Designers.

The Form and View Designers page is launched.

3 Click New > Folder Views or Workspace Views, depending on whether you are working in a
workspace or folder.

Provide a caption and a name for the new definition.

Select the type of workspace for which you want to create the new definition.
Click OK.

Click the Workspace Add/Modify Form link.

In the box on the right side of the page, click Add.

O 00 N o u bH

In the Form Elements section, click Remote Application.
10 Provide a caption and a name for the new remote application field that you’re creating.

The text that you enter in the Caption field is what the remote application field is called in the
workspace or folder form.

11 Click OK.

12 Click Close to exit the Form and View Designer.

Configuring the Workspace or Folder to Support the New View
+ “Configuring a Workspace to Support the New View” on page 183
¢ “Configuring a Folder to Support the New View” on page 184

Configuring a Workspace to Support the New View

For information on how to configure the workspace to support the new view that you created in
“Creating the New View” on page 183, see Section 7.5, “Enabling the Workspace View,” on
page 103.
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Configuring a Folder to Support the New View

For information on how to configure the workspace to support the new view that you created in
“Creating the New View” on page 183, see Section 3.2.1, “Changing the Default Folder View,” on
page 26.

Using the New View to Enable a Remote Application

Now that you have created the new definition and configured the workspace or folder to support it,
you need to enable the additional remote application.

To enable the additional remote application, see Section 12.2, “Setting Up a Remote Application,” on
page 180.

12.4 Managing Access Controls for Remote Applications

Because not all remote applications can be completely trusted, it is a good idea to limit the privileges
of the remote application. Because Micro Focus Vibe administrators are responsible for creating and
enabling the remote application for the Vibe site, they are also responsible for setting up access
controls on the remote application.

Before you modify the access control settings of remote applications for a specific workspace or
folder, you should consult with your Vibe administrator to ensure that what you plan to do is safe.

When an application is restricted to a specific role, the application can use web services to perform
only those tasks that are allowed for that role. For example, the Participant role can create new
entries, modify entries that the user created, add comments to entries, and so on. Participants
cannot perform system administration tasks and cannot modify other users’ entries.

To limit the remote application to privileges assigned to a specific role:

1 Navigate to the folder or workspace where you want to set the access control settings on the
remote application.

2 Click the Configure icon © next to the workspace or folder title, then click Access Control.

3 On the Configure Access Control page, click Add an Application.

Add an Application = Application Title £p

--thin annlications--

Add an Application

4 Inthe Add an Application field, use type-to-find functionality to specify and select the
application that you want to add.

5 Close the Add an Application panel by clicking the X in the upper right corner.

6 In the access control table, select the check box that is located in the row of the remote
application that you just added, and the column of the role that you want to assign to the
application.
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7 Click Save Changes > Close.

The application that you added is now restricted to those operations allowed for the role that you
selected. For example, if you assigned the Participant role to the remote application, then the
inheritance of workspace and folder access controls means that it is very likely that most workspaces
and folders inherit this setting. Assuming that all places inherited this setting, the most powerful role
the remote application can assume within the installation is that of a Participant.

If you are not sure what access control settings to assign to a particular remote application, consult
with your Vibe administrator.

If your Vibe administrator has enabled multiple applications for your site, some of these applications
might be grouped together in an Application Group. Application Groups are similar to groups that
contain user names. Application groups contain the names of registered applications. After your
Vibe administrator defines application groups, you as a workspace and folder owner can assign
access-control roles to groups of applications instead of assigning roles to one application at a time.
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3 Managing Your Data Quota

13.1

Data quotas can be enabled by your Vibe administrator in order to limit the amount of data that is
stored on the Vibe site. For information on how the Vibe administrator can enable data quotas, see
“Managing Disk Space Usage with Data Quotas and File Restrictions” in the OpenText Vibe 4.0.8
Administration Guide.

If data quotas have been enabled on your Vibe site, you need to understand what counts toward
your data quotas, the different kinds of data quotas that exist, and how you can view the current
data usage so you can know when you are approaching the allotted data quota. If you meet your
allotted quota, Vibe lets you purge files and attachments that you have previously deleted.

+ Section 13.1, “Understanding Data Quotas,” on page 187

+ Section 13.2, “Viewing Your Data Quota,” on page 188

+ Section 13.3, “Setting a Data Quota for Workspaces and Folders,” on page 190

+ Section 13.4, “Adding Files and Attachments to the Vibe Site When You Are Over Your Quota,”
on page 191

+ Section 13.5, “Emailing Files and Attachments to the Vibe Site When You Are Over Your Quota,”
on page 191

+ Section 13.6, “Using Mirrored Folders When You Are Restricted by a Data Quota,” on page 191

+ Section 13.7, “Adding Files Through WebDAV When You Are Restricted by a Data Quota,” on
page 191

+ Section 13.8, “Working with File Versions When You Are Restricted by a Data Quota,” on
page 191

+ Section 13.9, “Making Disk Space Available by Deleting Items from the Trash,” on page 192

Understanding Data Quotas

Only files and attachments count toward your data quota. Workspaces, folders, and entries that do
not contain files and attachments do not count toward your data quota. Files and attachments must
be deleted and purged in order to make more disk space available.

The Vibe administrator can enable two kinds of data quotas:

+ User data quotas

+ Workspace and folder data quotas
The administrator can enable one of these quotas, or both of them.

¢ Section 13.1.1, “Understanding User Data Quotas,” on page 188
¢ Section 13.1.2, “Understanding Workspace and Folder Data Quotas,” on page 188
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13.1.1

13.1.2

13.2

13.2.1

Understanding User Data Quotas

User data quotas limit the amount of data individual users can add to the Vibe site. Any files and
attachments that you add to the Vibe site counts toward your data quota, regardless of the folders
or workspaces where you add them.

Understanding Workspace and Folder Data Quotas

Workspace and folder quotas limit the amount of data that can be stored in individual workspaces
and folders.

Sub-workspaces and sub-folders that have a data quota are subject to their own data quota, as well
as any data quotas that exist on parent folders and workspaces. For example, consider a workspace
that has a data quota of 50 MB. The workspace contains two sub-workspaces: Workspace A and
Workspace B. Users cannot upload data that is in excess of 50 MB into either of these sub-
workspaces. Furthermore, users cannot upload data into both of these sub-workspaces that is in
excess of 50 MB. (For example, users cannot upload data that is in excess of 30 MB into both sub-
workspaces, because the amount of combined data for both sub-workspaces is greater than 50 MB.)

Viewing Your Data Quota

Data quotas might or might not be in use on your Vibe site. If you are unable to view your data
guotas as described in this section, your Vibe administrator has not yet restricted the amount of
data that can be added to the Vibe site.

If you have exceeded your allotted data quota, you should purge items that you have previously
deleted, as discussed in Section 13.9, “Making Disk Space Available by Deleting Items from the
Trash,” on page 192.

¢ Section 13.2.1, “Viewing Your User Data Quota,” on page 188
+ Section 13.2.2, “Viewing Your Workspace or Folder Data Quota,” on page 189

Viewing Your User Data Quota

If your administrator has set a user data quota and if you are an active contributor to your Micro
Focus Vibe site, you might want to periodically view your current data quota to ensure that you are
not approaching the user limit.

To view your current data quota and how much you are currently using:

1 Click your linked name in the upper right corner of each Vibe page.

188  Managing Your Data Quota



13.2.2

Your data quota is displayed, along with the amount you are currently using.

Julio Chavez

| Data Quata. 100 MB
Zh] Quota Used. 0.05 MB

View Profile

Personal Freferences

Change Password

Live Feed

Help

Download Vibe Deskiop App

Sign out

Viewing Your Workspace or Folder Data Quota

The Vibe administrator can set a data quota on your workspaces and folders, or the administrator
can allow you to set your own data quotas on your own workspaces and folders.

You must be an administrator for the workspace or folder in order to view data quotas.
To view your current workspace or folder quota:

1 Navigate to the workspace or folder where you want to view the quota.

2 Click the Configure icon 'E" next to the workspace or folder title, then click Configure Views,
URLs and Controls.

3 Click the Quotas tab.

Configure Workspace View Simple URLs and E-mail Addresses Quotas “ersioning and Folder Settings

Workspace: Marketing
[E-Home Workspace jf [-Team Workspaces J/ [@-Marketing

Disk Space Quota

Workspace Disk Space Used: 1.65MB
Workspace and Children Disk Space Used: 5.06MB

Lowest Quota on Parent Workspaces or Folders: None

Current Quota: 50MB

Set a Quota: 50 MB
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13.3

The following data quota information is displayed for the workspace or folder:

+ Workspace/Folder Disk Space Used: The amount of disk space the workspace or folder is
currently using. This does not include disk space that is being used by sub-workspaces and
sub-folders.

+ Workspace and Children Disk Space Used/Folder and Sub-Folder Disk Space Used: The
amount of disk space that is being used by the workspace or folder and all of its sub-
workspaces and sub-folders.

+ Lowest Quota on Parent Workspaces or Folders: The lowest quota that exists on any
workspace or folder that is higher in the folder hierarchy than the workspace or folder that
you are currently viewing.

Sub-workspaces and sub-folders that have a data quota are subject to their own data
quota, as well as any data quotas that exist on parent folders and workspaces. For more
information, see Section 13.1.2, “Understanding Workspace and Folder Data Quotas,” on
page 188.

+ Current Quota: The current data quota that exists on the workspace or folder.

+ Set a Quota: lets you change the data quota for the workspace or folder.

Setting a Data Quota for Workspaces and Folders

The Vibe administrator can allow you to set your own data quotas for your workspaces and folders. If
you cannot set a data quota as described in this section, your administrator has not allowed this
capability.

If workspace and folder administrators have set data quotas at higher-level workspaces, your
workspaces and folders are subject to any quotas that are set on the higher-level workspaces. For
example, suppose you are the administrator of a team workspace called “Online Marketing.” This
team workspace is a sub-workspace to a workspace called “Marketing.” If the workspace
administrator for the Marketing workspace has set a data quota of 100 MB, users in your workspace
and in other sub-workspaces to the Marketing workspace cannot upload more than 100 MB of
collective data to the sub-workspaces, regardless of what is set as the data quota for the sub-
workspaces. For more information, see Section 13.1.2, “Understanding Workspace and Folder Data
Quotas,” on page 188.

To set a data quota for workspaces and folders:

1 Navigate to the workspace or folder where you want to view the quota.

2 Click the Configure icon @ next to the workspace or folder title, then click Configure Views,
URLs and Controls.

3 Click the Quotas tab.

4 In the Set a Quota field, specify the new data quota for the workspace or folder, then click OK.
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13.4

13.5

13.6

13.7

13.8

Adding Files and Attachments to the Vibe Site When
You Are Over Your Quota
If you have exceeded your data quota but you still need to add files and attachments to the Vibe site,

you need to decrease your disk usage by purging files and attachments that you have previously
deleted.

For information on how to purge deleted items, see Section 13.9, “Making Disk Space Available by
Deleting Items from the Trash,” on page 192.

Emailing Files and Attachments to the Vibe Site When
You Are Over Your Quota
Vibe lets you add files and entry attachments to the Vibe site via email, as described in “Adding

Entries to a Folder Via Email” in the OpenText Vibe 4.0.8 User Guide. However, if you have met your
data quota, you are unable to email entries to Vibe if they include attachments.

If you have exceeded your allotted data quota, you should purge the items that you have previously
deleted, as discussed in Section 13.9, “Making Disk Space Available by Deleting Items from the
Trash,” on page 192.

Using Mirrored Folders When You Are Restricted by a
Data Quota

Files stored in mirrored file folders do not count against your data quota, because they are not
uploaded into the OpenTextsite.

For more information on mirrored folders, see Section 3.9, “Working with Mirrored Folders,” on
page 37.

Adding Files Through WebDAV When You Are
Restricted by a Data Quota

When you add files to the Vibe site through WebDAV, the files still count against your data quota,
just as if you had added the files through the regular Vibe interface.

Working with File Versions When You Are Restricted by
a Data Quota

Vibe lets you create multiple versions of the same file, as described in “Using Version Control with
Files” in the OpenText Vibe 4.0.8 User Guide.

When you edit a document in Vibe, Vibe creates a new version of the file. This new version counts
against the data quota of the user who edited the file; it does not count against the quota of the user
who originally posted the file. File versions also count against the data quota of individual
workspaces and folders.
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13.9

You can manage your data quota by deleting previous versions of a file that you no longer need. For
information about how to delete previous file versions, see “Deleting Existing Versions of a File” in
the OpenText Vibe 4.0.8 User Guide.

IMPORTANT: When you use OpenOffice to edit a document in Vibe, a new version of the document
is created each time you click Save. Because each version of a document counts against your data
quota, you should save the document only once if you are using OpenOffice as an editor.

When you use Microsoft Office, Vibe creates only one version when you save the document. Clicking
Save multiple times does not create multiple versions, as is the case when you edit documents with
OpenOffice.

Making Disk Space Available by Deleting Items from
the Trash

Files and attachments that have been moved to the Trash but not yet deleted from the Vibe system
still count toward your data quota. Workspaces, folders, and entries that do not contain files and
attachments do not count toward your data quota. If you have reached your allotted data quota, you
need to purge deleted files and attachments.

You can permanently delete any item that you have rights to move to the Trash.

NOTE: Items that have been permanently deleted cannot be recovered. When you delete items from
the Trash, remember the following:

+ Permanently deleting an entry also permanently deletes all attached files, comments, and
replies.

+ Permanently deleting a folder also permanently deletes all entries and sub-folders that are
associated with that folder.

+ Permanently deleting a workspace also permanently deletes all folders, sub-folders, and entries
that are associated with that workspace.

1 Navigate to the folder or workspace where the item resided before it was moved to the Trash.

For example, if you want to permanently delete a file entry that was in your personal Files
folder, navigate to the Files folder in your personal workspace.

If you want to see everything that has been deleted in the Vibe site, navigate to the highest
level workspace. (By default, this is the Home Workspace directory.)

2 Click the Trash icon 2§, located in the Navigation panel.

The Trash page displays all workspaces, folders, and entries that have been moved to the Trash
in or below the current workspace or folder.

3 Select the file entry or any other type of entry that contains an attachment that you want to
permanently delete.

4 Click Delete > OK.

The item is permanently deleted from the Vibe site.
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Restoring Items from the Trash

Vibe lets you recover a workspace, folder, or entry that you previously moved to the Trash, and
restore it to its previous location. When you restore an entry from the Trash, all associated
attachments, comments, and replies are also restored.

You cannot restore an item that has been permanently deleted.

+ Section 14.1, “Rights Associated with Undeletion,” on page 193

*

Section 14.2, “Restoring Workspaces, Folders, and Entries,” on page 193

*

Section 14.3, “Restoring Mirrored Files,” on page 194

*

Section 14.4, “Restoring Items That Contain Workflows,” on page 194

*

Section 14.5, “Locating Items That Have Been Moved to the Trash,” on page 194

14.1 Rights Associated with Undeletion

As a general rule, if you have rights to move an item to the Trash, you also have rights to restore that
item.

Remember the following when restoring items from the Trash:

+ You can restore an item that another user moved to the Trash, if you have appropriate rights.

+ If you have rights to restore an entry from the Trash, but do not have rights to restore the folder
that contains the entry, you cannot restore the entry.

+ If you have rights to restore a folder from the Trash, but do not have rights to restore the
workspace that contains the folder, you cannot restore the folder.

+ When you restore a folder from the Trash, the contents of the folder are not automatically
restored. You need to restore the contents of the folder separately.

+ When you restore an entry in a folder that has been moved to the Trash, the folder is
automatically restored. However, if you do not have rights to restore the folder from the Trash,
you cannot restore the entry.

14.2 Restoring Workspaces, Folders, and Entries

If you have the appropriate rights, you can retrieve any workspace, folder, or entry from the Trash
and restore it to its previous location.

1 Navigate to the folder or workspace where the workspace, folder, or entry resided before it was
moved to the Trash.

For example, if you want to restore a Blog folder that was in your personal workspace, navigate
to your personal workspace.

If you want to see everything that has been moved to the Trash throughout the Vibe site,
navigate to the highest level workspace. (By default, this is the Home Workspace directory.)
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14.3

14.4

14.5

2 Click the Trash icon Bz, located in the Navigation panel.

The Trash page displays all workspaces, folders, and entries in or below the current workspace
or folder.

3 Select the workspace, folder, or entry that you want to restore.
4 Click Restore.

The workspace, folder, or entry is restored to its previous location.

Restoring Mirrored Files

Restoring files that have been deleted through a mirrored folder is not supported in Vibe. Files that
are deleted through a mirrored folder are permanently deleted, and cannot be recovered.

Restoring Items That Contain Workflows

When you restore a workspace or folder where a workflow has been created, the workflow is also
restored with the workspace or folder.

When you restore a folder entry where a workflow has been enabled, the entry is restored with the
workflow still enabled. The entry is in the same workflow state as it was when it was moved to the
Trash.

Locating Items That Have Been Moved to the Trash

If you cannot find an item in your Vibe site that you know was there previously, it has probably been
moved to the Trash or permanently deleted. Items that have been permanently deleted cannot be
recovered.

To locate an item that has been moved to the Trash, do either of the following:
+ Perform a search for the item, as described in “Searching for Items That Have Been Moved to
the Trash” in the OpenText Vibe 4.0.8 User Guide.

+ Navigate to the folder or workspace where the item previously resided, and click the Trash icon

Lol located in the Navigation panel, as described in Section 14.2, “Restoring Workspaces,
Folders, and Entries,” on page 193.
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15.1

15.2

15.3

Using OpenTextwith MicroFocus
GroupWise

You can configure your OpenTextGroupWise client to work with Vibe in various ways.

+ Section 15.1, “Displaying Live Vibe Feeds in GroupWise,” on page 195
+ Section 15.2, “Accessing Vibe from a GroupWise Web Panel,” on page 195
+ Section 15.3, “Accessing Vibe through the OpenTextFolder,” on page 195

Displaying Live Vibe Feeds in GroupWise

You can display your OpenText feed in the GroupWise client. This lets you keep up with the latest
Vibe additions without leaving GroupWise.

For information on how to do this, see “Creating a New Panel” in “Getting Organized” in the
GroupWise 18 Client User Guide. Also, see the GroupWise 18 and Vibe Quick Start (https://
www.novell.com/documentation/groupwise18/gw18_qs_vibe/data/gw18_qgs_vibe.html).

Accessing Vibe from a GroupWise Web Panel

You can set up OpenText to display inside a GroupWise web panel, so you can access Vibe without
leaving the GroupWise interface.

For information on how to access Vibe from a GroupWise web panel, see the GroupWise 18 and
Vibe Quick Start (https://www.novell.com/documentation/groupwise18/gwi18 gs_vibe/data/
gwl8 gs_vibe.html).

Accessing Vibe through the OpenTextFolder

For information on how to access OpenText through the OpenTextfolder, see the GroupWise 18 and
Vibe Quick Start (https://www.novell.com/documentation/groupwise18/gw18_gs_vibe/data/
gwl8 gs_vibe.html).

NOTE: Before you can access Vibe through GroupWise as discussed in this quick start, your
GroupWise administrator must set up the integration, as described in “Enabling GroupWise/Vibe
Integration for GroupWise Client Users” in “Configuring GroupWise for Use with Micro Focus Vibe”
in the GroupWise 18 Interoperability Guide.
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A.l

A.2

A.3

What’s New in Vibe 4.0

In Vibe 4.0 you'll find new features, a fresh user interface, and significant updates. For a list of more
basic features that are new in Vibe, see “What’s New in Vibe 4” in the OpenText Vibe 4.0.8 User
Guide.

The following list is an overview of the new features for advanced users.

+ Section A.1, “Reuse an Existing Survey,” on page 197
+ Section A.2, “Workflow Enhancements,” on page 197

+ Section A.3, “Landing Page Improvements,” on page 197

Reuse an Existing Survey

Vibe 4.0 allows you to reuse an existing survey by clearing all votes from the survey.

Workflow Enhancements

Vibe 4.0 provides new workflow capabilities. These capabilities include:

+ Transition an entry on a passed date allows you to transition all entries that are currently
running in the workflow to transition at the date and time that you designate.

Landing Page Improvements

The following improvements were made to Landing Pages in Vibe 4.0:

+ Improved look and feel

+ Tables are transparent to provide a better look regardless of background color
+ Add rows to tables

+ Preview the landing page before publishing it

+ Sub-folders and sub-workspaces inherit landing page properties by default

+ Ability to show only a designated number of lines or pixels of a displayed entry

+ Better formatting consistency

For more information about landing pages, see Chapter 6, “Creating and Managing Landing Pages,”
on page 59.
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Using HTML Markup in Vibe

Vibe lets you add HTML markup into the following locations of the Vibe interface:

+ Any HTML editor, such as in the Description section of entries, folders, and workspaces.

”n i

For more information, see “Modifying the Description Section of an Entry”, “Modifying a
Folder”, and “Modifying a Workspace” in the OpenText Vibe 4.0.8 User Guide.

+ The Subject Line and Notification Body of workflow notification messages.

For more information, see Step 7 in Section 11.1.5, “Sending Email Notifications,” on page 142.

You can add the following HTML markup items:

Markup Text

Function

{{vibe:title}}
{{vibe:user}}

{{vibe:user|name}}

{{vibe:createdBy}}
{{vibe:createdBy|name}}
{{vibe:createdOn}}

{{vibe:modifiedBy}}

{{vibe:modifiedBy|name}}

{{vibe:modifiedOn}}

{{vibe:data|dataName}}

Displays the title of the entry, folder, or workspace.
Displays the name of the user who is viewing the entry, folder, or workspace.

Displays the user ID of the user who is currently viewing the entry, folder, or
workspace.

Displays the name of the user who created the entry, folder, or workspace.
Displays the user ID of the user who created the entry, folder, or workspace.
Displays the date that the entry, folder, or workspace was created.

Displays the name of the user who last modified the entry, folder, or
workspace.

Displays the user ID of the user who last modified the entry, folder, or
workspace.

Displays the date that the entry, folder, or workspace was last modified.

Displays the value of the specified data item. Data items are elements that
have been added to the form or view definition by using the Form and View
Designer. Replace dat aNane with the data name of the element that you
want to show.

For a list of elements, see Section 9.5, “Understanding Elements,” on
page 128.

For more information about how to use the Form and View Designer to
create custom forms and views, see Chapter 7, “Creating Custom Workspace
Views,” on page 95, Chapter 8, “Creating Custom Folder Views,” on page 107,
and Chapter 9, “Designing Custom Folder Entry Forms,” on page 119.
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Markup Text

Function

{{vibe:permalink | link}}

{{vibe:image | imageName |
alt=... | height=... | width=... |
border=0 or 1}}

{{vibe:file | filename | title}}

[[entry title]]

Displays a permalink to the current entry, folder, or workspace. Replace
| i nk with the text that you want to be displayed. This is the text users will
click to navigate to the entry, folder, or workspace.

This markup option is most useful when it is used in the Subject line of a
workflow notification email. For example, the Subject line might read, A
wor kf | ow change occurred in entry.The user can then click entry
in the Subject line of the notification to be taken directly to the entry.

Displays the image that you specify. Replace i mageNane with the file name
of the image that you want to display. Images must be attached to the entry,
folder, or workspace.

For information on how to attach entries, see “Attaching Files to a Folder
Entry,” “Modifying a Folder,” and “Modifying a Workspace” in the OpenText
Vibe 4.0.8 User Guide.

If you want to specify a custom size, you can add the alt, height, and width
arguments. These arguments are optional.

Displays a link to a file. The file must be attached to the entry, folder, or
workspace.

For information on how to attach entries, see “Attaching Files to a Folder
Entry,” “Modifying a Folder,” and “Modifying a Workspace” in the OpenText
Vibe 4.0.8 User Guide.

For example, {{vibe:file | tree.jpg | tree}} outputs the word t r ee as a link to
the tree.jpg file.

Creates a link to the entry that you specify. You must specify the exact name
of the entry.

For more information about creating links in Vibe, see “Linking to a Folder or
Folder Entry” in the OpenText Vibe 4.0.8 User Guide.
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